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ABSTRACT 

 

SIMPPLLE is a spatially-interactive, dynamic landscape modeling system for projecting temporal 

changes in the spatial distribution of vegetation in response to insects, disease, wildland fire, 

and other natural and management-caused disturbances.  SIMPPLLE is designed to provide a 

balance between incorporating enough complexity and interactions in modeling ecosystem 

processes to provide an acceptable level of realism while making simplifications in the choices 

on required data input requirements, required computer platforms, and computing time to be a 

management tool useful in collaborative planning processes.  SIMPPLLE is designed to serve as a 

decision support system in collaborative efforts to help managers and resource specialists 

quantify and incorporate concepts that are often difficult to interpret for specific landscapes.  

Managers can use SIMPPLLE to help define and evaluate desired future conditions at landscape 

scales, to identify what parts of a landscape are more prone to disturbance processes over a 

given time frame, and to help design and evaluate different strategies for achieving desired 

future conditions. We explain data input requirements, the GIS tools to create the necessary 

input files, input values specific to geographic areas, directions for executing the system and 

generating model output, and GIS displays. 
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1. INTRODUCTION—OVERVIEW OF SIMPPLLE 

SIMulating Patterns and Processes at Landscape scaLEs (SIMPPLLE) was initially developed for 

U.S. Department of Agriculture (USDA) Forest Service, Region One as a management tool to 

integrate disturbance processes and vegetation conditions at a range of spatial scales. A basic 

overview publication is in the Western Journal of Applied Forestry (Chew et al. 2004). Earlier 

publications discussing the design and development of the system can be found in Chew (1993), 

Chew (1995), and Chew (1997). 

The objective of SIMPPLLE is to help provide an understanding of the dynamics of landscapes. 

Multiple simulations can provide a range of possible outcomes—a prediction of general trends 

for when and where disturbance processes may occur on specific landscapes. Any single 

simulation can present a possible scenario of what could happen, but it cannot be taken as a 

precise prediction.  SIMPPLE is spatially interactive because of the importance of the spatial 

interaction between landscape features and disturbance processes.  Individual simulations can 

be selected from a set of multiple simulations to represent worst-case scenarios for specific 

disturbance processes, a most likely scenario, or a most optimistic scenario.  

SIMPPLLE’s purpose is to provide the user with the ability to: 

 Simulate future vegetation changes caused by disturbance processes at multiple 
landscape scales. 

 Simulate ranges of conditions of plant communities and processes that can be expected 
for specific landscapes. 

 Simulate how changes in vegetation patterns influence the activity of fire, insect, and 
disease processes. 

 Help identify areas that have a high priority for treatments that can help achieve and 
sustain desired conditions at landscape scales. 

 Simulate management treatment alternatives for their impact on disturbance processes 
and the attainment of desired conditions defined at landscape scales. 

 Compare effectiveness of varying treatment alternatives at altering fire, insect, or 
disease probabilities.  

 Simulate impacts over time on a variety of resource objectives that can be defined by a 
combination of vegetation conditions and spatial attributes. 

 Provide a basis for identifying the probability of disturbance processes and vegetation 
conditions. 

There are many features of SIMPPLLE that are designed to provide these capabilities. 

The development of SIMPPLLE places emphasis on creating data structures within an object-

oriented design to capture knowledge represented by both research results and expert opinion. 

Knowledge for the system is represented in data structures that provide maximum flexibility in 

adapting the system to new areas and making updates as new research knowledge or 

experience becomes available. 
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The user can make many choices in the knowledge and simulation parameters to tailor the 

application to specific issues. The total design for SIMPPLLE is to provide a system that has four 

components of an interacting landscape: vegetation, land units, aquatic units, and manmade 

features.  SIMPPLLE is spatially explicit. The location of each existing landscape unit is unique. 

Each existing unit has an attribute that identifies its adjacent units.  SIMPPLLE is also spatially 

interactive in that it provides for interaction between disturbance processes and the vegetative 

pattern of a unique landscape.   The probability of a disturbance process originating or 

spreading from a vegetation unit is determined not just by a plant community’s attributes (e.g., 

species, size, structure, and density), but also by what exists around it, what processes are 

occurring around it, and what processes have occurred in the past. Rather than a transition 

matrix approach, process probabilities are used in a stochastic fashion for each individual 

vegetation unit. Disturbance processes with a low probability of occurrence are often the ones 

that determine the pattern of a landscape and future events. 

To be spatially interactive requires that the input for SIMPPLLE has to be processed through a 

geographic information system (GIS). SIMPPLLE does not execute within a GIS framework; 

however, the files that are used to create SIMPPLLE input files must be developed from a GIS. 

The means for developing the SIMPPLLE input files and for displaying the output have been 

developed for ESRI’s ArcGIS. However, it could be possible for other geographic information 

systems to be utilized. All of the required ArcGIS products are included in the downloaded 

executable for SIMPPLLE. Within some of the SIMPPLLE user interface screens, there are choices 

that are shaded out, indicating features that are either not fully developed yet, or not available 

for the stage the user is at within the system. In using SIMPPLLE, there are choices that have to 

be made that are related to the analysis objectives, the issues, and the inventories available. 

These are discussed under the section “Decisions to Make Prior to Simulations.” The choices one 

makes have a significant impact on the amount of computer resources needed and the time 

taken to make the simulations.  

SIMPPLLE consists of the necessary GIS tools, the SIMPPLLE modeling environment, and 

Microsoft Excel spreadsheets with macros for processing simulation output. Since the initial 

release of SIMPPLLE 1.0 in 1997 for the Westside Region One and Eastside Region One, Forest 

Service, the system has been expanded to cover additional geographic zones. Each of these 

areas has unique conditions that require changes and new features in SIMPPLLE. The appendices 

contain the valid values for the nonspatial attributes for all the geographic zones and a 

discussion of the system knowledge. Not all zones are described in the same level of detail.  

 

2. APPLICATION OF SIMPPLLE 

SIMPPLLE has been applied by both individuals and teams.  It has been applied for a range of 

research projects (Chew 2003; Chew and others 2000; Jones and Chew 1999, 2000; Jones and 

others 1999) planning projects within the Forest Service (Slaughter and others 2003), Bureau of 
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Land Management (USDI 2005), U.S. Geological Survey and the National Park Service (Turner 

and others 2008), States (State of South Dakota 2006) and private organizations (Ecosystem 

Research Group 2006; Haufler and others 2008; Mehl and others 2009).   The modeling system 

features that enable this range of applications are the same features that facilitate the use of 

SIMPPLLE in collaborative efforts. 

 

The use of SIMPPLLE is very appropriate for two trends in natural resource management that 

have emerged: a trend toward engaging stakeholders in participatory, collaborative processes, 

and a trend toward wider use of modeling to help manage the inherent complexity of natural 

systems. Collaborative engagement of stakeholders results in more inclusive and transparent 

decision making, which can engender greater acceptance of decisions and a wider sense of 

stewardship (Wondolleck and Yaffee 2000). The trend toward the use of modeling in resource 

management addresses the need to accommodate the numerous and complex interactions of 

natural systems (Jakeman et al. 2006).  To adequately represent the inherent complexities of 

natural systems one has to address the interactions and feedback among individual components 

of the system.  Although a large number of models are available to address individual 

components of natural systems and their integration, their data requirements and their 

computing needs often exceed what is appropriate for a usable management tool.  SIMPPLLE is 

a modeling system that utilizes a range of model types, from empirical to phnenomological, to 

mechanistic and rule based, to provide the integration at a level that can serve as a 

management tool.   

 

The following is an overview of the steps to run SIMPPLLE and the manual sections that contain 

the detailed information: 

1. Install SIMPPLLE (Section 4) 

2. Make memory management decisions (Section 5) 

3. Create SIMPPLLE input files (Section 6) 

4. Make decisions on simulation parameters (Section 7) 

5. Execute a simulation (Section 8) 

6. Make choices for output (Section 9)  
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3. GEOGRAPHIC ZONES AVAILABLE 

Geographic Area Sample Landscape 

Forest Service – Westside Region One Bitterroot National Forest, Montana 

Forest Service – Eastside Region One Helena National Forest, Montana 

Sierra Nevada Yosemite National Park, California 

Southern California Angeles National Forest, California 

South Central Alaska Kenai Peninsula, Alaska 

Gila Gila National Forest, New Mexico 

South West Utah Beaver Creek Drainage, Utah 

Michigan No sample landscape 

Colorado Front Range Portions of two National Forests, Colorado 

Colorado Plateau Mesa Verde National Park, Colorado 

Western Great Plains Steppe Thunder Basin National Grassland, Wyoming 

Mixed Grass Prairie Landscape from South Dakota 

Great Plains Steppe Landscape from South Dakota 

Teton No sample landscape 

Northern Central Rockies No sample landscape 

Zone builder No sample landscape 

Table 1 Geographic areas available for SIMPPLLE version 2.5. 

 

The two zones for the Forest Service, Region One, were developed with funding from the Region 

and represent the initial development of SIMPPLLE. A Joint Fire Sciences funded project, Project, 

98-1-8-06 (a risk-based comparison of potential fuel treatment tradeoff models (Weise et al. 

2000, 2003), provided the funding for a model comparison study developing two California 

zones, south central Alaska, the Gila Forest, southwest Utah, and Michigan. A second Joint Fire 

Sciences funded project (Kaufmann et al. 2001) funded the development of the Colorado Front 

Range Zone. Funding and expertise from the Ecosystem Management Research Institute (EMRI) 

of Seeley Lake, Montana, provided the basis for the development of the three grassland zones 

(Ganguli et al.  2007). The U.S. Geological Survey’s (USGS) project of Framing Research for 

Adaptive Management of Ecosystems (Turner et al. 2008) provided the funding to participate in 

their effort on Mesa Verde National Park to develop the Colorado Plateau zone. A grant with 

Montana State University covered the incorporation of the invasive species logic for the Eastside 

of Region One. The Teton and Northern Rocky Mountain zones were funded by the Teton 

County Conservation District. The Zone Builder represents the long-term goal to allow users to 

completely build a new geographic zone through the user interface without the involvement of 

the system developers. This effort is still incomplete in version 2.5. 

Most zones come with a sample landscape that can be loaded and simulated. Many of the 

sample landscapes have GIS files available that can be downloaded separately from the 

SIMPPLLE website download page:  
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1. Go to http://www.fs.fed.us/rm/missoula/4151/SIMPPLLE/downloads.html.  
2. Select GIS Extras Installer (GIS datasets for sample areas).  
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4. INSTALLING SIMPPLLE 

Two executables for installing SIMPPLLE version 2.5 can be obtained from the SIMPPLLE 

website: http://www.fs.fed.us/rm/missoula/4151/SIMPPLLE/. One executable is for Microsoft’s 

64-bit operating system, both Vista and XP (simpplle-2.5.19-install-x64.exe). The second is for 

Microsoft’s XP 32-bit operating system (simpplle-2.5.19-install-x32.exe). 

To install SIMPPLLE from the executable after downloading it to your computer, execute the 

appropriate executable (*.exe) file and follow the instructions, accepting the defaults 

recommended.  The installation places a SIMPPLLE icon on the computers desktop. 

5. MEMORY MANAGEMENT 

SIMPPLLE makes an initial assignment of your computer system’s memory to the Java Max Heap 

Size when the installation is made. On 64-bit operating systems the default is set to 90 percent 

of the available memory. On 32-bit operating systems, the default is set to 1100 MB.  

To adjust memory, select Utilities > Change Java Heap Size (Figure 1). 

 

 
Figure 1 Location of Change Java Heap Size choice in user interface. 
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The Java Max Heap Size (MB) window will appear (Figure 2). 

 

 

 
Figure 2 Dialog box for changing Java Heap Size. 
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The value may need to be lowered to 512 MB if you have only 1 GB of memory. Sometimes, 

trying to assign too much memory may make it impossible to start SIMPPLLE, and you will get a 

Java error. If this is the case, you will have to edit a file in the SIMPPLLE installation directory. 

This file is “SIMPPLLE.ini” in the SIMPPLLE 64 bit installation directory (Figure 3) or 

“SIMPPLLE.bat” in the 32 bit installation directory (Figure 4). The location of these files can be 

easily found by going to Start >Programs > SIMPPLLE > Application Folder. 

 

 

 
Figure 3 Line in the SIMPPLLE.ini file to be edited for changing the Java Heap Size. The two 90s 
(highlighted) can be set to a lower value. 
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Figure 4  Line in the SIMPPLLE.bat file to be edited for changing the Java Heap Size. The 1100 can be set 
to a lower value. 

 

As simulations are run, the amount of memory used is displayed at the bottom of the main 

screen. The information for each landscape unit, time step, and fire event is kept in memory. 

This provides for maximum flexibility in producing reports after the simulations are made; 

however, it requires considerable memory. There are options on the simulation parameter 

screen to reduce the memory required. One option is to discard unnecessary simulation data. If 

this option is selected, there are limitations on the reports that can be made. Writing to a 

database can help to reduce these limitations; however, it does increase the simulation time. 

The database is discussed further under “System Output.” 

6. SIMPPLLE INPUT FILES  

Two files created in ArcGIS are imported into SIMPPLLE to create the input file that represents a 

landscape: spatial attributes (named “user-provided-name.spatialrelate”) and nonspatial 

attributes (named “user-provided-name.attributesall”). 

The spatial attributes are the relationships between the components carried in SIMPPLLE, which 

can be existing vegetation units, land units, aquatic units, and manmade units. The range of 

spatial relationships depends on the landscape components being modeled. If landscape 

components are utilized in addition to existing vegetation, their associated spatial relationships 

and attributes are included in the two files. 

USDA Forest Service Gen. Tech. Rep. RMRS-GTR-268WWW. 2012 9



 

SIMPPLLE GIS tools create both files from the ArcGIS environment. 

The geographic extent represented by these input files is dependent on the issues to be 

addressed. Based on prior analyses, 6th field hydrologic code units (HUCs) appear to be too small 

to simulate by themselves when considering spreading disturbance processes. Many 

disturbance processes originate outside and spread into most drainages of this size. The 

exception is when watershed boundaries function as barriers and prevent disturbance processes 

from spreading. A combination of several 6th field HUCs or a single 5th field HUC is an 

appropriate minimum size to simulate. The plant communities in these areas can be as small as 

one acre or less. The maximum size of a plant community is determined by the size of an area in 

which spatial relationships are important and what can be handled by the memory limitations of 

SIMPPLLE on the computer being used. Currently, 4th level subbasins represented by 10 acre 

uniform sized polygons are a reasonable upper limit. We have simulated entire ecological 

sections of millions of acres, but the vegetation unit size has been increased to 20 acres or larger 

and the number of long term simulations is very limited even with discarding unnecessary 

simulation data. 

6.1 NONSPATIAL ATTRIBUTES 

Each landscape component (vegetation, land, aquatics, and manmade) must be represented in a 

separate feature class or coverage in ArcGIS. Attributes for each class are needed. The valid 

values for the nonspatial attributes for each geographic area are covered in an appendix for 

each area. These fields must be manually added to the feature classes. For version 2.5, the field 

names and formats must be identical to what is shown. There is no required order within the 

GIS files. 

It is recommended that all these fields be created and edited within ArcMap or Catalog 9.3 or 

9.3.1 on feature classes within a file geodatabase. If previous work was done in shape files, we 

do not recommend continuing to work with these, but import these into a file geodatabase first. 

There are field size limitations in shape files that are not compatible with the field names we 

use. Although ArcMap and Catalog are not case sensitive, some python scripts are, so make sure 

all field names are upper case. Null cannot be a value in any field. The length of the text fields 

depend on the descriptors used for the specific geographic area. 

6.1.1 Vegetation 

The level of vegetation attributes required is dependent on the way that SIMPPLLE uses them in 

combination with other variables to generate a probability for disturbance processes (Chew et 

al. 2004). 

SIMPPLLE can represent a single dominant vegetation life form for each plant community or any 

combination of three life forms: trees, shrubs, and herbaceous. All the species belonging to each 

life form will have separate pathways in the system. 
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Although the pathways are separate, an additional component allows for interaction between 

the life forms that are present, allowing for the density of one life form to be impacted by the 

density of the others (see “System Knowledge” section). 

There are multiple ways to create files of the existing vegetation attributes and other optional 

fields for the units in the GIS coverages. The most common has been to use data from a 

vegetation management record system, satellite imagery, or a combination of the two. 

SIMPPLLE can represent vegetation as irregular size units derived from vector GIS files or 

uniform sized units from raster GIS files. 

The question of the accuracy of inventory data and the assignment of attributes to individual 

plant communities is left to the user to resolve. The user makes choices on how to represent a 

landscape for modeling purposes when the attributes are assigned in the data. It is the user’s 

responsibility to express the limitations of making choices about the representation of spatially 

explicit plant communities. 

The fields in an ArcGIS cover or feature class required depend on whether you are using single 

life forms or multiple life forms and if you are using Tracking Species. The order in a cover or 

feature class attributes table is not important, however, the spelling is. The format for the field 

required by ArcGIS is specified in parenthesis. 

Fields for the entire vegetation unit regardless of single or multiple life form: 

SLINK (created by script) 

This field provides the link between the unit in SIMPPLLE and the GIS environment. 

It is added by one of the SIMPPLLE ArcGIS toolbox options. If the field already exists, it will be 

recalculated by the script. Once SIMPPLLE Spatial Relations has run, it is important to use the 

geodatabase created so the SLINK field will properly match what SIMPPLLE is using as identifiers 

for units. 

HT_GRP (required – text) 

This field for ecological stratification started as habitat type group values in the first geographic 

zones developed. HT-GRP has been broadened in concept and varies for each geographic zone 

(see appendices A through I). HT_GRP ranges from no stratification, to broad classes of elevation 

and aspect, to specific soil types. Within the user interface screens, the name has been changed 

to Ecological Grouping. All of the system knowledge can be varied by this stratification/grouping 

by the user choosing to add a column for this field to the probability and logic screens.  

ACRES (required – long) 

Acres of the individual unit. 

USDA Forest Service Gen. Tech. Rep. RMRS-GTR-268WWW. 2012 11



 

STAND_ID (required — text) 

A number (although represented as text) that can be tied to other record keeping systems. For 

vegetation, this is often a vegetation management record keeping number. It must be set to 

zero if it is not used.  

OWNERSHIP (optional — text) 

To utilize the fire suppression logic, ownership needs to be: National Forest Wilderness (NF-

WILDERNESS), National Forest Other (NF-OTHER), or OTHER. OTHER can be State, private or 

other federal ownership or more specific, but in its use with fire suppression logic it all is treated 

as other. The user does not have to make differences in fire suppression by ownership and 

wilderness versus non-wilderness, but the system does provide the capability. 

ROADS (optional — text) 

The road status can be identified in two ways. If road units are not created for the landscape 

file, the user can (in the GIS environment) decide what status to assign to each plant 

community. The road status can then be used in the fire suppression logic (if the logic includes 

road status). It needs to be one of the three: Open Roaded (O), Closed Roaded (C), or None (N).  

If roads units are part of the landscape file, which they need to be for the Eastside Region One 

zone for invasive species, this status value is determined dynamically. Treatments can be utilized 

to close and open roads. 

ELEV (optional — long) 

If this field is not used, a digital elevation model must be identified when running the SIMPPLLE 

spatial relations tool from the SIMPPLLE toolbox. The system uses a difference of 10 percent in 

the mean elevation of a unit to determine if a neighbor is above or below a vegetation unit. At 

the time of area-file creation a window will appear, allowing the user to change the percent, or 

the Elevation Relative Position choice under the utilities menu can be used.  Both the elevation 

and distance in the feature classes has to be in meters. 

FMZ (required — text) 

This field is for designating the fire management zone (FMZ). These are delineations that have 

had some meaning for fire management planning (fire suppression and fire occurrence). There is 

usually variation in terms of numbers of past fires, suppression costs, and suppression policy.  A 

delineation may be utilized to represent a wildland urban interface. If no zone value is used, All 

is interpreted for the field. 

SP_AREA (optional — text) 

This field can be used to facilitate a spatial breakdown of the outcome from SIMPPLLE in the 

reports. In past analyses we have seen drainage designations, wildlife management units, Forest 

Plan Management Areas, and a broad designation of Forest versus non forest ecological types 

used. If the field is used, it cannot be blank, have a space, or have a dash in the value.  All of 

these cause problems in Excel macros or ArcGIS. An underscore can be used. 

USDA Forest Service Gen. Tech. Rep. RMRS-GTR-268WWW. 2012 12



  

LANDTYPE (optional — text)                            

This field can be used to assign to a vegetation unit some feature of the land that it occupies.  
This can be utilized if a user does not want to create a GIS layer of land units to incorporate into 
SIMPPLLE.   

Vegetation fields for single life form: 

SPECIES (required — text) 

The dominant species may be assigned from any source of input that is available. Its assignment 

should match guidelines from the inventories in the geographic area. 

SIZE_CLASS (required — text) 

There is variability in how this attribute is represented across zones. One has to use values that 

are tied to inventories and needed for a combination of interpretation and influence on 

disturbance processes. The user must be aware that if structure is built into pathways it may not 

always be shown in initial vegetation conditions because of limitations from an inventory. 

However, simulation will “add” structure according to the vegetative pathways over time steps 

(see appendix for specific zone) showing a significant increase in structure. 

DENSITY (required — text) 

There is variability by zones, but all utilize absolute canopy cover because it is most easily 

obtained from remote sensing and most commonly found in inventories. 

PROCESS (optional — text) 

This can be used to provide SIMPPLLE with a disturbance process history that can be utilized in 

the initial simulation time steps. If used, the Process_T field must also be utilized.  

The values must be one of the acceptable disturbance processes used in the system. This is not 

the same as identifying a current, ongoing process. See the “lock-in” process feature for current 

processes. Without specifying a disturbance process, each plant community starts out as if 

succession was occurring. 

TREATMENT (optional — text) 

This field can be used to provide a treatment history for the initial simulation time steps. 

PROCESS_T (optional — long) 

The number of time steps past that the process occurred. Although you can put values of more 

than 1, SIMPPLLE currently always uses a value of 1. 

TREAT_T (optional — long) 

The number of time steps past that the treatment occurred. Although you can put values of 

more than 1, SIMPPLLE currently always uses a value of 1. This field is used inside SIMPPLLE to 

keep track of time steps since simulated treatments as well. 
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6.1.2 Multiple Life Form Input Fields 

To use multiple life forms requires additional fields in the GIS files. If the inventories do not 

contain this information it can often be added by extrapolating from sources such as Forest 

Inventory and Analysis (FIA) plots. If it has not been added, but the SIMPPLLE area file must be 

multiple life forms to be able to run a specific feature (such as using invasive species in the 

Eastside Region One), there is a choice under Utilities that will convert the file to be recognized 

as having multiple life forms even though no additional values exist. This will have an impact on 

the summary report and the user must keep this in mind. See “Notes” under “Reports.” 

The species, size-class, density, process, and treatment have to be expanded to account for each 

life form. The following abbreviations used are shown in Table 2. 

 

 

Abbreviation Definition 

TR Trees 

S Shrubs 

H Herbaceous 

A Agriculture 

N Non-Forest 

PROC Disturbance Process 

TREAT Treatment  

Table 2  Abbreviations used with multiple life forms. 

 

 

The required fields in a text format are: 

SPECIES_TR 

SPECIES_S 

SPECIES_H 

SPECIES_A 

SPECIES_N 
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SIZE_TR 

SIZE_S 

SIZE_H 

SIZE_A 

SIZE_N 

DENSITY_TR 

DENSITY_S 

DENSITY_H 

DENSITY_A 

DENSITY_N 

PROC_TR 

PROC_S 

PROC_H 

PROC_A 

PROC_N 

TREAT_TR 

TREAT_S 

TREAT_H 

TREAT_A 

TREAT_N 

PROC_TR_T 

PROC_S_T 

PROC_H_T 

PROC_A_T 

PROC_N_T 
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TREAT_TR_T 

TREAT_S_T 

TREAT_H_T 

TREAT_A_T 

TREAT_N_T 

6.1.3 Tracking Species Input Fields 

Tracking species can be used with single and multiple life forms and any life form (trees shrubs, 

and herbaceous). This is used for two cases. One case is with grass communities where users do 

not want to use a size and density, but an aggregate of species (see Appendix H for the 

grassland zones). The second is to account for invasive species in the two zones that have logic 

for invasive species, Eastside Region One and Colorado Plateau. 

To use tracking species as a means to represent plant communities, the pathways have to be 

built to identify the species that comprise the aggregate and will be tracked. Within the 

pathways, the inclusion rule has to be identified for what species have to be within certain 

percents to identify the state. The rate of change (as a percent of what exists) for all species and 

all possible disturbance processes has to be identified. If a species listed to track has a zero value 

in the attributes file that comes from the GIS cover, and it is not a species listed in the ecological 

stratification as a species to track, it is not brought into SIMPPLLE. If the species value in the 

attributes file that came from the cover is greater than zero but there still is no species change 

information for it within the pathway files, it will be brought in, but the species value will not 

change. In this case, the user can edit the pathway file, adding in change values for this new 

species. Additional information on inclusion rules and rates of changes is covered under the 

discussions on Pathways. 

For tracking invasive species, the species has to be checked as invasive in the species attributes 

editor and the rate of change and a threshold value has to be provided in the invasive species 

system knowledge. 

There is no limit for the number of species that can be tracked.  

Each species being tracked must include a field for the species name (text format) and a field for 

the percent of cover (long format):  

SPTK_TRx  SPTK_TRxP 

SPTK_Sx  SPTK_SxP 

SPTK_Hx  SPTK_HxP 
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SPTK_Ax  SPTK_AxP 

SPTK_Nx  SPTK_NxP 

The tracking species number from 1 to the number of tracking species, with the number within 

each life form is represented by x. These values have to be attributed for all records in the 

vegetation feature class, even if the value is zero. 

The following components in SIMPPLLE are necessary only if you are working in a zone that 

requires them or for the features desired. 

6.1.4 Land Units 

Land units have been used in two geographic areas. They have been used in the Colorado 

Plateau area to provide soils information that is required in the logic for predicting the 

probability of invasive species. They have been used in the Eastside Region One to provide 

topographic information used in the prediction of the probability of invasive species. 

 

Required fields and format: 

SLINK (added by ArcGIS python script) 

ACRES — long 

SOIL_TYPE — text 

LANDFORM — text 

SLOPE — float 

ASPECT — text 

PARENT_MAT — text 

DEPTH — text 

In the case of the Eastside Region One, only slope and aspect are used for predicting the 

probability of invasive species. Since the other fields are still required, but not used, one can just 

enter any valid value in the field and make it the same for all units. 

6.1.5 Aquatic Units 

Fields for the aquatic class were initially created for a prototype that displayed the capabilities 

to include the dynamics of stream reaches. They have been used in the grasslands zones to 

identify water sources for bison grazing. In this case, we simply make the LTA_GRP, AQ_CLASS, 
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AQ_ATTRIB, and INT_PROCESS, have the same value for all units. The status field is used to 

identify if the stream reach, aquatic unit, is perennial or intermittent. 

Required fields and format 

 SLINK (added by ArcGIS python script) 

 LENGTH — double 

 LTA_GRP —  text 

 AQ_CLASS — text 

 AQ_ATTRIB — text 

 SEG_NUM — short 

 INIT_PROC — text 

 STATUS — text 

Until further development of the aquatic component of the landscape is done in a geographic 

zone, the only valid values available for these fields are those from the initial prototype study 

that was done in the Westside Region One zone (see Appendix A). 

The LTA_GRP has values that represent Landtype Association, valley bottom groupings. 

Any of the following values (defined in Appendix A) can be used: 

 12-FMA 

 12-FWC 

 12-FWB 

 45-41-FMA 

 45-41-FNA 

 51-FMA 

 51-UWB 

 51-FWB 

 62-72-FNA 

The AQ_CLASS has values that represent the Rosgen type assigned the stream unit. Any of the 

following values can be used: 
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 A1, A2, A3, A4 

 B2, B3, B4 

 C4 

 D4 

 E4 

 G3, G4 

The AQ_ATTRIB is intended to represent the status of temperature, stream bank stability, large 

woody debris, and stream bed conditions. Different combinations of these variables being in or 

out of reference conditions were developed. For the purpose of using an acceptable value for 

the system, use: REF. 

The INIT_PROC has values that are intended to be representative of the dynamics of an 

individual stream reach. For the purpose of using an acceptable value for the system, use: 

STREAM-DEVELOPMENT.  

STATUS has been added to meet the needs for the grassland zones modeling bison grazing. This 

has two possible values: PERENNIAL or INTERMITTENT. 

Small polygons of water can be converted to arcs if desired. Through the use of Change Rules 

and Tracking Species, and the Regional Climate variable, ecological types can vary between 

water and vegetation.  

6.1.6 Roads  

The only use of the road class has been in the Eastside Region One area in connection with 

predicting the probability of invasive species. Even when they are in the system (the area file) 

we have not added the means to look at these features. 

Required fields and valid values:  

Required fields: 

STATUS — text 

Values 

OPEN 

CLOSED 

PROPOSED 
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ELIMINATED 

UNKNOWN 

KIND — text 

Values 

SINGLE_LANE 

DOUBLE_LANE 

UNIMPROVED 

SYSTEM 

NONSYSTEM 

UNKNOWN 

6.1.7 Trails 

The only use of the trail class has been in the Eastside Region One area in connection with 

predicting the probability of invasive species. Even when they are in the system, the area file, we 

have not added the means to look at these features. 

Required fields: 

STATUS — text 

Values 

OPEN 

CLOSED 

PROPOSED 

ELIMINATED 

UNKNOWN 

KIND — text 

Values 

HIKE 
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6.2 SPATIAL ATTRIBUTES 

Version 2.5 includes a SIMPPLLE ArcGIS toolbox. It needs to be added to the toolboxes in 

ArcMap (and ArcCatalog) after installing SIMPPLLE by right clicking in the toolbox space to open 

up a dialog box with the option Add Toolbox (Figure 5). In the resulting dialog window, enter 

the pathway and file name to where the SIMPPLLE toolbox is located under the installed 

directory (Figure 6). This information is included in a file that can be displayed during the 

SIMPPLLE installation process. 

 
Figure 5 Instructions for adding the SIMPPLLE ArcGIS Toolbox. 
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Figure 6 The choices available in the SIMPPLLE toolbox under ArcMap. 

The following spatial relationships are used in SIMPPLLE. 

For vegetation, we identify the set of adjacent neighbors for each vegetation unit. If using 

irregular polygons it is any unit that shares a boundary. If polygons are uniform, the system can 

identify a maximum of eight neighbors. Each neighbor is identified as being Above, Below, or 

Next To by comparing the elevation of the center of the plant community. The elevation has to 

come from either an elevation field in the cover for the vegetation or a digital elevation model. 

The neighbors that are Downwind are identified by providing a dominant wind direction for the 

landscape. The distance to the nearest aquatic unit and distance to nearest road unit is 

calculated in SIMPPLLE. 

For aquatics, the upstream predecessor and the successor aquatic unit in the network is 

identified. We identify what vegetation units are adjacent to each aquatic unit. 

For constructed features of roads and trails, the predecessor and successor in the network is 

identified. 

For land units, we identify the adjacent neighboring land units (similar to vegetation) and the 

vegetation units that coincide with it. 
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6.3 GIS PROCESSING OF INPUT DATA 

After all of the initial landscape components have been attributed in the GIS environment, a 

choice on the shape and size of the vegetation units has to be made. If the units are irregular 

polygons, are they to be left that way or converted into uniform polygons and of what size?  If 

the units were initially grid data are they to be left at the original size or combined into larger 

units?  Through the use of the SIMPPLLE GIS toolbox, the user has a choice to model irregular 

polygons, or convert them to uniform, rectangular size polygons, essentially a grid, or to 

aggregate small grids into larger uniform size polygons. 

Within SIMPPLLE, a disturbance process or management treatment is modeled to apply to all of 

a plant community. SIMPPLLE does not split existing vegetation units. If an initial coverage 

consists of irregular size polygons with a wide range of sizes, the user may not like how 

SIMPPLLE spreads the processes in irregular size units. Uniform sized units are recommended. 

Because of the GIS tools used to determine the spatial relationships between SIMPPLLE units, 

we need to convert any grid input into polygons within the GIS environment. The resulting 

coverages have the appearance of being a grid. A polygon coverage is used for the advantages it 

provides in spatial display of output and the ability to join modeled results back to the coverage 

polygons. 

In the SIMPPLLE toolbox, PolyToPolyCells (Figure 7) creates a feature class of uniform 

rectangular size polygons of the acreage the user identifies from irregular sized polygons. 

GridToPolyCells (Figure 8) will take small grids (e.g., 15–30 meters) and create uniform polygons 

of a larger, user specified size. 

Following the conversion of units using either of these two tools, SIMPPLLE Spatial Relations 

(Figure 9) must be run in order to create the two files to be imported into SIMPPLLE.  

A feature class of the plant communities (and any other landscape component) must exist in an 

ArcGIS file geodatabase, regardless of the original source of the polygons. A digital elevation 

model (DEM) for the landscape also must exist (or an elevation field must be in the vegetation 

and land covers). As a road or trail feature class is converted into a cover, one must do a BUILD 

on NODE followed by a BUILD on LINE prior to using them as input to SIMPPLLE Spatial 

Relations. All feature classes and the DEM must be in the same projection. The elevation from a 

field or from a DEM is used to determine if each plant community’s neighbors are Above, 

Below, or Next To it. This is computed dynamically as SIMPPLLE is executing using a percent 

difference in elevation between the unit’s center points. The distance in the feature class, the 

elevation field, and elevation in a DEM must all be in meters. To change the percent difference, 

select Utilities > Elevation Relative Position. Older landscape files that had the relative position 

determined prior to file import can still be utilized. With new files that contain the elevation for 

each vegetation unit, the percent value can be changed with the utility and new simulations 

made to test the difference in how relative position is calculated. 

USDA Forest Service Gen. Tech. Rep. RMRS-GTR-268WWW. 2012 23



 

 

 

 
Figure 7 Screen to provide input for running SIMPPLLE poly2polycells. 

USDA Forest Service Gen. Tech. Rep. RMRS-GTR-268WWW. 2012 24



  

 
Figure 8 Dialog box to provide input for running the SIMPPLLE gridtopolycells from the toolbox. 
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Figure 9 interface screen for SIMPPLLE spatial relations started from the toolbox in ArcMap. 
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6.4 IMPORTING FILES WITHIN SIMPPLLE:   

Importing can only be done after the SIMPPLLE Spatial Relations tool is run in the GIS 
environment. Select Import > Create New Area (Figure 10).  
 
 

 
Figure 10 Selecting Create New Area from the SIMPPLLE interface. 

 

The user will be prompted for the name of the file that resulted from executing the SIMPPLLE 
spatial relations tool (Figure 11). If a working directory is designated under File and the results 
are placed from running the tool in the working directory, then the system will open up the 
dialog box listing all the files ending with the “*.spatialrelate” extension. 

 

 

 
Figure 11  SIMPPLLE dialog box to provide the name of the file containing the spatial attributes. 
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After selecting and choosing Open, the system will find the corresponding “*.attributesall” file 
with the same prefix name that has been created and placed in the same directory. 

As the files are processed, the existing vegetation attributes that are created are compared to 
the system knowledge for the geographic area. 

Incompatibilities will result in invalid units. The following problems will result in the display of 

Figure 12: 

 FMZ values in the fields but not having an FMZ (fire occurrence) file loaded that 
recognizes the zone values 

 Combined existing vegetation states do not match potential states in the pathway files  
 
 

 
Figure 12 SIMPPLLE screen that identifies the creation of area was only partially successful. Options are 
provided to fix the problems. 
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An example of the log file mentioned above is displayed in Figure 13. 

 

 

 
Figure 13  Log file identifying invalid units. 
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The editing options within the Import drop-down menu are shown in Figure 14. 

 

 

 
Figure 14 SIMPPLLE Import choices with edit options after an attempt to create a new area file was only 
partially successful. 

 

 

Import > Fix Incorrect States is not available in all geographic areas. It was developed in one 

geographic area, Eastside Region One, to test logic that was an attempt to automatically correct 

invalid states. 

Import > Invalid Units Report can be used to create a text file of unit ids that are invalid, but is 
not as useful as the “log file” above. 

If Import > Edit Units is selected, Figure 15 is displayed. To open the same editor, select Utilities 
> Open Unit Editor. 
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Figure 15 SIMPPLLE screen identifying an invalid vegetative unit. 

 

In this case, the Vegetative Type is invalid because we have large, two-storied (LTS) for a 

sizeclass/structure combination. In the pathways for this zone, two-storied stands are not 

identified for subalpine fire (AF) but multistoried (MU) is. One can either go back and modify the 

pathway (or if the wrong pathway files have been loaded, load new ones) or edit this invalid 

state through the user interface.  To edit the invalid state, click Utility > Global Changes for all 

units that have the same invalid attributes (Figure 16). This process can be repeated for all 

invalid units and then the corrected landscape file can be changed. 
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Figure 16  The global change screen to correct invalid attributes. 

 

 

However, any changes made through the user interface are not made in the “*.attributesall” 
file, the geodatabase that was created, or the original feature class. In most cases, one will want 
to go back to the original feature class, make the changes and rerun SIMPPLLE Spatial Relations. 

If we have no invalid states, an Area Import Succeeded screen will appear. This screen reminds 
you to give the area a name using Utility > Change Area Name and then save the area (*.area) 
file using File > Save. 

Utilities > Change Area Name provides a dialog box to insert a name for the landscape. This is 
not a file name, but the name within the file that still has to be saved. It is just the name that 
will be used on SIMPPLLE screens and in many reports. After providing the desired name we can 
now save our new landscape file so we will have it for future simulations. The name provided 
here for the file name does not have to match the name just given to the area. 

File > Save Area will open a dialog box at the working directory level for the user to provide a 
name. The area (*.area) extension will be automatically added to the saved landscape file name. 

7. DECISIONS TO MAKE PRIOR TO SIMULATIONS 

7.1 VEGETATION—SINGLE OR MULTIPLE LIFE FORMS  

The use of multiple life forms is necessary if the system is to be used to address invasive species. 

If this decision was not made when the vegetation was attributed in the GIS files a utility can 

change the file without the initial input, select Utility > Change Area to Multiple Lifeform. 

7.2 SINGLE OR MULTIPLE SIMULATIONS  

Single simulations are often used to check system behavior and to gain an understanding of how 

changes have an interacting effect on many processes. The short time it takes to make a 

SIMPPLLE simulation makes it easy to use in a team environment to test system knowledge and 

to design and evaluate management options.  
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Multiple simulations are most often used to help quantify a range of outcomes on management 

options once they have been designed. A statistical test (see Appendix M) is provided with the 

Microsoft Excel spreadsheet template that comes with SIMPPLLE to compare the distribution of 

outcomes to see if there are any significant differences. Multiple simulations can be used to 

provide quantification for the concept of a range of variability in both vegetation attributes and 

disturbance processes. They can be used with long-term simulations to help provide a 

quantification of historic landscape conditions. When making multiple simulations, you have the 

option of tracking by ownership and Special Area within the data set. This enables the file using 

the Excel macro to be stratified by these levels. When making multiple simulations a location 

and a prefix to go with the files that are created must be identified. 

7.3 NUMBER OF TIME STEPS  

Short-term time step simulations (1–5 decades) are often used to provide a means to compare 

alternative management scenarios or current trends. 

Long-term (greater than 5 decades) time step simulations are most often used to help quantify 

the interaction and cycling of disturbance processes and vegetation conditions. Long-term 

simulations (5–10 decades) without fire suppression are one way to help provide a 

quantification of historic conditions for a specific landscape. 

7.4 HOW MANY SIMULATIONS TO MAKE  

The number of simulations to run depends on both the size and the variability of vegetation 

within the area. Based on previous work, 30 simulations appear to be adequate to capture the 

variability created within SIMPPLLE. An Excel spreadsheet with a statistical test is provided to 

make it possible to test sets of simulations to see if additional simulations increase the 

variability of specific attributes (see Appendix M).  

7.5 FIRE SUPPRESSION  

Simulations to compare management options are usually made with fire suppression. Making 

simulations without fire suppression is most commonly used with long term simulations to 

create an interaction between fire, insect and disease disturbances and the vegetation pattern 

to quantify a historic range of variability. If fire suppression costs are incorporated, however, 

they are very simplistic.  The user can access the dialogue System Knowledge > Vegetative 

Process > Fire Suppression Costs.  Costs are assigned on a per acre basis, by fire size class, and 

by fire management zone. 

7.6 SIMULATION METHOD  

There are three choices for simulation method.  Stochastic is the most common simulation 

method used. A Monte Carlo approach is used with the probability values for each disturbance 
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process calculated for each individual plant community to reinforce the concept that our 

landscapes are not always shaped by processes that have a high probability of happening on any 

given acre. The probability of many events is relatively low, but when these disturbance events 

happen, they make significant changes that shape the development of the landscapes. 

Stochastic, multiple simulations can be used to create the probability of vegetation attributes 

existing or disturbances occurring within a landscape. They are also useful to help add 

quantification to the concept that there is variability in the outcome in our landscapes. For some 

analyses on a very specific location of treatment choice (e.g., for example fuel management 

treatments) it may be more useful to lock-in specific disturbance processes to see how the 

landscape will vary with or without the treatments. Highest Probability will utilize the 

disturbance process that has the highest probability for each plant community. Choosing Stand 

Development as a simulation method can be used to eliminate all disturbance processes. This 

will create a landscape in which all plant communities will simply grow older.  

7.7 DECADE, YEARLY, OR SEASONAL TIME STEPS 

The default time step is decades. However, some of the interactions between processes, such as 

fire, insects, or the response of grasses to yearly moisture changes, make more sense if the 

system is run with yearly time steps. For some geographic areas, such as the grasslands, the 

interaction between processes is important on a seasonal basis. For these geographic areas, the 

default time step is yearly. For those geographic areas where the user can chose between yearly 

or decade time steps, most system knowledge is automatically adjusted. Two system knowledge 

components that the user must adjust are: 

 Regeneration delay—this has to match the user’s choice of time steps 

 Rate of change for tracking species when used for invasives—user has to make this 
match the time step 

Both of these changes can be made through the user interface. 

7.8 PREDICTING INVASIVE SPECIES    

This can be used only if the logic is included for the geographic zone / area in use. 

In this release of version 2.5, only two geographic areas have logic for invasive species; the 

Colorado Plateau and the Eastside of Region One  

7.9 LOCKING IN DISTURBANCE PROCESSES  

Any disturbance process can be scheduled in a plant community by locking it in for a specified 

time step. Without specifying locking-in processes, a simulation begins with the assumption that 

no disturbances processes are ongoing. The simulations can be more realistic by accounting for 

processes that the user knows are currently active, such as mountain pine beetle or root 

disease. These processes can be scheduled for the first time step by building a file through the 
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user interface. Processes can also be scheduled to evaluate the impact of possible extreme 

events—large-scale occurrences of processes such as mountain pine beetles or stand replacing 

fires. There are a variety of ways that the user can explore “what if” scenarios. Some 

disturbance processes can be locked in while the system models others stochastic; or, by 

choosing Stand Development for the simulation type, the only disturbance processes will be 

those locked-in. The probability screens for each process can be utilized to selectively zero out 

the occurrence of a process. 

7.10  SCHEDULING TREATMENTS  

To represent management scenarios, treatments have to be scheduled. There are a number of 

ways that this can be accomplished. See more information on treatments under “System 

Knowledge.” 

7.11  TRACKING BY OWNERSHIP OR SPECIAL AREA  

The Special Area field has been used to summarize conditions and processes and to schedule 

treatments by watershed, management areas, or simply a break between non forest ecological 

stratification and forested ecological stratification. These assignments must be made during the 

GIS setup and can be used to stratify results post-simulation (e.g., ownership, forest versus non 

forest, management areas, and HUCs).  

8. MAKING SIMULATIONS 

Making a simulation involves the following steps: 

1. Identify a working directory 
2. Select a zone–geographic area 
3. Load any user modified system knowledge files 
4. Load a landscape 
5. Set simulation parameters 
6. Run simulation  

8.1 IDENTIFY A WORKING DIRECTORY  

The first step is to identify the working directory. This is the area where you want output files 

sent to and may also be where you have the input file for the landscape you wish to simulate. 

File > Set Working Directory opens a dialog box to allow the user to browse to the desired 

location (Figure 17). 

Note: Do not put working files in the installation directory that the installation of SIMPPLLE 

created. 
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Figure 17 SIMPPLLE main menu with choice under the File selection to set the working directory. 

 

The working directory is saved when SIMPPLLE is closed. The next time SIMPPLLE is started, the 

saved directory is recalled. 

8.2 SELECT A ZONE—GEOGRAPHIC ZONE  

After you have identified the working directory, the main screen displays limited options until a 

zone is selected (Figure 18). 
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Figure 18 SIMPPLLE screens for selecting a zone (geographic area). 

 

 

After the zone is loaded, its name is displayed on the screen as the Current Zone, and the New 
Area button is enabled.  
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8.3 LOAD A LANDSCAPE  

After the zone has been loaded, the option to load a new area is now available. There are four 

choices the user can make (as shown in Figure 19): 

 

 

 
Figure 19  Different types of SIMPPLLE area files that can be loaded. 

 

 

Loading the saved file from a previous simulation can be used to create additional reports, GIS 

files that were not created at the time of the initial simulation, or reports for a saved file from a 

set of multiple simulations (see “System Output” section). All the landscape files are identified 

by an area (*.area) extension. Landscape files containing the results of a simulation can be 

loaded as a previously simulated area and have a “*.simdata” extension.  

8.4 SET SIMULATION PARAMETERS  

To run a simulation, select Run Simulation (Figure 20). 
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Figure 20 SIMPPLLE main screen with both a Zone and Area loaded. The choice to Run Simulation is now 
available. 
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This will bring up the Set Simulation Parameters screen, which contains a number of choices for 

the user to select (Figure 21). 

 

 

 
Figure 21 SIMPPLLE screen for the simulation parameters that can be changed by the user. 

 

 

Number of Simulations can be set from one to one hundred. Multiple sets of 100 simulations 
can be made if desired. An option in Excel spreadsheets provides for combining the output files 
from multiple sets of simulations. The limit on the Number of Time Steps is 10,000. The 
Simulation Method can be set to Stochastic, Highest, or Stand Development.  

Invasive Species Logic must match the geographic area being used. At this time, only Colorado 
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Plateau and Eastside Region One have logic for predicting invasive species.  

The time steps can be set as yearly or decade. The default is decade. To change the time steps to 
yearly, check the Yearly Time Steps box. The three grassland geographic areas must use a yearly 
time step. There is no user choice. 

Fire Suppression must be checked, or no fire suppression logic is used. If the Fire Suppression 

box is checked, Discounted Cost is enabled, and the user can chose to have the system calculate 

and discount suppression costs at the rate specified.  

If Ownership and Special Area are attributed in the landscape file, the option to have the output 
file of “*-ls.txt” stratified by these levels can be chosen by selecting Track Ownership or Track 
Special Area. These can only be selected for multiple simulations.   

For a single simulation, no output files are automatically created and saved so no file names 
have to be entered in the Results Output Options. If multiple simulations are made, some 
output files are automatically created using a prefix file name provided by the user. 

If multiple simulations are being made, a directory has to be identified for the output files. The 
prefix for this directory name is also used as a prefix for all files names. Unless the GIS 
Update/Spread Files box is checked, the only GIS files generated for the multiple simulations 
will be those that provide the basis of making probability maps. The update files showing the 
changes in all attributes and disturbance processes by time step by simulation will not be 
generated unless this box is checked. The spread files that show the origin and spread of the 
spreading disturbances such as wildfire will not be generated unless this box is checked. 
Checking this box can result in a very large number of files being created. Often, the approach is 
not to check it, generating only the probability files. After an analysis of the multiple 
simulations, the user can select an individual simulation, reload it and generate the update and 
spread GIS files. However, this is possible only if the simulations were made without discarding 
unnecessary simulation data. 

Simulation choices involve Memory Saving Options that are based on trying to keep SIMPPLLE’s 
system requirements appropriate for the type of PCs in common use at the field level in many 
organizations. The simulation results can be written to a database or past time step data can be 
discarded. There is a minimum of how many time steps to keep in memory. Some of the logic 
associated with disturbance probabilities looks back to use disturbance and treatment history. 
The default and minimum is set at 10 time steps. For the Eastside Region One zone, the 
minimum must be set to 20 time steps for logic that is associated with the conifer encroachment 
process. 

The All States Report requires the detailed data for each plant community for all time steps and 
if the simulations are made discarding data, the reports must be run during the simulation. If 
simulation data is not discarded, these reports can be run after the simulations. 

The Tracking Species Report is designed to be used in two cases: where some plant 
communities have pathways that are defined by percentages of individual species, and where 
invasive species are being simulated. 
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8.5 RUN SIMULATION  

After all parameters have been set, click Run Simulation within the Set Simulation Parameters 

screen. 

A message for the projection of each time step as it is simulated displays at the bottom of the 
main screen. This also displays the amount of memory being used from what is available (Figure 
22). 

 

 

 
Figure 22 SIMPPLLE screen displaying the time step and simulation number being projected and the 
amount of memory used. 

 

 

Once the simulation is completed, the Simulation Finished screen is displayed. Click on OK in 
the dialog box. 

Following a simulation, the results can be viewed in the user interface. If examination of the 
results is satisfactory, a variety of output files can be created using Export, Reports, or 
Interpretation from the main menu (see output section). If no reports are desired, another 
simulation can be started by going back to Run Simulation on the main menu. The system resets 
to original conditions. Running another simulation will result in different output as long as the 
simulation method is stochastic.  

If one wants to continue the simulation from the end point select Utilities > Make Area 
Simulation Ready. 

This will set the landscape to the end point to enable starting a simulation from those 
conditions. The last time step disturbance process is also saved for each vegetation unit so the 
landscape is starting with a one-time step history. 
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9. SYSTEM OUTPUT 

Output from the system is in a variety of forms. Output can be viewed within the user interface, 

reports, interpretations, and export files that can be joined back to the vegetation units within 

the GIS environment. Additionally, there are two Excel macros that help summarize modeled 

results. These outputs vary depending on whether a single simulation or multiple simulations 

are made. The distinction between reports versus interpretations is in the amount of processing 

of plant community attributes needed. For individual simulations, no output files are 

automatically generated. This enables the user to make many simulations to become familiar 

with the system, test ideas, or test changes in values without creating a file management job. A 

set of multiple simulations will automatically generate a number of files. The user has to specify 

the directory location and a file prefix name. Table 3 summarizes what is currently available for 

outputs by the type of simulation.  

  

USDA Forest Service Gen. Tech. Rep. RMRS-GTR-268WWW. 2012 43



 

 

 
Single 
Simulation 

Multiple 
Simulations 
 no memory saving 
options 

Multiple  
With 
database

1
 

Multiple  
Discarding data 

User interface     

Vegetative unit analysis         X           X  - 

Vegetative condition 
summary 

                     X 

   Process         X           X   

   Species         X           X   

   Size class / structure         X           X   

   Density         X           X   

   Treatments         X                   X   

Reports     

   Summary         X           X   

   Individual unit         X           X   

   All States         X           X   

   Tracking Species         X            -   

   Multiple simulation         -            -   

   Detailed fire         X            -   

   Fire suppression cost         X            X  Specify at beginning 

   Emission         X    

Interpretations             X   

   Ecosystem restoration          -             -   

   Wildlife habitat          X            -   

Export     

   GIS simulation          X            X2   

   Area Creation files          X    

User-supplied-name-
ls.txt 

             X2   

Table 3 Types of output available for a single or multiple simulations. 

The “User-supplied-name-ls.txt” file is a space-delimited file that contains all the output from 
all the multiple simulations in a set. This form can be imported into Microsoft Excel for 
additional analysis. Two Excel spreadsheet templates are in the application folder (Start > All 
Programs > SIMPPLLE > Excel Macros). 

A third Excel spreadsheet contains a statistical test that can be used to determine if there is a 
difference in attributes in different sets of simulations.  

Many of the reports, interpretations, and GIS files for single simulations can be created at a 
future time.  Click File > Save Landscape… at the end of a single simulation (Figure 23). 

 

 

                                                           

1 Testing has to be done before we can identify what can be accomplished from the database. 

2  These files are created automatically with multiple simulations. It is impossible to re-create these files later. 
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Figure 23 Main SIMPPLLE screen highlighting the Save Landscape choice. 
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Save Landscape… saves the landscape file with all the changes by each plant community over 
the duration of the simulation. This saved file loads when the user chooses Load a Previously 
Simulated Area. Each of the simulations from a set of multiple simulations is automatically 
saved in a similar fashion and can be reloaded. However, if the simulations were made with the 
Discard Simulation Data option, there are limitations to what can be generated after reloading 
(Table 4). 

 

 

 Reloading Saved Simulation (previously simulated landscape) 

View Results  

Vegetative unit analysis X 

Vegetative condition 
summary 

 

   Process X 

   Species X 

   Size class / structure X 

   Density X 

   Treatments X 

Reports  

   Summary X 

   Individual unit X 

   Multiple simulation X 

   Detailed fire X 

   Fire suppression cost X 

   Emission X 

Interpretations  

   Ecosystem restoration - 

   Structural development 
stage 

X 

   Wildlife habitat X 

Export  

   GIS simulation X 

   Attributes file X 

User-supplied-name-ls.txt  

Table 4  Output that can be created by reloading a saved simulation, whether it is an individual one or 
from a multiple set. 
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9.1 GRAPHICAL USER INTERFACE—OUTPUT 

There are two options within the user interface for viewing the results of the simulations (Figure 

24). Vegetative Unit Analysis looks at individual units. Vegetative Condition Summary looks at 

summaries of the attributes, disturbance processes, and any applied treatments for the entire 

landscape. Whether the landscape components other than vegetation are available depends on 

the geographic area being used and if they have been included when the SIMPPLLE area file was 

created from the GIS files. 

The intent of the two levels of the reports is that most analyses will utilize the summary 

information. However, to provide confidence in the system’s behavior the individual plant 

communities can be examined. If the system’s behavior at the individual plant community level 

is not acceptable, one cannot defend the landscape summaries. 

 

 

 
Figure 24 Main SIMPPLLE screen with the choices under View Results for looking at simulation output. 

 

 

The results for both the individual units and summary vary by individual and multiple 

simulations. 

9.1.1 Single Simulation—Vegetative Unit Analysis 

For a single simulation, the screen opens at the lowest numbered plant community in the 

landscape. It displays the current state, which is the condition at the end of the simulation, the 

ecological grouping and the acres of the plant community. The adjacent plant communities are 

shown as the identifying number, its position relative to the unit, and if it is downwind, or not, 
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according to the dominant wind direction associated with a weather front passage for this 

landscape.  

History 

The history for the simulation is displayed by individual vegetative units showing the sequence 

of vegetation conditions and the disturbance processes. 

Prev and Next are used to move to other plant communities, or the desired number of a plant 
community can be typed in the box between the two buttons. The vegetation units in the 
adjacent units can be double clicked, and the interface will move to that unit. 

Figure 25 shows the history for a five-decade simulation. Since the time step is set to Decade, 

seasons do not occur and are represented by Year. Time Step 0 represents the starting 

conditions. The data set is for a single life-form representation of plant community 32, so no 

classification is used with life form. The process of succession was the dominant process in all 

but Time Step 3. In this time step, mixed severity fire originated in the unit. The value of 8 is the 

probability used by the system which resulted in a fire event occurring in the unit. If the fire 

event would have occurred in another unit and spread into this one, an S would have been in 

place of the number 8. The following Time Step 4 shows that the process of change was 

succession. In the probability column, there is SUPP. This represents the situation where a fire 

event did occur as the result of using the probabilities. However, in this case, the fire 

suppression logic resulted in the fire event being suppressed at the Class A level (less than one-

quarter acre). A fire event suppressed at this level does not change the character of the 

vegetation attributes of the plant community, but fire suppression costs are accrued. The 

process of succession is assigned instead of redoing the evaluation of all process probabilities 

again.  
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Figure 25 View Results screen for individual vegetative unit number 32 displaying the history of state 
changes for a simulation.  
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Figure 26 is another individual vegetative unit. This unit is multiple life forms, but the only form 
present is trees. In Time Step 1, succession is shown as the process. However, a D is shown for 
its probability and the original process is spruce-beetle. This means the system tried to assign 
spruce beetle to this existing vegetation unit (EVU), but it could not find what the resulting state 
would be in the pathway file. An error was made in creating the pathway file. Thus, the system 
defaulted to succession for a process. Severe lp-mpb occurred in Time Step 2 as a result of the 7 
percent probability. In Time Step 3, a mixed severity fire spread into the unit from one of its 
neighbors. 

 

 

 
Figure 26 Individual unit display. 
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Figure 27 is the result of moving the scroll bar at the bottom of the individual unit display to the 
far right. This shows additional attributes that would have values if roads, trails, or aquatic units 
were in the system or if individual species were being tracked. 

 

 

 
Figure 27 Individual unit display (far right portion of screen). 

 

 

The values that may occur in the Prob column are displayed in Table 5. 

 

Value Description 

#  (a number) The probability generated by the system 

S Fire event spread into the unit under average conditions 

SE Fire event spread into the unit under extreme wind driven 

conditions 

SFS Fire event was spread via fire spotting 

SUPP Fire event was suppressed at less than .25 acres 

COMP Life form competition occurred 

GAP Process was a GAP process 

D A process was predicted but no next state could be found in the 

pathways. The system defaulted to succession 

L The disturbance process has been “locked-in” by the user. 

Table 5  Values that may occur in the Prob column in the vegetation unit display. 
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The original process is used when D or GAP occurs in the Prob column. This is the process that 
the system predicted would occur. In the case of D, the system could not find a next state in the 
pathways. This helps the user identify the corrections that need to be made in the pathways. 
GAP identifies the process that occurred on only a small portion of the plant community. 
 

Figure 28 is from a landscape in one of the grassland zones. The plant community is still 

represented by single life form, but yearly time steps are made in which the season of the 

disturbance process is modeled. Tracking species is used. 

 

 

 
Figure 28  Individual vegetation unit display with processes occurring by seasons and tracking species 
utilized. 
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Figure 29 is also a single life form, but notice that the Distance to Water is displayed with a (P)—
indicating it is a perennial water source. 

 

 

 
Figure 29  Individual vegetation unit display showing a distance and number to the aquatic unit that is 
the nearest perennial water source for each time step. 
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A display for an aquatic unit is shown in Figure 30. 

 

 

 
Figure 30  Display for an individual aquatic unit showing its status as Perennial. 
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Multiple Life Forms 

Notice Figure 31, showing the initial time step before any simulation, that three life forms are 

used to represent the vegetation unit. The current state in the attributes section is the dominant 

life form only. Both land and aquatic units are represented in this landscape. The ones that have 

a spatial relationship to this vegetative unit are identified. 

 

 

 
Figure 31 Individual vegetation unit display when vegetation is represented by multiple life forms and 
land units and aquatic units are part of the SIMPPLLE data set for the landscape. 
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By selecting the value in either Landform Units or Aqua Units, the interface switches to the 

display for the selected unit (Figure 32). Neither of these units have any dynamic processes 

associated with them in this version of SIMPPLLE.  

 

 

 
Figure 32  Display for an individual land unit showing its attributes and spatial relationship to other land 
and vegetation units. 
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Figure 33 illustrates a change in the tree life form in Time Step 1, changing from large, multi-
storied at density 3 to a single story at density 1. The disturbance process was SUCCESSION. 

 

 

 
Figure 33  Display for an individual vegetation unit that shows only the tree life form has a disturbance 
in time step one. 
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Treatment History 

If the Treatment History tab is selected, the follow screen is displayed (Figure 34). This shows a 

mechanical thinning was applied in Time Step 1 and the change the application made. 

 

 

 
Figure 34  The individual vegetation unit display showing treatment history for an individual unit. 
Mechanical thinning was applied in time step one and it changed the size class and density. 
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Unit Attribute Search 

A useful feature of the individual vegetation unit analysis is the search capability. By selecting 

Search in the upper left corner of the Vegetative Unit Analysis screen, the Unit Attribute 

Search screen is available (Figure 35). 

 

 

 
Figure 35  The blank search screen that can be used to find vegetation units that meet the conditions 
specified in logic combinations. 

 

 

The Unit Attribute Search screen allows the user to create logic that can be used to search for 

vegetation units that meet the requirements. Select Columns for the basic set of logic choices 

available to use throughout the system for all other logic screens. Figure 36 shows a search for 

the occurrence of stand-replacing fire in Time Step 2. The result is 321 acres. The window lists all 

units that meet the criteria. Clicking on any of the units will move the screen to the units display. 
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Figure 36 Results from searching the simulation for the conditions in the selected combination. 

 

 

Options > Make Treatment Schedule allows the user to build a treatment schedule. Options > 
Make Lock-in Process Schedule allows the user to lock in process schedule from the units that 
were selected. 

Double clicking on a unit within the results window will lead to the individual unit screen 
opening to that unit. There is an option on the individual unit screen that can be checked so the 
Prev and Next buttons can be used to move through all of the units that meet the search 
criteria. 

9.1.2 Single Simulation—Vegetation Condition Summary 

The conditions for the entire landscape are displayed in View Results > Vegetation Condition 

Summary. Radio buttons allow the user to view the summary report by acres of disturbance 

processes (Processes), each of the vegetation attributes of species (Species), Size Class, Density, 

Treatments, and a breakdown of the acres of fire is given by their distribution (Fire Events). 

Time Step 0 represents the initial conditions. Unless the user initializes the system by identifying 
what disturbance processes may have recently occurred (see input files), all communities have a 
history—a Time Step 0—of succession. In the summary below (Figures 37 and 38), 163,344 acres 
of stand replacing fire occurred in the past decade and was entered into the GIS layer for this 
landscape. Acres of Processes are only for the dominant life form if the landscape file is 
described using multiple life forms. 
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Figure 37 Vegetation Condition Summary for a single simulation displaying the acres of each process by 
time step. 
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Figure 38 Vegetation Condition Summary for a single simulation displaying the acres of each species by 
time step. 
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If single life forms are used, then each plant community has only one species. Thus, the acres of 
species will equal the acres of the landscape. However, if multiple life forms are used, the acres 
of species will be greater than the landscape acres. The same is true for both the size class and 
density attributes (Figures 39 and 40). 

 

 

Figure 39 Vegetation Condition Summary for a single simulation displaying the acres of each size class 
by time step. 
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Figure 40 Vegetation Condition Summary for a single simulation displaying the acres of each density 
class by time step. 
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Acres of treatments scheduled by time-step can be displayed (Figure 41). If any scheduled 
treatments are infeasible due to changing landscape conditions, they are shown as infeasible in 
the report. By infeasible, we mean that the vegetation conditions change before the system gets 
to the time step in which the treatment is scheduled for. Later sections on treatments will 
address the logic for treatment feasibility. 

 

 

 
Figure 41 Vegetation Condition Summary for a single simulation displaying the acres of each treatment 
applied by time step. 
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The single simulation was made with fire suppression, so there are a significant number of fire 
events that are kept at the Class A size (Figure 42). 

 

 

 
Figure 42 The display for Fire Events that shows the number and acres of fire by fire size class. Total 
acres are given for each time step as well as the percent of the landscape burned. 
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9.1.3 Multiple Simulations—Vegetative Unit Analysis 

The display for an individual unit after multiple simulations provides the frequency of the values 
for each attribute and disturbance process (Figure 43). 
 
 

 
Figure 43 Individual vegetative unit display for a multiple simulation. Display shows the frequency of 
each attribute. 
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9.1.4 Multiple Simulations—Vegetative Condition Summary 

For each attribute, the mean value for each time step from the multiple simulations is 
calculated. The minimum and maximum values are also provided (Figure 44). 
 
 

 
Figure 44 Multiple simulation condition summary display. The average acres and the minimum and 
maximum levels from the multiple simulations are shown for each process by time step. 

USDA Forest Service Gen. Tech. Rep. RMRS-GTR-268WWW. 2012 68



  

 
Figure 45 Multiple simulation condition summary display. The average acres and the minimum and 
maximum levels from the multiple simulations are shown for each species by time step. 

 

 

The displays for species, size class, density, and treatments are similar. There is no summary 

display for fire events from multiple simulations. The fire event display is for the last simulation 

in the set. 
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9.2 REPORTS 

9.2.1 Single Simulation 

Under Reports, both the Summary and the Individual Unit reports (Figure 46) provide the same 

information, which can be seen through View Results. 

 

 

 

Figure 46 SIMPPLLE main screen showing the choice available for “Reports” for single simulations 

 

 

An Individual Unit report can be created, but it is a very large file displaying the history for each 
plant community in the landscape for the simulation. When Summary is selected, the following 
screen (Figure 47) is displayed with options for the report. 
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Figure 47 Additional options to choose from when making a “summary” report for a single simulation. 

There are two basic options for report output:  

 Formatted Output: an easy-to-read format that looks similar to what is seen in the 
view-results.  

 Comma Delimited (spreadsheet) Output: easy to import into a spreadsheet program 
such as Microsoft Excel.  

Within both options, other choices are available if these attributes have been assigned to the 
plant community polygons (see input file). Standard provides for no additional breakdown of 
the information. Other choices will result in the information being stratified by ownership, 
special area, or both. See “Input Requirements” for explanation of Special Area. Reports cannot 
be made by ownership or special area unless the simulation has been made specifying in the 
simulation parameters that these be tracked. When Continue is selected, a dialog window 
opens to the working directory, and a file name for the report can be selected (Figure 48).  

 

 
Figure 48 SIMPPLLE dialog window providing for the user to enter the name to be used for a summary 
report. 
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When providing a name for the reports, use a text (*.txt) extension to make it possible to read 
the report with a variety of applications (i.e., Notepad or WordPad). 

A summary of the fire events is provided in this report (Table 6).  

 

 

  0-0.25 0.26-9 10-99 100-299 300-999 1000+ TOTAL 

1  

 Acres 7 0 228 873 1,051 0 2,159 

 #Events 28 0 6 5 2 0 41 

2  

 Acres 6 8 149 154 1,457 0 1,774 

 #Events 23 1 3 1 3 0 31 

3  

 Acres 6 0 134 1,219 785 0 2,144 

 #Events 22 0 5 6 2 0 35 

4  

 Acres 6 0 362 0 2,921 1,096 4,384 

 #Events 22 0 5 0 6 1 34 

5  

 Acres 4 0 127 852 3,780 1,420 6,183 

 #Events 16 0 3 5 7 1 32 

Table 6 Summary of Fire Events provided in the summary report for a single simulation. 

 

 

The Fire Event Summary breaks down the number of fire events by acres and fire size class by 

time step. The choice of polygon size used in the landscape file can have an impact on what is 

seen in this report. If the user has created coverage of uniform, ten acre polygons, it would be 

impossible for any fire events to show up in the 0.26–9 acre class. There would still be fire 

events in the 0.0–0.25 acre class due to fire suppression or weather events occurring at the time 

of the ignition event.  

All States Report 

Reports > All States Report provides the acres for any specified combination of vegetation 

attributes.  If desired for a single simulation, this report is available after the simulation. One 

does not have to check in the Simulations Parameters screen that they are wanted. For a single 

simulation the results after processing through the appropriate Excel spreadsheet will give only 

total acres. There is no range of occurrences from a single simulation. 

See Appendix K for a detailed description of this report. 
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Tracking Species Report 

Reports > Tracking Species Report is designed to give the acres for the species being tracked. 

If desired for a single simulation, this report is available after the simulation. One does not have 

to check in the Simulations Parameters screen that they are wanted. For a single simulation the 

results after processing through the appropriate Excel spreadsheet will give only total acres. 

There is no range of occurrences from a single simulation. 

See Appendix L for a detailed description of this report. 
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Detailed Fire 

Reports > Detailed Fire Report provides more information on the fire events. It identifies the 

plant community each event originates in, the communities it spreads to, and what type of fire it 

is. An asterisk beside a unit number means the fire spread under extreme, wind driven events by 

spotting to this unit. Table 7 displays part of a detailed fire report. 

 

 

Time Originated in Total Acres Spread To 

1 105-CLASS-A 0  

1 112-CLASS-A 0  

1 158-CLASS-A 0  

1 1410-CLASS-A 0  

1 399-SRF 452 468-LSF 485-LSF 512-LSF 377-SRF 386-SRF  
426 -MSF 454-SRF 

1 467-SRF 156 363-MSF 376-MSF 481-MSF 

1 528-SRF 286 511-LSF 568-LSF 

1 528-SRF   

1 606-SRF 31 No Spread 

1 845-SRF 194 769-LSF 777-MSF 

1 869-SRF 599 945-SRF 965-SRF 1028-MSF 852-LSF 955-MSF 974-SRF 977-SRF 
1003-MSF  

1 935-SRF 78 885-SRF 947-SRF  

1 73-MSF 22 No Spread 

1 279-MSF 114 No Spread 

1 814-MSF 123 No Spread 

1 1016-MSF  18 No Spread 

1 1527-MSF 19 No Spread 

1 327-LSF  60 No Spread 

2 16-CLASS-A 0  

2 22-CLASS-A 0  

2 103-CLASS-A  0  

2 1519-CLASS-A 0 
 

 

2 859-SRF 331 842-LSF 848-SRF 865-SRF 1041-MSF 

Table 7 Portion of a Detailed Fire Report showing by time step each fire event, the plant community it 
originated in, the total acres of the event, and the communities it spread to and as what type of fire. 

 

 

The Menu option in the Detailed Fire Report will be unavailable if the Discard Data option is 

selected.  

The Fire Suppression Cost Report is only available if the simulation is made with fire 

suppression and if costs are included in the fire occurrence and cost input table. This simplified 

version of fire suppression costs utilizes a per-acre cost based on the size class of the fire event. 
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Table 8 illustrates a Fire Suppression Cost Report. In this example, the costs are not discounted 

and not identified by fire management zones (FMZs). If FMZs are used, the cost is displayed by 

each FMZ in addition to the total. 

 

 

FMZ Time 

 1 2 3 4 5 

All 2,068,792 2,170,796 1,713,806 4,656,188 5,803,487 

Total 2,068,792 2,170,796 1,713,806 4,656,188 5,803,487 

Table 8 Fire suppression report showing undiscounted costs for the entire landscape that was 
simulated. 

 

At the time the report is selected, the user can change the default discount rate from 1.04 
percent. The suppression costs utilize the per-acre cost that can vary by fire size class and fire 
management zone if that level of detail has been provided by the user. The costs are calculated 
by using the combination of process origin and the units to which the process spreads to get the 
size-class of each fire event. The costs are discounted to the middle of each decade time step. 

The emissions report was developed for use in a Joint Fire Sciences Study (Weise et al. 2000,  

2003). Data is taken from Hardy et al. (2000). The emissions values were developed for Westside 

Region One, Southern California, Sierra Nevada, South Central Alaska, Gila, and South West Utah 

zones. These values have not been kept current. Use of the report in any other zone will default 

to values for the Westside Region One. No user interface access to this system knowledge is 

available. Emissions are provided for both fire events and treatments of ecosystem 

management underburn and broadcast burn. This makes it possible to compare tradeoffs in 

emissions between simulations with and without treatments. No emissions are calculated for 

the fuel treatment associated with other activities such as broadcast burning of harvest units, or 

burning hand or machine piles (what is often referred to as activity fuels).  Table 9 is an example 

of an Emissions Report. 

 

 Time 

 1 2 3 4 5 

Fire Emissions (Tons) 

 PM 10 377 349 436 988 1,419 

 PM 2.5 302 279 349 790 1,135 

Treatment Emissions (Tons) 

 PM 10 0 10 20 0 0 

 PM 2.5 0 8 16 0 0 

Table 9 Emissions Report showing tons of particulate by time step. 
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9.2.2 Multiple Simulations Report 

When making multiple simulations, one report file is created automatically. This is a text (*-

ls.txt) file with a user-provided name. This report file provides the results from each time step 

for each simulation for processes, vegetation attributes, fire information, suppression costs, and 

emissions in a form that can be readily imported into a spreadsheet for further analysis. The use 

of the Excel spreadsheet with the ls.txt file is the basic processing tool for SIMPPLLE simulations. 

With multiple simulations, the same reports can be made at the end of a simulation as with a 
single simulation. However, if they are made, they are for the last simulation of the multiple set. 
For example, if you made 10 five-decade simulations, the reports made from the user interface 
will be for the 10th simulation. The additional report that shows up after a set of multiple 
simulations is Reports > Multiple Simulation. If ownership and special area are identified within 
the plant communities, then the report can be stratified By Special Area or By Ownership. 
Without them, only Normal is available. 

 

 

 
Figure 49 Report option for Multiple Simulation. 

 

 

The Multiple Simulation Report provides the mean and range of values identical to what is seen 
throughout the user interface. This report looks similar to what is seen in view results with 
multiple simulations. 

9.3 DATABASE 

In running a simulation in SIMPPLLE, the user has an option to output data to a database 

(*.mdb). The data output to the database is all of the simulation results that are accumulated in 

the course of a run. This is the same data that is utilized in generating reports from within 
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SIMPPLLE. This gives the user great flexibility to utilize the database to analyze the data in ways 

that we have not provided for in the built in reports.  

The database currently used is Hypersonic SQL. Hypersonic SQL is an open-source, free-use 

database. Currently, this database has a size limitation of approximately 8GB. All of the primary 

tables in the database use only numbers (e.g., all processes are assigned an ID).  The reason for 

this is to save space in the database because the amount of data that SIMPPLLE generates is 

very large. 

The database is written using Hibernate, allowing the use of databases other than Hypersonic 

SQL in the future. 

Currently, when a database is written, a Windows Batch file is written to the output directory 

that will run a database viewing utility provided with Hypersonic SQL. This is a very basic 

program that requires the user to know SQL in order to manipulate the database. 

It is important to note that these databases can get quite large, so large, in fact, the viewer 

cannot display the entire table of simulation data. If you find that the program runs out of 

memory, merely rephrase the SQL statement to limit the query. 

In the future, we are planning to add built-in report queries to make it easier for the user to get 

the information desired. In the meantime, a good SQL tutorial may be in order. In addition, the 

viewing utility has an option to output the results of a query into a format that can be imported 

into Access. 

9.3.1 Database Tables 

 

 

AREA_SUMMARY_DATA 

ID Database Row ID 

ORIGINUNITID Unit Id where the process originated 

UNITID Unit ID in which the process occurred 

TOUNITID ID of the unit that the process spread to (if applicable) 

PROCESS_ID Process ID as specified in the PROCESS_ID table 

RATIONALPROB Probability of Process Event times 100 (see Prob Ref table for negative values) 

RATIONALACRES Acres of Process in the unit times 100 
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SEASON_ID Season ID (see SEASON ID Ref Table) 

TIMESTEP Time step in which the process occurred 

RUN Run in which the process occurred 

GROUP_ID Group ID as specified in the ECOLOGICAL_GROUP table 

OWNERSHIP_ID Ownership ID as specified in the OWNERSHIP_ID table 

SPECIAL_AREA_ID Special Area ID as specified in the SPECIAL_AREA_ID table 

FMZ_ID FMZ ID as specified in the FMZ_ID table 

Table 10  Information on process events. 

 

 

 

 

 

PROBABILITY REFERENCE TABLE 

Report Value Description Database Value 

D Process no next state -2 

L Locked in process -3 

S Spreading process -4 

SUPP Suppressed process -5 

SE Extreme fire spread -6 

SFS Fire spotting spread -7 

COMP Competition -8 

GAP Gap process -9 

Table 11 Description of probability values found in the database. 
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SEASON ID REFERENCE TABLE 

ID Database Value 

SPRING 0 

SUMMER 1 

FALL 2 

WINTER 3 

YEAR 4 

Table 12  The season the numbers found in the database refer to. 

 

 

DENSITY 

ID ID used in primary tables 

DENSITY Actual density value 

Table 13 A database table used to assign numeric ID’s to Density values. 

 

 

ECOLOGICAL_GROUPING 

ID ID used in primary tables 

NAME Group name 

Table 14 A database table used to assign numeric ID’s to Ecological Grouping values. 
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EVU_SIM_DATA 

ID Table row ID 

SLINK Unit Identifier 

TIMESTEP Simulation time step 

RUN Simulation run number (starts at 0) 

LIFEFORM_ID Life form ID 

SPECIES_ID Species ID 

SIZECLASS_ID Size Class ID 

AGE Age 

DENSITY_ID Density ID 

PROCESS_ID Process ID 

PROB 
Probability of process event times 100 (see 

Prob ref table for negative values) 

SEASON_ID Season ID (see SEASON ID Ref Table) 

Table 15 A database table that contains all of the simulation data for Vegetative Units. 

 

 

FMZ 

ID ID used in primary tables 

NAME Fire Management Zone 

Table 16 A database table used to assign numeric ID’s to FMZ values. 
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INCLUSION_RULE_SPECIES 

ID ID used in primary tables 

NAME Inclusion Rule Species Name 

Table 17 A database table used to assign numeric ID’s to Inclusion Rule Species values. 

 

 

LIFEFORM 

ID ID used in primary tables 

NAME Life form name 

Table 18 A database table used to assign numeric ID’s to Life form values. 

 

 

OWNERSHIP 

ID ID used in primary tables 

NAME Ownership name 

Table 19 A database table used to assign numeric ID’s to Ownership values. 

 

 

PROCESS 

ID ID used in primary tables 

PROCESSNAME Process name 

Table 20 A database table used to assign numeric ID’s to Process values. 
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SIZECLASS 

ID ID used in primary tables 

SIZECLASS Size class name 

Table 21 A database table used to assign numeric ID’s to Size Class values. 

 

 

SPECIAL_AREA 

ID ID used in primary tables 

NAME Special Area name 

Table 22 A database table used to assign numeric ID’s to Special Area values. 

 

 

SPECIES 

ID ID used in primary tables 

SPECIES Species Name 

Table 23 A database table used to assign numeric ID’s to Species values. 

 

 

TRACKING_SPECIES 

ID ID of the database row in the EVU_SIM_DATA table 

PCT Tracking/Invasive Species Percent 

SPECIES_ID Inclusion Rule Species ID 

Table 24 A database table that hold tracking species information for data in the EVU_SIM_DATA table. 
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See Figure 50 for example results from a database query. 

 

 

 

Figure 50  Results from database query. 

 

9.4 INTERPRETATIONS

The current choices under Interpretations are limited and vary for single or multiple 

simulations. Choices have been developed as users have requested them  The choices shaded 

out in the Interpretations pull-down menu are those that have either been used at some time in 

the past and not maintained, or have been proposed but not yet developed. These choices are: 

 Pattern Analysis (Fragstats): The logic has not been incorporated into the system to 
perform an analysis. If analysis for spatial statistics is desired, make sure the SIMPPLLE 
area file is created with uniform sized units. Following simulations, the feature class can 
be updated for any number of time steps and converted to a grid in the GIS 
environment. The resulting grid can be utilized in Fragstats. 

 Timber Volumes: This capability to track standing inventory and identify what 
disturbance processes or management treatments are playing a role in its change has 
not been maintained since version 1.0.  Users will have to create their own links 
between updated vegetation conditions by joining output files and average standing 
volumes by cover type, size class, and density. 

 Structure Development Stages (Oliver and Larson 1990): Provides an interpretation of 
the combination of current conditions and processes that created them to provide acres 
by time step. Not maintained since version 1.0. 

 Risk Calculator: This interpretation is to provide the optimization modeling system 
MAGIS (Zuuring et al. 1995), an input file to use based on an interpretation of 
disturbance process probabilities from multiple simulations. This option has not been 
fully developed. 
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 Weed Potential: This choice was added in early versions to incorporate work being done 
by Region One. It has been replaced by invasive species logic and will be removed in the 
next build of version 2.5 

9.4.1 Single Simulations 

Two choices are currently active for single simulations: Wildlife Habitat and Ecosystem 

Restoration. Ecosystem Restoration is available because it uses probability files from previous 

multiple simulations (Figure 51). 

 

 
Figure 51 Interpretation Choices available for current version. 

 

 

Wildlife Habitat Report 

Interpretations > Wildlife Habitat Report is only available for the two Region One zones. The 

relationships that have been developed by states as GAP models are made accessible to 

SIMPPLLE through their inclusion in a database. The flexibility has been created to be able to 

include any Region specific models. Within SIMPPLLE, only the habitat relationships are 

included. Any spatial relationships are not included until the ArcView project (or extension) is 

accessed. The database could be utilized for relationships in other geographic areas. 
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Interpretations > Wildlife Habitat results in the Wildlife Habitat Interpretations screen (Figure 

52), giving the user the choice of a report for the entire group or individuals within it. 

 

 
Figure 52 Main screen for Wildlife Habitat Interpretations. 
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Additional choices must be made on which model to use (Figure 53). 

 

 
Figure 53 Display of choices for individual species within a group. 

 

 

The report format is displayed in Figure 54. 
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Figure 54 Report for Wildlife Habitat Interpretations. 

 

 

This is only available for single simulations. If it is executed at the end of a set of multiple 

simulations, the numbers will be computed on the last simulation in the set. At this time, the 

use of multiple simulations and the resulting probabilities for providing vegetation conditions 

for wildlife habitat must be addressed through using numerous output files in a GIS 

environment. 

9.4.2 Multiple Simulations 

Both Attribute Probability Calculator and Ecosystem Restoration (under Interpretations) 

require multiple simulations as probabilities are generated from multiple simulations. 

Interpretations > Attribute Probability Calculator provides the means to determine how many 
acres of a given combination of attributes or processes exist at a specified probability level. This 
provides a way to obtain these acres without creating GIS files to do it in the GIS environment. If 
multiple simulations are made, the Attribute Probability Calculator can be used to identify how 
many acres of certain conditions exist at or above a specified probability level. Alternatively, this 
can also be determined within the GIS extension by multiple queries. 

The screen in Figure 55 shows the selection of PP-DF for Species and a Size Class of Large 
occurring at least 50 percent of the time. There are only 71 acres that meet these criteria. If the 
combination is important for some resource value, this feature is useful to give an idea of how 
limited the combination may be in the landscape over the time of the simulation. 
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Figure 55 Acres that meet the criteria of being PP-DF and Large greater than or equal to 50 percent of 
the time for a set of multiple simulations. 

 

 

Ecosystem Restoration 

Interpretations > Ecosystem Restoration uses probability files from two different sets of 
multiple simulations that have to have been made previously (Figure 56). 

 

 

 
Figure 56 The SIMPPLLE dialog screen used to identify two sets of probability files used to identify 
Ecosystem Restoration needs. 

 

 

This interpretation choice is designed to help identify the need for ecosystem maintenance, 
conversion, or restoration. Using SIMPPLLE for this analysis incorporates the dynamics of 
specific landscapes that are dependent upon unique spatial patterns. SIMPPLLE uses 
probabilities from two sets of simulations. One set is considered a representation of the historic 
conditions of the specific landscape. The other set is a projection of the current landscape. 
SIMPPLLE provides a comparison between the files of the two vegetation types which occurred 
at the highest frequency level. It does not make a difference in the order in which the 
probability files are entered in the dialog screen. 

A comparison is made for each existing vegetation unit: 

Use the two species that have the two highest probabilities for each file. If there is a difference, 

assign a value of “1,” if there is no difference, assign a “0.” 
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Use the two densities that have the highest probability for each file. If there is a difference, 

assign a value of “1,” if there is no difference, assign a “0.” 

Use the two size-class/structures that have the two highest probabilities for each file. If there is 
a difference, assign a value of “1,” if there is no difference, assign a “0.” 

Using the “difference” values: 
If species is = 1         assign “C” 
Regardless of other two values    

If species = 0 
And density = 0 
And size = 1         assign “R” 

If species = 0 
And density = 1 
And size = 0       assign “R” 

If species = 0 
And density = 0 
And Size = 0          assign “M” 

A file of the EVU number and assigned value of C, R, or M is created and can be joined to the 
landscape coverage in the ArcView project. Although the logic was initially developed for use in 
Region One, it can be applied in any other geographic area. 

This report and its use on sample landscapes are documented in Chew (2003). 

9.5 EXPORT FILES 

9.5.1 Area Creation Files  

The user can correct for mismatches that occur when files are imported through the user 

interface (see previous section). To reflect these changes in the GIS coverage you can export the 

attributes file and join it back to the coverage within ArcMap or ArcCatalog. Click Export > Area 

Creation Files (Figure 57). 
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Figure 57 Choice to create an attributes file that can be joined to the GIS coverage to account for 
changes made through the user interface. 

 

 

This choice brings up the Information dialog box shown in Figure 58. 

 

 

Figure 58  Identification of the files that SIMPPLLE is going to use. 

 

 

9.5.2 GIS Simulation Files  

The creation of files to use in a GIS environment can result in a significant number of files. To 

minimize this impact, single simulations do not automatically create files. This allows the user 

make many single simulations without having to worry about file cleanup. For multiple 

simulations, there are some files that are created without the user’s choice as it would be 

impossible to create after the simulations. Types of files vary with either single simulations or 

multiple simulations and are discussed in the following sections.  

USDA Forest Service Gen. Tech. Rep. RMRS-GTR-268WWW. 2012 90



  

These files are designed to be used with both the ArcView customized SIMPPLLE project and the 

ArcMap SIMPPLLE extension. However, a proficient GIS user can utilize them with basic ArcGIS 

tools. 

GIS Simulation Files—Single Simulation 

 

 
Figure 59  Choices available for GIS output files under the Export main menu choice. 

 

 

With the expansion to include multiple life forms, there are more choices that have to be made 

with these files. Select Export > GIS Simulation Files > Update and Spread Files to bring up the 

Chooser Lifeform dialog screen (only if the area file is multiple life form)(Figure 60). 
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Figure 60  Choice available when exporting GIS files for a simulation if multiple life forms are used to 
describe the vegetation in the landscape. 

 

 

Update Files—Single Simulation 

Export > GIS Simulation Files > Update and Spread Files is used to map the individual time steps 

which include the processes that occurred, vegetation attributes, and treatments after a single 

simulation is made, or a single simulation file has been reloaded. The files are named with the 

user-provided prefix and a file for each time step of the simulation: “user-prefix-#.txt.”  

Spread Files—Single Simulation 

Spread Files are for those disturbances that spread. These files provide the means to map where 

a specific process originates versus where it spreads. The files are named using the user-

provided prefix with a file for each time step of the simulation: “user-prefix-#-spread.txt.” 

Probability of Reburn—Single Simulation 

Export > GIS Simulation Files > Probability of Reburn will identify what plant communities get a 

stand replacing fire more than once within the length of the simulation made. There is no access 

to this code to make any changes, such as using any fire event, not just stand replacing fire 

events. This report is not functional for version 2.5. 

GIS Simulation Files—Multiple Simulations 

Three types of GIS files are created automatically from multiple simulations: probability files, 

time step attribute update files and spread files, and an area file for each simulation. Probability 

files are for the processes and each attribute of species, sizeclass, and density. There are two 

sets of probability files: one set of files based on the entire simulation and one set of files for 

each time step.  Probability files for the total duration of the simulation use the user supplied 

name plus “username-n-process.txt”  “username-n-species.txt,” “username-n-size.txt,” 

“username-n-canopy.txt.” These files are used in the ArcView project file or the GIS extension to 
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display the probability of a process or attribute occurring over the length of the number of time 

steps in the simulations. The files for the probability by each individual time step are named 

using the user provided prefix, the time step, and the attribute: “userprefix-#-attribute.txt.” 

Update and Spread Files cannot be used if the choice was made to discard simulation 

information. If you want to discard information, then GIS files must be made at the time of the 

simulation by making a choice from the simulation parameters screen. These update and spread 

files are made for an individual simulation, even if they are made as a set of simulations. If the 

user wants to create files from many of the simulations in the set, the saved area file that 

contains the simulation results (*.simdata) from the run must be loaded as a Previously 

Simulated Landscape. The choice of discarding information will limit what can be done with the 

simdata file. 

Create GIS Probability Files by Decade 

For some analyses, the probability of a process or vegetation attribute over the entire 

simulation period may not be the best expression. Files can be generated to display the 

probability by time steps. These files are automatically created for each time step for each 

attribute, species, size, and density when a set of multiple simulations are made. These files are 

put in a separate directory for each of the multiple simulations with additional subdirectories for 

each life form. 

9.6 EXCEL SPREADSHEETS  

9.6.1 Basic Processing 

When working with multiple simulations, one of the easiest ways to process the output is in a 

spreadsheet. This makes it easy to cut and paste data to create any variety of graphic 

comparisons. To facilitate this effort, an output file is automatically created when multiple 

simulations are made. This file contains the output by time step, by simulation in the following 

sequence: acres of processes, acres of species, acres of size-class/structure, acres of density 

class, fire suppression costs, emissions for fire events pm-10, emissions for fire events pm 2.5, 

emissions for treatments pm-10, emission for treatments pm 2.5. 

With sets of multiple simulations for a number of management alternatives, each alternative 

can have its own spreadsheet plus one spreadsheet that provides a comparison of values 

between management alternatives.  

The basic spreadsheet macro is provided with SIMPPLLE. The instructions are in Appendix J. 

9.6.2 All States Report 

Reports > All States Report is most commonly used with multiple simulations. The All States 

Report was designed to provide the capability to track specific combination of species/size class 

– structure/density. The report is designed to identify the mean, maximum, minimum, and 
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standard deviation for each state—the results from multiple simulations. This report requires an 

output file generated by SIMPPLLE and the use of an Excel template. The input file can be 

structured to track each individual combination. Note: You must have Excel 2002 or newer to 

run the macros in the Report Template.  

If the report is run on all individual states, it may take a considerable time to complete. Most 

likely the report will be done on groupings of the states, such as grouping used for a Diversity 

Matrix. 

The user interface to query the user for the desired grouping has not yet been created. Instead, 

the system asks for the name of a text file (*.txt) that contains the information to create groups. 

Many text files for different groupings may be made. 

It is possible to exceed line limitations with this report in older versions of Excel. 

Instructions are included in Appendix K. 

9.6.3 Tracking Species Macro  

Reports > Tracking Species Report was created to provide support for using the tracking species 

feature for invasive species. Instructions are included in Appendix L. 

9.6.4 Statistical Analysis—Multiresponse Permutation Procedure (MRPP) 

An Excel spreadsheet template with macros for statistically testing differences in values 

between alternatives is included. Instructions are in an Appendix M. A separate General 

Technical Report is being prepared for the use of the statistical test. 
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10. SYSTEM KNOWLEDGE  

Within SIMPPLLE, change is not driven by transition matrices. The system has to contain 

adequate knowledge to predict the probability of the occurrence of disturbance processes for 

each plant community. The collection of knowledge about vegetation change by processes, the 

probability of processes and their spread, and the impact from treatments is all collectively 

referred to as system knowledge. This knowledge is a combination of specific research results 

modified to fit the level of inventory information commonly available at landscape scales and 

the incorporation of the expert opinion of field silviculturists, ecologists, and resource specialists 

from each geographic area. It is represented in many different forms ranging from equations to 

logic screens. Each time SIMPPLLE is started, the default system knowledge for a geographic 

zone is loaded.  

The goal is to make all of this knowledge easily accessible, but only certain components of it are 
changeable by the user. Changes made through the user interface can be saved and easily 
reloaded.  Changes in the system knowledge beyond what is accessible by the user require 
changes by the system developers. System Knowledge (Figure 61) provides access to the 
knowledge components. There are many reasons why the user should be able to change the 
default system knowledge. Many of the geographic areas are rather large, and one can expect 
the behavior of many of the disturbance processes to vary across this area. Both the research 
results and the expert opinion that provides the basis of the system knowledge is far from 
complete. Changes can be made to test different relationships or to account for the differences 
that vary within what may be large geographic zones. A Knowledge Source menu choice exists 
on each screen under system knowledge. This can be used to identify the source of the 
knowledge. It is the user’s responsibility to document changes made in the default system 
knowledge. 

 

 

 
Figure 61 System knowledge choice from the main SIMPPLLE menu. 

Version 2.5 offers more consistency in the knowledge screens for each component than in 
previous versions. To access the Process Probability Logic screen, select System Knowledge > 
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Vegetative Process > Process Probability Logic. The user has a choice of Columns that can be 
added to the screens to have as much or as little system knowledge utilized. Figure 62 displays 
the list of the system components that can be used in a logic screen. 

 

 

 
Figure 62 The basic disturbance process probability logic screen showing the pulldown menu for 
columns. This displays the system knowledge that the user can choose to utilize. 

 

 

There are always going to be some components in geographic areas that are so unique that they 
require a separate form of screen. For example, the Bison Grazing screen in the grassland areas 
and the Invasive Species screen in the Colorado Plateau area each are unique screens. When 
building logic combinations for any screen, the more detailed the combinations, the more 
specific knowledge requirements must be listed first. For any given screen, the system goes 
through the combinations in order. The first one that matches, the system will utilize. If a 
generalized combination is the first one, the more detailed conditions will never be utilized. 
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Managing the changes from the default system knowledge for a zone can be a significant task. A 
log file is created for a simulation if a prefix name is provided for the output. However, this file 
does not capture all of the changes that may be made in the various system knowledge 
components, especially if they were made for the duration of a single set of simulations. The log 
file currently identifies only a portion of the saved knowledge files that may be loaded. Thus, a 
major part of managing the system knowledge requires the user to keep records on what 
comprises each simulation. Figure 63 is an example of a log file for a set of simulations. 

 

 

 
Figure 63 SIMPPLLE log file from a set of 10 simulations display a subset of the simulation parameter 
values. 

 

 

Knowledge Components Shaded Out 

SIMPPLLE’s design of classes that can be used to represent a range of landscape components 
has not been fully implemented. The initial emphasis has been on the vegetation part of the 
landscape. Thus, there are numerous parallel choices associated with other landscape 
components, land and aquatic units, that are shaded out until they are developed in future 
versions. 

System Knowledge Not Accessible  

Our goal is to have all system knowledge accessible, but there are currently some components 

that are not in version 2.5. The following identifies system knowledge that the user cannot 

access at this time: 

 emissions code 
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 reburn probability   

 fire spotting under extreme fire spread 

 hazard rating systems for mountain pine beetle in lodgepole and ponderosa pine 

 the spruce beetle expert system incorporated into the south central Alaska zone 

 pulse regeneration logic 

 code that identifies acres of adjacent units for use in determining adjacent seed sources 

 code controlling Insect/Disease Process spread 

System Knowledge Source 

All logic screens have a Knowledge Source choice on the main menu bar. This provides the 
means to document the source of the logic used in the screens. Any changes by the user should 
be documented in this screen. If the logic is saved as a file to be loaded again, this 
documentation is a part of the file. 

System Knowledge Files 

Changes in components of the system knowledge can be applied during a simulation session or 
saved to files that are in a specific format for SIMPPLLE by selecting File > Save As. These new 
files can be reloaded for future simulations by loading each separately from the File choice at 
the main menu for each of the knowledge components, or they can be loaded collectively. To 
load all of them collectively, the user must first load the files individually and then select System 
Knowledge > Save User Knowledge File. 

The next time SIMPPLLE is started after the zone and area are loaded, select System Knowledge 
> Open User Knowledge File to load the changed knowledge files. Table 25 identifies the file 
extensions for each type of system knowledge. 
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Type of Knowledge File Extension 

Vegetation pathways sk_pathway 

Lock-in processes sk_processsched 

Treatment logic sk_treatlogic 

Treatment schedules sk_treatsched 

Fire Spread Rate sk_firesuppspreadratelogic 

Fire suppression production rate sk_firesupproductionratelogic 

Fire Spread logic sk_firespread 

Type of fire logic sk_firetype 

Fire suppression costs sk_fmz 

Fire occurrence numbers sk_fmz 

Fire suppression beyond class A sk_firesuppbeyondclassalogic 

Fire suppression class A Sk_firesuppclassalogic 

Class A fire suppression due to weather sk_firesuppweathera 

Fire suppression beyond Class A due to 
weather 

sk_firesuppweather 

Regional climate sk_climate 

Insect and Disease probabilities sk_processproblogic 

Species attributes sk_species 

Regeneration logic –fire sk_regenlogicfire 

Regeneration logic –succession sk_regenlogicsucc 

Regeneration delay sk_regendelaylogic 

Producing seed logic sk_producingseedlogic 

Conifer Encroachment logic sk_conifer 

Gap Process logic sk_gapprocesslogic 

Vegetation Unit fire type logic sk_vegunitfiretypelogic 

Invasive species logic sk_invasivespecieslogic 

Life form competition logic sk_competitionlogic 

User system knowledge file sysknowledge 

Table 25 Types of system knowledge files and their file name extensions assigned by the system. 

 

 

If the user makes many changes to system knowledge components from the zone defaults, it 

can become time consuming to load all the files each time SIMPPLLE is restarted. For this 

reason, once all the changed files have been loaded, select System Knowledge > Save User 

Knowledge File (Figure 64). 
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Figure 64 The choice of “Save User Knowledge File” on the pulldown menu from System Knowledge. 
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The Save System Knowledge screen (Figure 65) allows the user to save as much as desired and 

provide a name for the system knowledge file. This file actually contains all the modified system 

knowledge. It does not just “point” to the location of individual files. Thus, the individual files 

may be located in separate directories. 

 

 

 
Figure 65 The save system knowledge screen that lets the user specify what modified system 
knowledge should be included. 
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10.2  PATHWAYS—VEGETATION 

Existing vegetation can be represented in two formats called pathways. One format is discrete 
states that are combinations of species, sizeclass and structure, and canopy density. The other 
format is an aggregate of numerous species with the percent of canopy cover for each species 
that has to fall within a specified range of cover for the aggregate. The choice of attributes used 
to describe the states is dependent on what is commonly available from current inventories, 
what is needed to provide the means to predict disturbance process probability on an individual 
plant community basis, and what is needed to interpret conditions for impacts on natural 
resources. Ecological groupings or stratifications are used to stratify the pathway states.  

Pathways are constructed as: 

 Trees changes based on a decade time between states 

 Shrubs and herbaceous as yearly changes  

Within SIMPPLLE, only a limited part of the system knowledge is in the pathways. The 
knowledge stored within these files of pathway states includes the processes that are applicable 
for each state and the resulting state if the process occurs. 

Within this collection of states we identify: 

 The time spent within a size-class 

 Density changes over time 

 When a tolerant species is added to the species mixture 

 How long seral species stay in a mixture 

 Influence of density on time within states 

 Influence of the ecological stratification 

For the initial geographic areas of the Westside and Eastside Region One, this information was 
provided by relationships in the “Regional Stocking Charts” (USDA Forest Service 1987) which 
were derived from hundreds of Forest Vegetation Simulator (FVS) runs on a very large number 
of sample stands. The initial relationships have been modified by expert opinion through 
numerous workshops. Users or user groups should consider using sample stands or FIA plots 
with FVS (or an appropriate growth model for their area) to improve the relationships within 
specific pathways. 

This knowledge can be built and refined through the use of fine scale models such as FVS on 
sample plant communities, research results on vegetative growth and disturbance processes, 
and expert opinion. Some detail on pathway development for each geographic area is given in 
the Appendix for each zone/area and is planned for future publications. 

The knowledge for determining the probability of a given process and how it may spread is 
stored in other parts of the system. It is not a part of the pathways.  The simulated spatial 
patterns of plant communities that can be unique to each area impact the probability and 
spread of the processes. The pathways capture information that does not require site specific, 
spatially explicit knowledge. Any information about vegetation change that depends upon 
knowledge about neighboring plant communities cannot be captured within the pathways and 
requires other components of system knowledge. 

USDA Forest Service Gen. Tech. Rep. RMRS-GTR-268WWW. 2012 102



  

10.2.1 Viewing Pathway State Diagrams 

To view pathway files, select System Knowledge > Pathway > Vegetative Pathways (Figure 66). 

 
Figure 66 Sequences of choices from the main menu to access the knowledge stored in the Vegetation 
Pathways. 
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A display (Figure 67) opens up to one of the ecological stratifications. For the Westside Region 
One zone, this is Ecological Grouping D3, and the first vegetative type of alpine fir (AF) with the 
Process of Succession. 

 

 

 
Figure 67 Diagrams of vegetation states for habitat group D3, alpine fir for the dominant species and 
succession as the process of change. 
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A choice of the Ecological Grouping to display is selected from the drop down menu as shown in 
Figure 68. 

 

 

 
Figure 68 The pulldown menu that provides access to other habitat type groups. 
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The ecological grouping (habitat type group for this zone) display is further divided by species to 
avoid having diagrams that are too difficult to read. The Species pulldown menu enables one to 
select the dominate species diagram to view (Figure 69). 

 

 

 
Figure 69 The pulldown menu to provide access to the dominant species within the group. 
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As displayed in Figure 70, the states are arranged with the youngest and smallest 
seedling/saplings on the left and the oldest and largest on the right. The lowest density class is 
in the top and the highest class in the bottom of the diagram. Each decade within a size-class is 
represented by a separate state. This allows variation within the processes to occur over time 
within a given size-class/structure combination. The boxes (states) that are shaded represent 
different species combinations that processes change a plant community to. The user must 
switch to the different species display within the same habitat type group in order to see the 
complete set of states for the new species. This is done by using the drop down menu, or simply 
double clicking on one of the shaded states. 

To keep the diagram readable, the title for each state is not automatically displayed on the 
diagram. Instead, the identifier for a given state is displayed when the cursor is placed on the 
state, or select Pathways > Show All Labels. 

 

 

 
Figure 70 Diagram of all possible states of the dominant species af on habitat type group D3. The 
descriptive labels for each state are displayed. The process linking all the displayed states is succession. 
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Other choices available under Pathways are: 

 New State: Adds a new state to a pathway such as adding an additional decade for the 
time spent in a given size class. 

 Auto Position States: Adding new states or editing existing can result in a confusing 
spatial arrangement of the states. This places the states in a predetermined 
arrangement for the displayed pathway. 

 Auto Position All States: This is similar to the above choice, only it is done for all 
pathways in the system. 

 Collapse All: Reduces the pathway to a single state for each size class. The separate 
states for age within a size class will be collapsed. 

 Detail All: Expands each size class to display all the states for each decade within it. 

 Step Counter: Determines the number of years between two selected states in the 
pathway. This is very useful in the editing process. 

 Grid Lines: Adds a grid separating size class and densities. 

Succession, stand-development, is the default process link that is displayed. Different processes 

can be displayed from the pulldown menu for Process (Figure 71). The processes of 

Regeneration and Invasive Species Occurrence are not shown in these diagrams as they require 

spatial information to be implemented. They require knowledge of the conditions of a plant 

community’s neighbors and place in the landscape. 
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Figure 71 Display of the process drop down menu for changing the disturbance process linking all of the 
states in the diagram. 

 

10.2.2 Creating Pathway Diagrams 

In version 2.5, new pathways diagrams and diagrams of new species combinations cannot be 

created directly through the user interface. To add a new species or species combination that is 

not currently in the system, create a text file of the pathways and import it through the menu 

choice, as shown in Figure 72. Existing pathway files can be exported as text files to use as a 

format.  
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Figure 72 Pulldown menu from “file” that gives the option of importing and exporting pathways as text 
files. 
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Adding a new species pathway also requires that the new species be added to the system 

through System Knowledge > Vegetative Process > Species Attribute Editor (Figure 73). 

 

 

 
Figure 73 Menu choices to access the Species Attribute Editor. 

 

 

10.2.3 Editing Pathway Diagrams 

The default pathway relationships are developed for each zone. It is expected that the 

relationships within the pathways will not be appropriate for some parts of the zone. For 

example, the tolerant tree species that come in with natural regeneration for a specific habitat 

type group will probably not be the same on the Flathead Forest as the Nez Perce Forest, both in 

the Westside Zone for Region One. The impact that a process such as root disease has on the 

next state for plant communities can be expected to be different on the Lolo Forest than on the 

Idaho Panhandle Forests. Editing features are available to capture additional work to improve 

the knowledge in the states such as fine scale modeling with FVS on sample plant communities, 

the incorporation of new research studies, and expert opinion gained from workshops of 
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silviculturists and ecologists. The editing features allow for changing the time spent in decades 

in a size-class/structure by adding or deleting states. The next state as a result of a process can 

be changed to a different species, size-class/structure, or density class. An additional process 

can be added to a state as long as it is one that currently exists within the system. Changes can 

be saved to new files that the user can reload for future simulations. 

There are two ways to edit pathway files: within the SIMPPLLE environment and outside of it. To 
edit within the SIMPPLLE environment: 

Place the cursor on a state and click the right mouse button (Figure 74). Select Edit. 

 

 

 
Figure 74 The choices for editing a state that are accessed by clicking with the right mouse button with 
the cursor on the state. 
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This will open the Pathway Editor screen, shown in Figure 75. 

 

 

 
Figure 75 The editor screen that is accessed by choosing the edit option when the right mouse button is 
clicked on the state in a diagram. 
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Within the Pathway Editor, select the process/next state combination that requires editing. In 
Figure 76, the Mixed-Severity-Fire process is selected for editing. 

 

 

 
Figure 76 Editor screen for a specific Vegetative Type state. The Process of Mixed-Severity-Fire is 
selected and the next vegetative type is ready to be edited. 

 

 

The next vegetative state can be typed in the box, or click Show List to see what other valid 
states can be selected.  

The Add option below Processes opens additional process choices to add to this state. Delete 
Selected removes the change to a next-state. 

Save Edits must be selected after making changes. 

If the desired next-state already exists in the pathway, the change can be made within the 
diagram by placing the cursor on the line where it comes from a state (the blue area) and 
holding down with left mouse button, dragging it to the new one we want to go to. Moving the 
line will make the corresponding changes in the file. 

The initial right mouse click on the state provides other choices besides Edit.  We could delete 
the entire state at this time. However, deleting a state cannot be done if there are other states 
with processes that lead to this state. An error message will indicate there are Previous States. 
The choice of Previous States can be used to identify states that have to be edited prior to 
deleting the selected state.  
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After editing all previous states, the desired state can be deleted. 

Species Change and Inclusion Rule are both available for grassland geographic areas. These are 
discussed under “Viewing and Editing Pathways that are Single States.” 

Collapse will collapse the individual decade states into just one state for each combination of 
species, size-class/structure, and density.  

If one needs to add a new state, but not an entirely new species, click Pathways at the top of 
the Vegetative Pathways screen, then select New State. This opens up a dialog box to allow the 
user to add a new state.  

10.2.4 Examples of Editing—Things to Look For 

Editing can be started by viewing the diagrams. Errors in logic are often spotted by turning on 

arrows for different processes. Figure 77 contains a number of errors. The third decade of the 

pole, density 3 does not seem to go anywhere. If you edit this state (this is in the default 

pathway file for the Westside) you will see that the next state after succession returns to the 

previous state. There are also two circular paths where the next state is the same, but it is easy 

to see the next state should continue within an age series. Another important point to notice 

with this species is that there are no multi-story states, only single and two-story. In workshops 

held to develop these pathways, the consensus was that if the states are called larch only, multi-

story stands will never appear. If multi-story stands develop, another species will need to be 

added to the larch. 
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Figure 77 Pathway display showing errors in three different locations. One state does not have a next-
state. Two states cycle when they should be going to another state. 

 

 

The red ERROR in Figure 77 has been added by editing the image. The system does not 
automatically recognize these types of errors.  

Figure 78 displays severe mountain pine beetle in lodgepole pine. The arrows display that the 
occurrence in most states completely kills the lodgepole pine with the resulting state being 
mesic shrubs. However, some of the older multi-story states do have their arrows going to a low 
density seedling/sapling state. One of the states in density 4 class is considered to have had a 
significant amount of Douglas-fir regenerating and with the mortality of lodgepole pine, it goes 
to a different species. The smaller size-classes do not have any arrows because they are too 
small to have a risk for the disturbance process. 
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Figure 78 Pathway display shows variability in the next-states resulting from severe lodgepole pine 
mountain pine beetle. 

 

 

Examining the summary report and the changes in acres of species or size-class/structure over 
time can provide some clues that some relationships may not be appropriate. If these do not 
appear logical (or even if they do) look at individual units to see how they are responding to 
disturbance processes. 
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The Vegetative Condition Summary, shown in Figure 79 (selected from View Results), shows a 
rapid loss in larch in the first few decades of the simulation (red lines added for emphasis will 
not show up in simulation). 

 

 

 

 
Figure 79 Summary display of species showing a rapid loss of acres in larch (L). 
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Figure 80 represents a state that changed from a larch type to a larch mixture in two decades as 
a result of succession. 

 

 

 
Figure 80 History display showing a change in species in the second time step from L to L-DF-GF. 

 

 

Elements that need to be changed on one ecological group will probably need to be changed on 
a number of habitat types. The above problem with larch has to be corrected across all the 
pathways where larch exists. There is no easy way to make such a change without going into 
each pathway file (one for each ecological/habitat type group) and making the change in the 
Next State after Succession. 

The Vegetative Unit Analysis screen in Figure 81 shows the impact of severe-lp-mpb that spread 
into a plant community. It completely killed all lodgepole above sapling size in the large, multi-
story, density 3 community. Only the seeding/sapling size lodgepole at a lower density class was 
left. Whether  this is an appropriate impact of severe mountain pine beetle and whether it 
should kill all of the larger trees needs to be decided by the user.  This impact or change of 
states, due to SEVERE–LP–MPB is separate from the probability that the disturbance would 
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occur.  

 

 

 
Figure 81 Individual unit history display showing the impact of severe-lp-mpb that spread into this 
existing-vegetation-unit. 
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The following example (Figure 82) is a lodgepole pine pole-size plant community that had a 
stand replacing fire in time step one. The regeneration logic identifies pole-size lodgepole as 
having serotinous seed. Thus, the stand regenerates to lodgepole. Note that for this habitat type 
at this density it takes three decades to move through the seedling/sapling size class. It is up to 
the user to determine if this an appropriate time or if the pathway should be edited. 

 

 

 
Figure 82 An individual unit history display showing the time to move through the seedling and sapling 
size following a stand replacing fire. 

 

 

Editing pathways is not an easy task. It can be very difficult to maintain consistency in 
relationships. We have to remember that states are abstractions. We often show abrupt 
changes from single story, to two-story or multi-story, or from single species, to two species. In 
most cases your experience tells you that most single-story states will have some understory in 
it. Within the pathways, it is often a judgment call as to the number of decades necessary for a 
state to develop enough understory that we change our abstraction label to two-story. The 
same is true for species changes.  
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10.2.5 Editing Pathway Text Files 

Pathway files can be edited in a text file format. Within the Vegetative Pathways screen (System 
Knowledge > Pathways > Vegetative Pathways) select File > Export Pathway to Text File… to 
create text files. A basic text editor such as Word or Notepad can be used to make changes, and  
import the new file back into SIMPPLLE using File > Import Pathway Text File. The exported text 
files are created for an ecological stratification. All species within a stratification are included in 
one text file. 

Once the file is loaded back into SIMPPLLE it must be saved as a Pathway file using the Save As 
so it can be loaded in the future by using Open. 
An example of an exported pathway file is in Figure 83. 
 
 
HABITAT-TYPE-GROUP C2 

  HABITAT-TYPES  516 517 518 519 520 521 522 524 525 526 529 

  CLIMAX-SPECIES GF 
  SERAL-SPECIES  DF PP LP L CW MC WP 

VEGETATIVE-TYPE L-PP-LP/LMU6/4 
  MIXED-SEVERITY-FIRE       L-DF-PP/VERY-LARGE/2                   0 
  LIGHT-SEVERITY-FIRE       L-DF-PP/VERY-LARGE/3                   0 
  STAND-REPLACING-FIRE      MESIC-SHRUBS/CLOSED-LOW-SHRUB/1        0 
  LIGHT-LP-MPB              L-DF-PP/VERY-LARGE/3                   0 
  SUCCESSION                L-DF-PP/VLMU/4                         0 
  SEVERE-LP-MPB             L-DF-PP/VERY-LARGE/2                   0 
  DF-BEETLE                 L-PP/LMU/2                             0 
  PP-MPB                    L-DF-PP/VERY-LARGE/2                   0 
  XY-COORDINATE L-PP-LP 716,351 

VEGETATIVE-TYPE DF-PP-GF/PTS2/3 
  MIXED-SEVERITY-FIRE       DF-PP-GF/POLE/2                        0 
  LIGHT-SEVERITY-FIRE       DF-PP-GF/POLE/2                        0 
  STAND-REPLACING-FIRE      MESIC-SHRUBS/CLOSED-LOW-SHRUB/1        0 
  ROOT-DISEASE              DF/PMU/2                               0 
  SUCCESSION                DF-PP-GF/PTS3/3                        0 
  XY-COORDINATE DF-PP-GF 193,165 

VEGETATIVE-TYPE DF-PP-GF/PTS2/2 
  MIXED-SEVERITY-FIRE       PP-DF/POLE/2                           0 
  LIGHT-SEVERITY-FIRE       DF-PP-GF/POLE/2                        0 
  STAND-REPLACING-FIRE      MESIC-SHRUBS/CLOSED-LOW-SHRUB/1        0 
  ROOT-DISEASE              DF/PMU/2                               0 
  SUCCESSION                DF-PP-GF/PTS3/2                        0 
  XY-COORDINATE DF-PP-GF 189,23 

VEGETATIVE-TYPE L-GF/LMU4/4 
  MIXED-SEVERITY-FIRE       L-GF/LARGE/2                           0 
  SEVERE-WSBW               L-GF/LARGE/2                           0 
  LIGHT-SEVERITY-FIRE       L-GF/LMU/3                             0 
  STAND-REPLACING-FIRE      MESIC-SHRUBS/CLOSED-LOW-SHRUB/1        0 
  ROOT-DISEASE              L-GF/MMU/2                             0 
  LIGHT-WSBW                L-GF/LMU6/4                            0 
  SUCCESSION                L-GF/LMU6/4                            0 
  XY-COORDINATE EARLY-SERAL 926,416 
  XY-COORDINATE LATE-SERAL 909,431 
  XY-COORDINATE L-GF 651,391 

Figure 83 Text format of an exported pathway file. 
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10.2.6 Viewing and Editing Pathways That are Single States 

Pathways represented by single states were developed for use in the grassland geographic 

areas. In version 2.5 they are available for use in any geographic area in combination with the 

multiple state pathways representation.  

Single-state pathways represent a species aggregate in which certain species are within defined 

percentages. The size class and density attributes are not used and are coded NA. Figure 84 

represents a single-state pathway. The screen provides access to the detailed information on 

the species aggregate. 

 

 

 
Figure 84 The pathway for the species aggregate of CALO-HECO26-ARTR2. 

 

 

The only option within the Process drop-down menu is SUCCESSION. By placing the cursor on 

the state and clicking with the right button, access is provided to the information in the pathway 

that includes Species Change and Inclusion Rules. 

Inclusion Rules identify the species and the percents they have to be within for a plant 

community to be identified as this state. Figure 85 shows the inclusion rule format. The 

percentages can be edited within the screen. To add an entry for a new species that already 

exists in the system, click on Action within the Inclusion Rules Editor. The new entry allows a 

USDA Forest Service Gen. Tech. Rep. RMRS-GTR-268WWW. 2012 123



 

new species to be added. This species must also be entered through the Species Attributes 

Editor first, as in the other pathway format. 

 

 

 
Figure 85 Inclusion rule for a specific state identifying what species at what percents are required for a 
plant community to be identified as this state. 
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With this pathway format, the information is not a change to another state, but the rate of 
change for each individual species. There can be more species identified than comprise the 
aggregate name. Figure 86 displays the rate of change for each species for each process that is 
applicable. As a simulation is made and the species percents change for each plant community 
with each time step, the system checks the percents against the inclusion rules. When a plant 
community’s species percent change puts it outside the initial inclusion rule, a new rule is found 
for the current percents, and a new state name is assigned. The rate of change in this format is 
constant across all the years in a simulation. The values can be less than whole percents. Future 
versions may provide more complexity to the change by making it possible to assign functions. 

 

 

 
Figure 86 The rate of change for each species by each process. 

 

 

To edit within the Species Change Editor, click Action. Percent Change can be edited directly on 

the screen. 
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The files for both the species change and inclusion rule can be built in an Excel spread sheet, 

saved as a text (*.txt) file, and imported into SIMPPLLE using options under File on the Pathway  

main menu screen. The text file for the species changes must be tab delimited (.txt), and the file 

for the inclusion rule has to be comma delimited (.csv). 

Once the files have been loaded into SIMPPLLE, the Save by the system adds an extension of 

“*.sk_pathway.” 

Using this pathway format requires that the plant communities in the GIS files have the tracking 

species fields populated (see previous section on “Vegetation Attributes”). If the species value in 

the attributes file that came from the GIS files is greater than zero, but there still is no species 

change information for it within the pathway files, it will be brought into the SIMPPLLE area file, 

but the species value will not change in simulations. This can easily be seen by looking at the 

individual unit displays. In this case, the user can edit the pathway file, adding in change values 

for this new species.  

10.3 PATHWAYS—AQUATICS 

Pathways for aquatic units were used in an early version for a prototype—Westside Region One 

geographic zone. A limited discussion is in Appendix A. Aquatic units are used in the grassland 

geographic areas to represent a water source for grazing animals. At least one pathway file has 

to exist for this purpose, but no changes from the pathway file are utilized (see Appendix H for 

grassland zones). 

10.4 VEGETATIVE PROCESS 

10.4.1 Lock in Process   

There are a variety of ways that the user can explore what-if scenarios. Disturbance processes 

can be locked in, while the system models others as stochastic. By choosing Stand Development 

for type of simulation, the only disturbance processes will be those locked in. The probability 

screens for each process can be utilized to selectively zero out the occurrence of a process. 

 Locking in a process is not the same as identifying a process within the input files. Identifying 

processes in the input files gives a simulation a disturbance history. The simulations can be more 

realistic by accounting for processes that the user knows are currently active or have recently 

occurred such as mountain pine beetle or root disease. Processes can also be scheduled to 

evaluate the impact of possible extreme events or large-scale occurrences of processes such as 

mountain pine beetles or stand replacing fires. 
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To lock in a specific disturbance process to a plant community and time step select System 

Knowledge > Vegetative Process > Lock in Processes (Figure 87). 

 

 

 
Figure 87 Choices made in SIMPPLLE menus to get to the screen needed to lock-in specific disturbance 
processes. 

 

 

This will open the Process Schedule (Figure 88). The Process Schedule allows the user to create 
combinations of Time Step, Process, and Unit Ids. Each combination represents an entry that is 
created by choosing (from File in the Process Schedule) New or Copy Current Process. Prev and 
Next can be used to move through the combinations you have created. 
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Figure 88 SIMPPLLE screen for scheduling disturbance processes. 

 

 

To create a new schedule, select File > New (Figure 89). 

 
Figure 89 Choices under the “File” pulldown menu on the “Process Schedule” main screen. 
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This opens a dialog box from which the user can select a new process (Figure 90). 

 

 

 
Figure 90 SIMPPLLE screen listing all disturbance process that can be locked-in for a specific zone. 
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The selected process is added to the Process Schedule screen. Notice with the fire processes 
FIRE-EVENT shows up as a process (Figure 91). If this is specified, the system knowledge for the 
type of fire event is used to determine what type of fire actually occurs (see fire process). A 
choice of time step must be entered, followed by the Enter key. The plant community id values 
(slink numbers) are then entered in by typing the number and selecting Add.  

 

 

 
Figure 91 A completed SIMPPLLE screen that locks-in the “fire-event” process for Time Step 1 for four 
vegetation units. 

If the user wants to schedule the same process for additional time steps, select File > Copy 
Current Process (Figure 92). 
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Figure 92 The choice needed to copy a locked-in process to apply to another time step. 

 

 

File > Copy Current Process changes the screen to have the same process and the same units 
scheduled; however, the time step is blank and must be entered. If you do not want the same 
exact units scheduled, use the Add or Remove Selected buttons for modification. This process 
may be repeated to create as many combinations of Time Step, Process, and Unit Id lists as 
desired. Prev and Next can be used to move between the combinations if additional editing of 
the unit ids is needed. To add a different process, create a new combination of Time Step, 
Process, and Unit Id lists.  

After you have created all the combinations of Time Step, Process, and Unit Id lists and you are 
ready to make a simulation with these processes locked in, select File > Close Dialog. If at any 
time in the process of creating a lock-in schedule you want to remove all the combinations you 
made, select File > Unload. To remove a combination currently displayed, select File > Remove 
Current Process.  

To save this lock-in schedule so it can be loaded in the future for other SIMPPLLE sessions 
without having to reenter everything, go to File > Save As. This can be done as soon as you have 
all the combinations made, or you can come back to this later after you have made simulations 
and decided you like the results. Selecting Save As opens a screen to the working directory you 
have identified. The system will add the extension of “.process” to the name you have provided.  

The file that is saved cannot be viewed or edited outside of SIMPPLLE. In future SIMPPLLE 
simulations, to use the file go to File > Open. This opens a screen at the working directory and 
identifies all “*.process” files that are available. 
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Another option is File > Load Unit Id File. This loads a file that can be created outside of 
SIMPPLLE and is in a text (*.txt) format (Figure 93). 

 

 

 
Figure 93 Example of a text formatted file for locking-in a process to specific plant communities. 

 

 

10.4.2 Fire Process 

Many aspects of the fire process have been simplified. However, what we have given up in the 

detail of modeling fire (using fuel models, FARSIGHT, etc.) we consider is more than offset by 

the inclusion of the interaction with other disturbance processes and the spatial pattern of the 

landscape. Figure 94 illustrates how SIMPPLLE models the fire process and identifies where 

information can be adjusted by the user. 
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Figure 94 Diagram of the steps used by SIMPPLLE in modeling the fire process. 
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Fire logic is accessible through the user interface screens under System Knowledge > Vegetative 
Process > Fire Event Logic (Figure 95). 

 

 

 
Figure 95 Access to the fire process logic. 

10.4.3 Fire Event Logic 

Fire event logic is separated into two components: type of fire and fire spread. To access the 

two components, use the SPREAD or TYPE tabs within the Fire Event Logic screen (Figure 96). 

If a fire event is not kept at less than one-quarter acre by either suppression or weather-ending 
events, the logic utilizes the TYPE screen to identify the type of fire in the plant community that 
has the origin of the event. 

 

 

 
Figure 96 Logic for determining the type of fire that results from a fire event in a plant community. 
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The resistance of species to fire is taken from Fischer and Bradley (1987) for Western Montana, 
and Smith and Fischer (1997) for Northern Idaho. 

As the fire event spreads to adjacent plant communities, the logic in the fire spread screen is 
used. The user can decide how many of the fields to display. Select Columns on the menu bar to 
include as much of the system knowledge as is appropriate. For example, Figure 97 is a Fire 
Event Logic screen for one of the grassland areas in which the only type of fire is stand replacing 
fire (SRF). 

 

 

 
Figure 97 Logic screen for fire spread for geographic zone that has only grasslands with stand replacing 
fire events. 
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Figure 98 displays a greater number of logic combinations for a more complex situation. 

 

 

 
Figure 98 Fire spread logic for a geographic zone that has all three intensities of fire: stand replacing 
(SRF), mixed severity fire (MSF), and light severity fire (LSF). 

 

 

10.4.4 Extreme Fire Spread Probability 

Burning conditions within SIMPPLLE have been simplified to represent two conditions; average 
conditions as well as extreme conditions that represent wind driven fire events. The occurrence 
of wind driven fire conditions, such as the passage of a weather front, or the behavior that 
results from the size of fire event creating its own weather once it exceeds a given size, can be 
set in the Extreme Fire Spread Probability screen (Figure 99) by selecting System Knowledge > 
Vegetative Process > Extreme Fire Spread Probability. 
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Figure 99 Screen that provides the means to change default values controlling the probability that a fire 
event will spread under extreme conditions. 

 

 

Extreme fire spread logic also includes a component to allow for spotting downwind of a fire 

event. This logic is not accessible at this time. 

10.4.5 Fire Suppression Costs 

In version 2.5, the input screen is used for both fire occurrence and suppression costs. Select 

System Knowledge > Vegetative Process > Fire Suppression Cost. The distribution of fires size 

classes are used to provide the basis for suppression costs which usually varies by fire size class. 

If the demand for utilizing fire suppression costs within SIMPPLLE increases, a separate screen 

will be created for the interaction of costs with other variables. 

10.4.6 Fire Occurrence Input 

The probability of a fire event in SIMPPLLE is on an acre basis. This can vary by fire management 
zone (FMZ) if the landscape is stratified by them (if the vegetation polygons have FMZ as an 
attribute). To access the FMZ Editor, select System Knowledge > Vegetative Process > Fire 
Occurrence Input. If FMZs are not used, the zone must be identified as All and a zero placed in 
the FMZ data field for each polygon in the cover (Figure 100). SIMPPLLE uses the number of fires 
for a past ten-year period divided by the total acres on which that the number of fires occurred. 
(These probabilities are on a decade basis. If yearly time steps are used, the system divides the 
values by ten.) The fires are listed by size class, but past distribution by sizes does not influence 
the future fire size distribution. The size of any given fire event is influenced by the vegetation 
pattern and the probability of extreme fire spread behavior. In version 2.5, the input screen is 
used for both fire occurrence and suppression costs and should look similar to the Personal 
Computer Historic Analysis (PCHA) reports that are generated by most National Forests and BLM 
field offices. 
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Figure 100 The Fmz Editor screen showing both the number of fires for a past 10 year period and the 
suppression cost per acre. The values can vary by fire management zone. 

 

 

A sensitivity analysis on the number of fires has been done as part of a Joint Fire Science funded 
project (Weise et al. 2000, 2003) 

10.4.7 Fire Season 

In version 2.5, the probability of the season of a fire occurring is only available in the grassland 

zones where the season of the fire is important in some of the logic. To access the Fire Season 

Probabilities screen (Figure 101), select System Knowledge > Vegetative Treatments > Fire 

Season. 

 

 

 
Figure 101 Screen that gives user access to changing the probability of the season of a fire event. 
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10.4.8 Fire Suppression Logic 

To access fire suppression logic options, select System Knowledge > Vegetative Process > Fire 

Suppression Logic (Figure 102). 

 

 

 
Figure 102 Access to the Fire Suppression Logic through the user interface. 

 

 

Fire suppression logic varies by the logic used to keep fires at a Class A size and for fires that go 
beyond the Class A size. The fire suppression logic beyond the Class A size is different if the 
SIMPPLLE area file uses irregular polygons or uniform sized units. 

Class A Size Events 

If fire suppression is being used in a simulation, the logic that is used to identify the probability 

of suppressing a fire at the Class A level is accessible for change. The probability can vary by 

what the Regional Climate is for a time step: wetter, normal or drier. Regional Climate is normal 

unless it is specified to be different for a simulation. Under the main menu, select System 

Knowledge > Vegetative Process > Fire Suppression Logic > Class A. This will pull up the Fire 

Suppression for Class A Fires Logic screen (Figure 103). Columns are available from the menu 

bar to utilize as many variables as desired. However, all variables used must be attributes of 

each plant community in the landscape (see input requirements). 
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Figure 103 Fire Suppression logic for the probability of keeping a fire event at a Class A level, less than 
.25 acres. 
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Beyond Class A 

If a fire event does not stay at a class A level as a result of either fire suppression or weather 

events, the logic for fire suppression beyond the Class A size is utilized. Under the main menu, 

select System Knowledge > Vegetative Process > Fire Suppression Logic > Beyond Class A. This 

will pull up the Fire Suppression Logic for Fires Beyond Class A screen (Figure 104). If irregular 

sized plant communities are used, this logic can be rather simple. A change in vegetation 

conditions that changes the type of fire to mixed severity or stand replacing fire must occur for 

it to be suppressed in a plant community that the fire has spread to. 

 
Figure 104 Logic used to determine how fire suppression is applied to fire events that exceed initial 
suppression at a Class A level. 
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Production Rate, Spread Rate, Response Time 

There are three components to fire suppression if uniform size units are being used: a fire line 

production rate for the suppression forces, a spread rate, and a delay time for the suppression 

forces arriving at the fire event. Each of these can be accessed by selecting System Knowledge > 

Vegetative Process > Fire Suppression Logic. The spread and production values can be derived 

from other fire analyses performed by fire suppression organizations. 

Figure 105 is a simplified set of production values for a geographic zone. 

 

 

 
Figure 105 Production rates used for uniform size plant communities. 
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To capture the same concept that was used with irregularly sized plant communities (no direct 

suppression against stand replacing fire), Figure 106 shows the addition of a line of logic 

showing no production if Time Step 0 has stand replacing fire. 

 

 

 
Figure 106 A set of production rates that includes a combination that states for a plant community that 
has stand replacing fire in the current time step, 0, there will be no production. Or, in other words, 
direct fire suppression activity is not taken against stand replacing fire. 
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The spread rates for the same zone are shown in Figure 107. 

 

 

 
Figure 107 Fire spread rates for use with uniform sized plant communities. 

 

 

System Knowledge > Vegetative Process > Fire Suppression Logic > Response Time allows the 
user to specify a delay time by FMZ if the landscape is stratified by them (Figure 108). 

 

 

 
Figure 108 Delay time in response of suppression forces by FMZ. Time is utilized in the calculation of fire 
spread and suppression forces production to determine size of fire events that are suppressed. 
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10.4.9 Weather-Ending Events 

An additional stochastic component exists to represent the probability of a weather event 

ending a fire event’s spread (such as a season ending rain). This logic is separated into fire size 

less than Class A and greater Class A. To access the Weather-Ending Events screen, select 

System Knowledge > Vegetative Process > Weather Ending Events, then choose Fires Less than 

.25 acres (Class A) or Fires Greater than .25 acres (Figure 109). 

Many fires do not develop beyond the Class A (less than one-quarter acre) level due to weather 
events such as significant rain occurring with the lightning that starts the fire event. The default 
conditions identify the species that are associated with higher elevation areas. However, if one 
believes the original data for Class A events does not include those ignitions that did not make it 
to the reporting level because they already went out, then this should all be set to zero. Or, in 
other words, they are already taken out of the data by the reports used to generate the number 
of fire events. 

 

 

 
Figure 109 Logic screen for probability of weather events that keep fire events from developing past the 
Class A size, less than 0.25 acres. 
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If a fire event exceeds Class A size as SIMPPLLE is spreading a fire event and each set of 
neighbors is evaluated for spread, the following probabilities (Figure 110) are used to see if the 
spread continues. This logic is very sensitive.  Small values can lead to very significant reductions 
in level of fire. 

 

 

 
Figure 110 Screen for providing probabilities to link a weather-ending event to the size of a fire event. 

 

10.4.10 Vegetative—Unit Fire Type Logic 

If multiple life forms are being utilized in a landscape, the logic for deciding what type of fire to 

assign to an entire unit must be included. Select System Knowledge > Vegetative Process > 

Vegetative – Unit Fire Type Logic. This allows the user to access the Veg Unit Fire Type Logic 

screen (Figure 111). 

 
Figure 111 Logic to be used with multiple life forms descriptions of vegetation to decide what type of 
fire to assign to the entire plant community. 
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10.4.11 Editing and Testing the Fire Process Logic 

Fire cycles, return fire intervals, or fire regimes are not input into SIMPPLLE. The simulated fire 
behavior is the result of the interaction of the logic and the unique vegetation pattern of a 
landscape. All of the logic in SIMPPLLE represents default values for a zone. There is the 
potential for considerable variation within these zones. The extent to which the user refines the 
default values/logic depends on what is judged to be acceptable model behavior. This should be 
determined by making simulations on sample landscapes and on landscapes where there is a 
history of disturbance processes to check against. To assess whether the logic in any of the 
screens needs to be adjusted, the user should start by looking at the number of fire events in a 
simulation. This is displayed in the Summary Report (see “Reports” section). 

If the number of fires appears reasonable, the acres associated with individual fire events can be 
evaluated by examining the Detailed Fire Report (see “Reports” section). The GIS files for spread 
can be created and examined to help decide if the spread of the fire process appears 
reasonable. Changes can be easily made and simulations made to see what impact they have. 
For example, with the extreme fire probability set to zero a fire event can be locked-in to a 
specific plant community to examine the fire spread with and without treatments or other 
disturbance processes. 

A test of fire spread logic can be accomplished by utilizing a file that tracks what spread logic is 

used as a fire event spreads from one unit to another.  To utilize this capability, a “flag” has to 

be set to “true” in the “simpplle.properties” file in the user's home directory. 

 

 For Windows XP, this is C:\Documents and Settings\username\.  

 For Vista, this is C:\Users\username. 
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The file looks similar to Figure 112.   

 

 

This file will produce a text file that is placed in the output directory identified for a single 

simulation. 

The easiest way to utilize this capability is to set the FMZ file fire occurrences all to zero. Then 

lock-in a fire event to a specific plant community. This way there will be only one fire event that 

occurs.  

Once the simpplle.properties file has the “false” changed to “true” for the 

“SIMULATION_LOGGING”, you have to close and open SIMPPLLE again. A single time step can be 

Figure 112 File to set the flag for analysis of the use of fire logic. 
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made without fire suppression. Select an output directory and provide a prefix name. Be sure to 

“uncheck” the GIS files. You don't need them for this analysis. 

In the output directory created there is the file that provides standard fire event information. In 

Figure 113, the one fire was locked into EVU 649. The spread resulted in a 2,638 acre fire.  

 

 

 

 was  

Figure 114 shows the logic rule used to make the spread to another unit, or stop the spread 

“NONE.”  

Figure 113 Standard fire event information for a fire locked in to plant community 649. 
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Figure 115 shows the information provided when a weather-ending event stopped the spread of 

the fire. 

 

 

 

 

Figure 115 Detailed fire spread log file with last line showing the fire event was stopped by a weather-ending event. 

Figure 114 The detailedlog.txt file that shows what logic was used in spreading the fire events. 
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10.4.12 Species Attribute Editor 

The Species Attribute Editor identifies Species, Description, Lifeform Type, Fire Resistance 

rating, Conditional Fire Resistance, whether they are considered Invasive (and thus, having 

probability logic associated with them) and a check by the system to see if a pathway is loaded 

for the species (Pathway Present). To access the editor select System Knowledge > Vegetative 

Process > Species Attribute Editor. Within the editor window, File and Action provide choices 

that include adding a new species and deleting existing ones. 

 

 

 
Figure 116 The Species Knowledge Editor. 

 

 

10.4.13 Disturbance Process Probability (other than fire)  

The choice of disturbance processes, such as insect and disease processes, to include in 

SIMPPLLE involves consideration of: 

 the processes that have significant knowledge that may be used to predict a probability 
of occurrence; 
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 the processes that make significant changes in the attributes that are used to describe 
vegetation;  

 their presence has a significant impact on the occurrence of other processes; and 

 the processes that require data for predictions that could be derived from the inventory 
data we could expect to find in a geographic area. 

To incorporate many of the processes into SIMPPLLE, significant modifications of the existing 

research are required, such as hazard rating systems, in order to be able to work with the level 

of inventory data available for landscape scales. The western spruce budworm logic derived 

from Carlson and Wulf (1989) for many of the zones and the spruce beetle for south central 

Alaska utilizing the Spruce Beetle Expert System (Reynolds and Holsten 1997) are two examples. 

However, as with other components of SIMPPLLE, what we have given up in detail in some areas 

we more than gain by being able to capture an interaction with spatial patterns of vegetation, 

past history of processes, and other disturbance processes. 

Past research and monitoring has provided long-term measurement that provides rates of 

change due to insect and disease process. These values have been used in transition matrices in 

other models but we do not want to lock these values into SIMPPLLE. They should serve as 

comparisons to SIMPPLLE output on similar landscapes with multiple stochastic simulations. 

Future analysis should be done to compare the results from multiple simulations to see how 

these observed values lie in relation to the range created by the simulations. 

10.4.14 Western Spruce Budworm Logic 

Western Spruce Budworm Logic is not accessible to the user. Screens have not been created for 

it, but it is discussed in the appendices for the geographic areas. Instead of options to modify 

the logic, the user can disable the use of this process by selecting System Knowledge > 

Vegetative Process > Disable Western Spruce Budworm. 
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10.4.15 Process Probability Logic 

To access the Process Probability Logic screen (Figure 118) select System Knowledge > 

Vegetative Process > Process Probability Logic (Figure 117). Using the Columns drop-down 

menu within the Process Probability Logic screen, the user can decide how much or how little of 

the system knowledge can be used. The probabilities in the logic screens are independent of the 

choice of time-step—yearly or decade. They should be considered as the likelihood of the given 

combination of conditions resulting in a plant community being impacted by that process.  

 

 

 
Figure 117 Access to the disturbance process probability logic that includes insects and disease 
processes. 
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Figure 118 The process probability logic screen for a zone with tabs for each process. 

 

 

 
Figure 119 The choice of columns of system knowledge that can be used in a process logic screen. 
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The ordering of the logic lines is important. The system starts working with the first line in the 
screen and as soon as one matches all conditions for a plant community it is used. This means 
more detailed combinations have to be placed first. The last line can be a generalized, default 
combination that the system will use if no other conditions match (Figure 120). 

 

 

 
Figure 120 Choices available for working with logic combinations. 

 

 

There are a number of processes that have unique screens (e.g., Bison Grazing) and are accessed 
separately through system knowledge choices. There are some processes in which the screen 
has no probability logic (e.g., Windthrow). The only way the process can be used is by locking it 
in to specific plant communities. 

The specific process logic is discussed in the appendices for each geographic zone. 

10.4.16 Gap Process Logic 

This logic was initially developed for the Colorado Plateau zone where the scale at which 

processes occurred was significantly less than the size of the unit that the inventories supported 

simulating. The goal with version 2.5 is to make this feature available in other geographic areas. 

The user can create logic to account for some processes happening at scales less than the size of 

the plant community being simulated. 

The Gap Process Logic screen (Figure 121) displays two logic combinations occurring at a gap 

scale: pinyon pine bark beetles (PIED-BB), Ips hoppingi, and stand replacing fire (STAND-

REPLACING-FIRE). The scale is parallel to fire events that are kept at the Class A size of 0.25 
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acres. The logic is parallel. The system keeps track that the process occurred in the plant 

community, but it does not change any attributes of the community. To access this screen, 

select System Knowledge > Vegetative Process > Gap Process Logic. 

 

 

 
Figure 121 Two logic combinations for having disturbance process occur at a scale of 0.25 acres. 

 

 

Figure 122 displays a plant community that has had a gap process. GAP occurs in the Probability 

column. To access the Vegetative Unit Analysis screen, select View Results > Vegetative Unit 

Analysis. The disturbance process for the entire plant community is SUCCESSION, but the 

original process column shows STAND-REPLACING-FIRE. 
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Figure 122 also shows another feature in Time Step 2. For probability, the herbaceous life form 

shows COMP. This indicates that the density of this life form was influenced by the presence 

and increase in density of the trees and shrubs. The pathways for this herbaceous species would 

have changed the herbaceous density to a Class 4; however, the logic in the Life form 

interaction system knowledge results in the density at a level 3 due to competition. 

 

 

 
Figure 122 Displays the occurrence of a fire event at a gap level in this 2 acre plant community in Time 
Step 2. 

 

 

The gap processes contribute acres to the reports at the rate of one-quarter acre per 

occurrence. 

In a future version of SIMPPLLE, the logic will be expanded in order to keep track of the 

occurrence and provide screens for the user to say what percent occurrence represents a 
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threshold over which an entire community’s attributes are changed as a result, or how the 

community responds to other processes is different. 

10.4.17 Insect/Disease Spread Logic 

System Knowledge > Vegetative Process > Insect and Disease Spread Logic is shaded out. 

Spread across the landscape is solely provided by the probability logic screens which determine 

how adjacent unit occurrence or occurrence within the landscape may increase the probability 

of the process spreading to other units. 

10.4.18 Windthrow—Wildlife Browsing 

If these choices are available on the Vegetative Process pull-down screen for a geographic zone 

they have to be locked-in to plant communities to be used. There has not been any probability 

logic developed. If the processes are locked in, the next-states for the processes have to have 

been incorporated into the vegetative pathways. 

10.4.19 Invasive Species Logic 

To access this screen (Figure 123), select System Knowledge > Vegetative Pathways > Invasive 

Species Logic. The system knowledge is based on research that is very specific to a geographic 

area. The Eastside of Region One and the Colorado Plateau are the only two areas with invasive 

species capabilities at this time. With the logic being based on very specific research there are 

significant differences in the probability screens for the species in each geographic area. The 

appendices for the zones identify the specific research used. 

Regardless of the difference in the research, the screens have two parts in common. One part 

for the probability logic (PROBABILITY tab) and one part for the change rate logic 

(CHANGE_RATE tab). The probability screen contains the information from the research 

necessary to link to a probability of occurrence and a starting canopy density value for the 

species. 
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Figure 123 Screen for the Colorado Plateau Zone invasive species logic. 

The change rate contains the logic on how a species’ canopy density responds to other 

disturbance processes or succession (Figure 124). It also identifies a threshold value that is a 

canopy density level above which the invasive is no longer just a species within a plant 

community, but is the dominant species, in which case the name used to label the community, 

or that life form, is changed to be the invasive. 

 

 

 
Figure 124 Change Rate screen for the Colorado Plateau invasive species logic. 
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Within the individual plant communities, the invasive species are handled as tracking species. 

The percent of canopy density will be displayed as shown in Figure 125. 

 
Figure 125 Individual plant community display showing invasive species (BRTE—cheatgrass) as tracking 
species by time step for a simulation. 

 

 

Acres of invasive species will show up in the Summary Report (Reports > Summary) when the 

percent of canopy density exceeds the threshold value. To get acres of invasive species at the 

full range of different densities Reports > Tracking Species Report has to be used. 

The incorporation of invasive species into the system provides the means to capture possible 

interaction with other processes. For example, by using Columns in the logic screen for fire 

spread tracking species of cheatgrass, BRTE, greater than or equal to 45 percent canopy cover 

made a difference in how fire spread as shown in Figure 126.  
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Figure 126 Fire spread screen for the Colorado Plateau showing the use of the presence of an invasive 
species BRTE at greater than or 45 percent cover to make a difference in how a fire event will spread. 

 

 

Remember, in order for this logic to be used in a simulation, the choice has to be made on the 

Set Simulations Parameters screen (click Run Simulation button on the main menu). 

10.4.20 Regeneration Process  

There are three components to regeneration that are accessible by selecting System Knowledge 

> Vegetative Process: Use Regen Pulse, Regeneration, and Producing Seed Logic. 

10.4.21 Use Regen Pulse 

System Knowledge > Vegetative Process > Use Regen Pulse has been made available to 

represent the situation where the combination of available seed sources, suitable weather 

conditions, and available seedbed conditions often occur throughout a geographic area at the 

same time. A logic screen is not accessible through the user interface yet. This choice allows the 

user to turn it on or off. The logic works in connection with pathways for specific ecological 

stratifications (see specific appendices for zones). If pathways have a combination of structure, 

single stories to multiple stories that are not connected by succession, then it takes the 

recruitment of another cohort of regeneration to change the structure. The regeneration only 

occurs when a combination of events happens: a good seed source, favorable moisture 

conditions, and an event that prepares the site. Then regeneration can happen over the entire 

landscape, not just specific plant communities. A probability value is used in the logic and when 

that probability event is triggered, the plant community must have had a recent mixed or light 
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severity fire that has prepared a seedbed. The change in structure and density as reflected in the 

pathways will then occur. 

10.4.22 Regeneration 

A significant part of the variability that exists over time in a landscape can come from the high 

variability in the regeneration process. The variability depends on not just the regeneration 

mechanisms of the species but also the spatial arrangement of adjacent plant communities that 

can be in different development stages. 

Regeneration is handled as a process but it does not show up in the potential vegetative states 

(the pathway diagrams) because it depends on spatially explicit information. It does not happen 

automatically. It is possible to have forested communities in a landscape not return to a tree 

cover type for a number of decades following stand-replacing events. To access the 

Regeneration Logic screen (Figure 127), select System Knowledge > Vegetative Process > 

Regeneration. The regeneration knowledge is applied under two specific conditions. It is applied 

if a non forest state exists on a forested habitat type. This application is referred to as 

succession regeneration (SUCCESSION tab). It is also applied following a stand-replacing-fire in a 

plant community as fire regeneration (FIRE tab).  

 

 

 
Figure 127 The Regeneration Logic screen for the fire regeneration. 
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New species can be added to both of these screens as long as it is first added to the system 

through the species attribute editor (System Knowledge > Vegetative Process > Species 

Attribute Editor). Both screens have the Columns option in the menu bar that enables 

additional columns to be added to use additional system knowledge to quantify the 

regeneration logic. 

Fire Regeneration 

When regeneration is applied through the fire logic (FIRE tab), the knowledge consists of five 

different components used to determine how a plant community can regenerate. They are: the 

species resprouts in place (Resprouting State), the species resprouts from adjacent communities 

(Adjacent Resprouting), seed is produced by the plants that burned (In-Place Seed), seed is 

provided from adjacent communities (Adjacent), or seed is transported from communities 

within the landscape (In Landscape). Through the interface screen, the user can specify by 

species the appropriate regeneration component For example various shrubs and quaking aspen 

are identified as resprouting. Quaking aspen can be identified by resprouting from adjacent 

communities of aspen. Lodgepole pine can be identified as having serotinous characteristics 

providing in place seed. Ponderosa pine and Douglas-fir if the large or very large size-class can 

also have some seed survive a stand replacing fire event. Most species are capable of producing 

seed that can serve as a seed source for an adjacent plant community that burns. Some species 

such as white bark pine or junipers have seed that is commonly spread across a landscape by 

birds.  

Notice that a preference sequence can be identified to be used with adjacent seed source such 

as placing those species that have light wind borne seed first. The entire table can be stratified 

by ecological grouping if so desired to account for variability in some species regeneration 

methods. Placing the cursor in a cell will open up a dialog box that enables the user to select 

what species and what state regenerates (Figure 128). 
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Figure 128 Selecting what species and what state to result from PIED providing adjacent seed as a seed 
source for a neighboring plant community impacted by a stand replacing fire event. 

The “regeneration following fire” logic evaluates the possible components in the order they are 
listed on the screen from left to right. If none of the above criteria result in a community being 
regenerated to a tree life form, the non forest state, shrubs or grasses, that is in the pathway 
resulting from stand replacing fire is assigned. In following time-steps, the succession 
regeneration logic is evaluated. 

The code that identifies the sequence of evaluation uses the adjacent plant community that has 
the greatest area, not the most shared boundary, to determine what adjacent seed source to 
use.  This code cannot be accessed or modified in this version. 

Succession Regeneration 

The Succession Regeneration (SUCCESSION tab) uses logic that only looks for seed sources from 

adjacent communities. The logic in this screen (Figure 129) identifies what grass or shrub states 

can have trees regenerate into it (if the seed source is present). Using this screen one can 

identify those grass and shrub communities on certain ecological sites that are not suitable for 

other species regenerating through it. Plant communities that are capable of being regenerated 

will be evaluated each time step for an adjacent suitable seed source. Those plant communities 

not suitable will follow the pathway trajectory for that species until a disturbance event changes 

them to a state that is suitable for other species regenerating in it. 

 

 

USDA Forest Service Gen. Tech. Rep. RMRS-GTR-268WWW. 2012 164



  

 
Figure 129 Succession logic screen showing what species can have other species regenerate within them 
and what the resulting state would be. 
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10.4.23 Producing Seed Logic  

System Knowledge > Vegetative Process > Producing Seed Logic (Figure 130) enables the user 

to identify the criteria under which a species will be considered capable of producing seed.  In 

Figure 130, the Processes column has been used to identify that past western spruce budworm 

activity eliminates the capability to produce seed. Research on the frequency of seed crops can 

be incorporated; however, at this time all default probabilities are either 0 or 100 percent. 

 

 

 
Figure 130 Screen for the logic for requirements for a species to be producing seed. 
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Regeneration Delay  

To access regeneration delay, select System Knowledge > Vegetative Process > Regeneration 

Logic. Within the Regeneration Logic screen, select Options > Delay Logic. This provides access 

to knowledge to account for regeneration having a delay on many ecological sites. All the factors 

that are responsible for regeneration delays are not modeled.  The process that is used instead 

is illustrated in Figure 131. For a set of ecological groups (Eco Group) in the Eastside Region One 

geographic area the system will wait three time-steps before evaluating the fire regeneration 

logic. The original logic with the Eastside zone was developed using decade time steps. In this 

case, the three time steps are decades. If the user changes to making simulations with yearly 

time steps the regeneration delay must be changed to 30 to be consistent with the original logic. 

 

 

 
Figure 131 Regeneration Delay screen. The time steps have to match yearly or decade time steps used 
in a simulation. 
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10.4.24 Conifer Encroachment 

This is a special case developed for the Eastside Region One zone (Figure 132). 

 

 

 
Figure 132 Choices to access conifer encroachment logic for the Eastside Region One geographic zone. 
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The ecological stratification utilized in the Eastside Region One zone uses habitat types that 

make a distinction between forested and non forested sites. The conifer encroachment logic 

(System Knowledge > Vegetative Process > Conifer Encroachment) allows for the regeneration 

of confers on some of the non forested sites in the absence of fire events. The amount of time a 

plant community has to be free of fire is dependent on the size of the plant community. There 

has to be an adjacent seed source. The pathways for these non forest habitat type groups must 

contain the species that the users want to have the potential to encroach. Similar to the 

regeneration delay, the number of time steps in this logic was designed for decades. If yearly 

time steps are used they must be changed (see Figure 133). 

 

 

 
Figure 133 Logic for conifer encroachment in the Eastside Region One zone. 

10.4.25 Life Form Competition 

To access the Life form Competition screen, select System Knowledge > Vegetative Process > 

Lifeform Competition. With the expansion to include multiple life forms, we had to make an 

initial simplistic way to account for interaction. At this time, we only account for changes in 
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density because of the presence of other life forms. The need to expand this logic will be 

evaluated over time. 

 

 

 
Figure 134 Logic screen to account for changes in density because of interaction between multiple life 
forms. 

10.4.26 Show Zone Processes 

This choice displays the processes that are available within a geographic zone and whether they 

are treated as spreading or not spreading. 

10.4.27 Import Zone Processes 

This choice shows up in certain geographic zones. It no longer serves any purpose for the user. 
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10.5  AQUATIC PROCESS 

Aquatic Process is not functional for any of the geographic zones. 

10.6  VEGETATIVE TREATMENTS 

Treatments within SIMPPLLE are not part of the collection of all possible vegetative states, the 

pathways. This means there are no assumptions made in the system about levels of 

management within these states. Any concept of management emphasis must be created by the 

user by scheduling acres of treatments.  

To represent specific management emphases or scenarios in SIMPPLLE, the user must create 

combinations of schedules of treatments and fire suppression choices. SIMPPLLE can utilize 

treatment schedules developed by other modeling systems such as MAGIS (Zuuring et al. 1995) 

and SPECTRUM (USDA Forest Service 1998) but specific files have to be created for SIMPPLLE to 

use. Treatments affect not only a specific plant community’s attributes but also the pattern of 

vegetation on a landscape, both of which affect future disturbance processes and resource uses. 

New treatments may be added. The conditions that must exist for a treatment to be seen as 

feasible by the system and the attributes that change as a result of a treatment are all part of 

the system logic accessible to the user. 

Treatments are applied at the beginning of a time step, and then the changed plant community 

is evaluated for the probability of a disturbance process. Thus, in any given time step both 

treatments and processes can occur. Often times the coarse level of vegetation description may 

not enable one to capture the difference in changes as a result of the treatment. In this case the 

fact that a treatment was applied can be used by the system to make a difference in other 

events occurring. Each treatment has logic that identifies what conditions have to exist before it 

can be applied, the conditions that are necessary to be feasible, and the logic for the change 

that results. The feasibility logic can include the condition that adjacent plant communities must 

be in. It is possible to schedule treatments for future decades and have disturbance processes 

change vegetation conditions making some treatments infeasible when the system gets to that 

time step. These infeasible treatments are identified within the summary report. It is also 

possible for treatments that are feasible to be “not applied.” These treatments not applied are 

the result of missing information in the “change” portion of the treatment logic. All three 

categories of treatment status are displayed in the report on treatments. Figure 135 is an 

example of treatments from a simulation summary report. 
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Figure 135 Output display for treatments from a simulation. 

 

 

System Knowledge > Vegetative Treatments displays two available choices: Treatment 
Schedule and Treatment Logic. Desired Future Conditions is an option under development that 
will allow the user to specify the desired future vegetation conditions and SIMPPLLE will select 
from a set of user-identified treatments that can compliment disturbance processes over the 
course of a simulation to attain the desired goals. Treatment Schedule is not available until a 
landscape file is loaded. Since the schedule is based on either specific plant communities or 
attributes of communities, a landscape must be loaded first. 
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Figure 136 Access to the treatment schedule and treatment logic in SIMPPLLE. 

 

 

10.6.1 Treatment Scheduling 

Treatment Schedule cannot be accessed until a landscape with specific plant communities has 

been loaded into the system. 

Treatments can be scheduled in three different ways. The user can: 

 specify individual units by treatment type and time step;  

 schedule by attributes specifying an acreage goal for a combination of vegetation 
attributes of ecological stratification, species, size-class/structure, density and let 
SIMPPLLE select the units at each time step; or  

 schedule treatments by probability. The user can specify threshold levels of disturbance 
process probabilities and let SIMPPLLE select the units.  

An advantage of letting SIMPPLLE select units for treatments is that the system does it at the 
beginning of each time step. SIMPPLLE builds the schedule as the simulation is made and takes 
into account the dynamic changes from disturbance processes that SIMPPLLE projects to occur. 
This will result in fewer infeasible treatments than when they are assigned on vegetation 
conditions that exist at the beginning of a simulation. 

At this time, no costs have been associated with any treatment. If the user desires to include 
treatment costs and other resource objectives and constraints as part of the scheduling of 
treatments, SIMPPLLE can be used with scheduling and optimization modeling systems such as 
MAGIS (Zuuring etal. 1995) or costs can simply be applied to the acres shown in the summary 
report. 
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Specifying Individual Units 

Scheduling treatments by specifying individual plant communities can be done both within the 

SIMPPLLE user interface and outside of it. 

Outside of SIMPPLE: 

Working outside of SIMPPLLE is accomplished by creating a separate text file with a text editor 
such as WordPad. If creating a separate text file, the general design of the file is fairly basic, but 
the creator must know which treatments will be applied to which units, and all these choices 
must be written out. Figure 137 is an example of a text file. Notice that it is named with a text 
(*.txt) extension. 

 

 

 
Figure 137 Text file format of treatments scheduled. 

 

 

Within the file, the time step is specified first. In this case it is Time Step 1, followed by the 
treatment type. The units to which the treatments are to be applied are listed beneath it. The 
same pattern would be used to add other time step treatment combinations. Once this file is 
completed, it is opened within the SIMPPLE model under System Knowledge > Vegetative 
Treatments > Treatment Schedule.  
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From the Treatment Schedule window, select File > Load Unit ID File as shown in Figure 138. 

 

 

 
Figure 138 SIMPPLLE screen displaying the choice to Load Unit Id File of treatments to be scheduled that 
has been created outside of the SIMPPLLE user interface. 

 

 

Within SIMPPLE: 

In the Treatment Schedule window, select File > New Treatment. 
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A dialog box opens that provides the treatments that can be selected. Once a treatment is 
selected, another dialog box opens asking for the time step. Figure 139 displays the selection of 
mechanical-thinning for Time Step 1. By default, the number in the Desired Acres field is the 
entire landscape acres. 

 

 

 
Figure 139 Treatment schedule screen that displays the selected treatment choice of mechanical-
thinning. 
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To identify the treatments by entering individual unit numbers, click on the box for Enable 
selection of specific units by id. This activates the Unit Id Selection tab, as shown in Figure 140. 

 

 

 
Figure 140 Main Treatment Schedule screen with the choices made for treatment, time step, and 
selection of specific units by Id. 
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To activate the Unit Id Selection tab, check the Enable selection of specific units by id box. The Unit Id 
Selection screen enables the plant community id values (slink numbers) to be typed in the Unit 
Id box and entered by clicking Add.  

 

 

 
Figure 141 Completed “unit id selection” screen for scheduling treatments within the SIMPPLLE 
interface. 

 

 

To schedule the same process for additional time steps, select File > Copy Current Process. This 

selection changes the screen to have the same process and the same units scheduled, however, 

the time step is blank and the desired time step must be entered.  

Select the Add or Remove Selected button to modify the Unit Ids. 

Repeat the steps to create as many treatments for a time step, or combinations of Time Step, 

Process and Unit Id lists as desired, Prev and Next can be used to move between the 

combinations for additional editing of the Unit Ids. To add a different process, create a new 

combination of the Time Step, Process, and Unit Id lists.  To create a new combination, return 

to the File dropdown menu. After the new combinations are created, and a new simulation is 

ready to be made, select File > Close Dialog.  

To remove the combinations made, or remove combinations to make simulations without them, 

select File > Unload. To remove a combination currently displayed, select File > Remove Current 
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Treatment. To save the treatment schedule for other SIMPPLLE sessions, select File > Save As. 

Saving can be done as soon as all of the combinations have been made, or you can come back to 

this later after you have made simulations and decided you like the results. Selecting Save As 

opens a screen to the working directory you have identified. The system will add the treatment 

(*.treatment) extension to the name you have provided. 

The saved file cannot be viewed or edited outside of SIMPPLLE. To use it again, select File > 

Open. This will load the saved file.   

When some treatments are scheduled they involve a follow-up treatment. The user can 

schedule these (check the box next to Schedule Follow Up Treatment as shown in Figure 142), 

or some are already built into the treatment. In our previous selection of mechanical thinning 

we had a herbicide application added as a follow-up. For those that are part of the original 

designed treatment for a zone, the follow-up will automatically show up. An example is a group 

-selection -cut that is followed by another harvest in the next time step. These follow-up 

treatments can be changed or disabled through the screen for scheduling the treatment (Figure 

142). 

 

 

 
Figure 142 Treatment Schedule screen showing a group-selection-cut treatment that will be followed up 
in the next time step by another group-selection-cut treatment. 

 

 

Schedule by Identifying Attributes 

Instead of trying to identify all the individual units, you may want to apply treatments to a type 
of condition such as commercial thinning the lodgepole pine stands that are medium in size and 
at the highest density levels. The user has the option of specifying a desired level of acres for 
treatment. In this case SIMPPLE will decide where to apply the treatment to try and achieve the 
acreage specified. The advantage of having SIMPPLLE look for the units that meet the attribute 
conditions is that it does it at each individual time step. The schedule is not built for all time 
steps based on starting conditions, but takes into account the conditions at the start of each 
time step. In other words, the disturbance processes that are changing the landscape have an 
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impact on what is scheduled. The units that meet the attributes specified at the start of each 
time step are put in a list and SIMPPLLE sequentially selects from this list till it meets your 
acreage goal. Additional selection criteria can be added in a future version if they are requested 
by users. 

Figure 143 is an example of the activated Attribute Selection tab. 

 

 

 
Figure 143 Screen within the “Treatment Schedule” with the choices made to activate the “Attribute 
Selection” screen to provide the information to enable SIMPPLLE to select units for treatment 
application. 
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In Figure 144, under Chosen Items, three habitat-type groups (Ecological Grouping), some 
combinations of lodgepole pine species (Species), size classes of medium and above (Size Class), 
the highest two density classes (Density), plus an additional requirement that the units have had 
a previous process of light mountain pine beetle in them (Processes) have been identified to be 
potentially selected for treatment. 

 

 

 
Figure 144 Combinations of attributes that have been identified to provide SIMPPLLE the basis for 
selecting units for treatment assignment. 

 

 

An upper limit of 5000 acres has been set in Figure 143; however, no limits by ownership or 
special areas within the landscape are set. 
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Time Selection by Probability 

The choice of this attribute (the grayed-out Enable selection of process probability) to schedule 

treatments involves making multiple simulations to create a probability file and using these 

probabilities to let the system guide the selection of units to treat. This choice is currently not 

functional. 

Prevent Retreatment  

To activate this choice, check the box next to Prevent re-treatment of system chosen units in 

next (n) time steps (1).  This enables the user to enter a value for n. Some treatments may make 

minor changes in attributes such as a precommercial thinning that only lowers the density or, 

for a low-density class to begin with, may not make any change in the attributes at all. In this 

case on the basis of the attributes, the plant community may be seen as feasible for the same 

treatment in the next decade (depends on what the treatment schedule calls for). By use of this 

feature, the user can prevent the plant community from being repeatedly treated on too short 

of a cycle. 

View/Order Treatments 

A treatment schedule can be created by any combination of these choices for scheduling. 

Total treatments can be scheduled from the Treatment Schedule screen.  Select Utilities > 
View/Order Treatments. All the treatments for a time step are shown. Prev and Next can be 
used to move through the schedule for all time steps. If multiple treatments may apply to plant 
communities with the same attributes, the treatments can be ordered by priority. Figure 145 is 
an example of a set of treatments for Time Step 1. The three columns to the right are the acre 
goal, the special area field, and the road status field. Reordering the treatments is done by 
selecting and dragging with the mouse. 
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Figure 145 The treatments scheduled for Time Step 1. The order can be changed to represent a priority 
for SIMPPLLE. The system starts at the top of the schedule. 

10.6.2 Treatment Logic 

To access the treatment logic screen, select System Knowledge > Vegetative Treatments > 
Treatment Logic. 

The Treatment Logic screen is designed to provide the user with two capabilities: identify the 
conditions under which the treatment is feasible or infeasible, and identify changes in the plant 
community attributes that result from the treatment. Changes can be used for the duration of 
the simulation session, or they can be saved in a file that can be reloaded in future sessions. The 
user has the ability to create a treatment that does not currently exist. 

Within the Treatment Logic screen, the Current Treatment pulldown menu allows the user to 
select a treatment. In Figure 146, MECHANICAL-THIN is selected. The Feasibility tab is active. Six 
items can be used to define the feasibility of this treatment. In this example (Figure 146), we 
have the two attributes of species and size class that have specific values that must be met to be 
feasible. In the middle of the screen the AND radio button is selected, meaning both conditions 
have to be met. The Species tab is selected showing that a vegetation community has to be one 
of the listed species. 
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Figure 146 Feasibility screen for the Mechanical-thin treatment showing the species that have to exist 
to be feasible. 

The Size Class tab (selected in Figure 147) displays the values that the size class must be. 

 

 

 
Figure 147 Feasibility screen for the treatment of mechanical-thin showing the size classes that have to 
exist to be feasible. 
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Figure 148 displays one of the change rules for the effects of mechanical thinning. This rule is for 
Size Class and shows that if the treatment is applied to a medium multi-story (MMU) 
community, the resulting change will be to a MEDIUM Size Class. 

 

 

 
Figure 148 The change rule for the change in size class that mechanical-thin makes to a MMU plant 
community. 
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Figure 149 displays the rule for the large multi-story (LMU) size class. The change is to a single 

story, LARGE Size Class. 

 

 

 
Figure 149 Change rule for mechanical-thin treatment for the LMU size class. 

 

 

Notice there is no MEDIUM OR LARGE specified in these rules. They could have been in both 
rules, but if not specified, no change is made by the system. As one progresses through the rules 
for change, there is no rule for species. Without a rule, no change is made. For the 
MECHANICAL-THIN treatment, no change in species composition will be made. 
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Figure 150 shows the change to the Density attribute and the rule associated with it. 

 

 

 
Figure 150 Change rule for density for the mechanical-thin treatment showing densities 2, 3, and 4 all 
go to level 1. 
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Figure 151 shows a Species change rule for a treatment. 

 

 

 
Figure 151 Species change rule for the ecosystem management thin and underburn treatment showing 
the removal of the more tolerant understory species from Douglas-fir mixtures. 

 

 

An entire state (“To State Item”) can be changed (“To State”) in addition to showing the 

treatment change individually by one of the vegetation state attributes of species, size class or 

density.  The To Function Call tab is a third way to represented change. Figure 152 shows the 

use of the TypeOfFireNextState function call. 
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Figure 152 Change rule for a treatment showing the use of the Function Call to identify the state 
following the treatment. 

 

 

A limited number of functions have been developed for specific cases and are available to use 

with both the feasibility and change logic. To see the available choices, use the pull-down arrow 

on the right of the function name slot. The description is given in the text box below as seen in 

Figure 152 for the “TypeofFireNextState” function. New function calls cannot be created by the 

user in version 2.5. 

10.7  AQUATIC TREATMENTS 

This choice is not functional for this version. 
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10.8  REGIONAL CLIMATE 

System Knowledge > Regional Climate is a simplified way to account for the variability that can 
result from time steps that have different weather conditions. SIMPPLLE uses two variables, 
temperature and moisture. Temperature selections are COOLER, NORMAL, or WARMER. 
Moisture selections are WETTER, NORMAL, or DRIER. Figure 153 represents an approach used 
in simulating Mesa Verde National Park. From precipitation records for the park, the years 1950 
to 1970 were selected and the standard deviation was calculated for this period. A sequence of 
normal, drier, or wetter was assigned based on a year beginning within, above, or below one 
standard deviation of the mean precipitation for this period. This sequence of the moisture 
component of the regional climate was utilized in simulations. 
 
 

 
Figure 153 Calculation of a sequence of moisture for the regional climate variable using past 
precipitation records from Mesa Verde National Park. 
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Many processes can have their behavior modified by the Regional Climate. Version 2.5 includes 
these two variables in the columns that can be selected for all logic screens. 

When loading a previously saved system knowledge file, a similar screen is available. The user 

can choose to load all or just parts of what was put in the saved system knowledge file. 

10.9  OPEN USER KNOWLEDGE FILE—SAVE USER KNOWLEDGE FILE 

See the general comments within the “System Knowledge” section. 

10.10  RESTORE ALL DEFAULTS 

System Knowledge > Restore All Defaults will restore all of the system knowledge to the default 

values for the geographic zone. This has the same effect as reloading the current zone. 
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11. UTILITIES 

Utilities (Figure 154) contains a variety of features, some that have been briefly covered in other 

sections. This section provides a more complete discussion of each choice. These features have 

been developed as a need has been identified over a number of years. Some have been 

incorporated into other parts of the system with newer versions of SIMPPLLE. 

 

 

 
Figure 154 Choices under the Utility menu. 

 

 

11.1  CHANGE AREA NAME  

Utilities > Change Area Name provides a dialog box to provide a name for the landscape being 

simulated. This is not the name of the area (*.area) file, but the name will be associated with the 

area file and will be used in a number of screens and reports. This same feature is used to 

provide a name the first time an area file is created through the Import menu. 
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11.2  OPEN UNIT EDITOR  

Utilities > Open Unit Editor is only available when an area file is first loaded, or changes are 

made that result in invalid units. The Open Unit Editor is identical to Edit Units (under the 

Import menu). 

11.3  ELEVATION RELATIVE POSITION 

Default 10 percent difference in elevation (in meters) between a vegetation unit and its adjacent 

vegetation units to determine relative position (ABOVE, BELOW, or NEXT-TO). The user can 

enter a different value if the default is not desired. 

11.4  COMBINE LS FILES  

When a set of multiple simulations is made, one of the basic output files created is the *-ls.txt 

file used with the Excel basic processing macro. Utilities > Combine LS Files has been created for 

a situation where memory constraints do not allow the user to make as many simulations in a 

set as desired. For example, for evaluating the historic range of variability for a landscape, the 

combination of total area and size of units allow only five 100-decade simulations to be made. If 

the desired number of simulations is thirty 100-decade simulations, then six sets of simulations 

can be made. This utility will let the user combine all six “*-ls.txt” files into one for processing. 

11.5  COPY GIS FILES  

Utilities > Copy GIS Files allows the user to move the files that come with SIMPPLLE to a desired 

location (Figure 155). 

 

 

 
Figure 155 Dialog box for copying GIS files. 
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Copy Coverage for Sample Area, Copy ArcGIS Geodatabase for Sample Area, and Copy ArcInfo 

Interchange File for Sample Area are no longer functional. As the number of geographic zones 

increased, these became too large to automatically include in the installation. If one wants to 

work with the sample areas a separate download exists on the website for these GIS files 

(http://www.fs.fed.us/rm/missoula/4151/SIMPPLLE/downloads.html). 

11.6  EXPORT PATHWAYS  

Utilities > Export Pathways prompts the user to provide a file location and a name for SIMPPLLE 

to export a text file of all of the allowable species/size/density assignments by habitat group. 

11.7  DELETE UNITS  

Utilities > Delete Units provides a way to delete units without having to go back to the GIS 

environment. It also removes these units as neighbors in associated vegetation units. These 

changes are not permanent unless the user selects File > Save Landscape. 

11.8  MAKE AREA SIMULATION READY  

Utilities > Make Area Simulation Ready will take the vegetation conditions at the end of the 

simulation and make them the starting conditions so a simulation could begin with these new 

values. The disturbance processes in the last time step are also kept as Time Step 0 processes, 

giving the plant communities a one time-step history to start with. 

This choice is often used in using SIMPPLLE to help quantify historic conditions. A very long 

simulation, 1000 years, can be made without fire suppression. The end results can then be made 

the starting point for a set of multiple simulations to help quantify a range of historic conditions. 

11.9  CHANGE AREA TO MULTIPLE LIFE FORMS  

In order to utilize the Tracking Species option for modeling invasive species, the area file must 

use the multiple life form method for describing plant communities. If an area file was not 

created with multiple life forms, this choice will make the system interpret the file as having 

multiple life forms. No additional life forms will actually be added except when the system 

predicts the occurrence of an invasive species that will show up as a tracking species. 

11.10  STAND DESCRIPTION UTILITY  

Utilities > Stand Description Utility has not been developed yet. 
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11.11  RESET AREA SIMULATION  

Utilities > Reset Area/Simulation will delete all simulation results and leave the landscape file as 

it initially existed. This is automatically implemented if the user starts a new simulation. 

11.12  PRINT CURRENT AREA TO FILE  

Utilities > Print Current Area to File will create a text file listing each plant community and its 

attributes. 

11.13  EXCEL TEMPLATE FILE  

Utilities > EXCEL Template File is no longer functional. It has been replaced by the Excel 

spreadsheets with macros that are available with the installation. 

11.14  MAGIS  

The following choices create files that are utilized in running the MAGIS (Zuuring et al. 1995) 

modeling system: 

Risk Rating 

Utilities > Magis > Risk Rating is not fully developed. The purpose is to have a file that assigns a 

risk value to each vegetation community for each time step. The interpretation of risk would be 

made through an interface screen that utilizes vegetation attributes along with the probabilities 

of disturbances from a set of multiple simulations. 

Process and Treatment Files 

Utilities > Magis > Process & Treatment Files creates two text files (in the dialog box for naming 

the files, make sure you assign a text [*.txt] extension). One file lists all of the treatments in each 

time step by each vegetation unit. The second file lists all of the processes in each time step by 

each vegetation unit. 

All Vegetative States  

Utilities > Magis > All Vegetative States will create one text file that contains all of the 

vegetative states involved in the set of simulations made. 

Examples of using SIMPPLLE and MAGIS together can be found in Jones and Chew (1999, 2000), 

Jones etal. (1999) and Chew etal. (2000).  

  

11.15  DISPLAY CONSOLE MESSAGES  

If the user is having problems executing SIMPPLLE, Utilities > Display Console Messages can 

provide information that can be sent to the developers to help identify the problem. 
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11.16  CHANGE JAVA HEAP SIZE  

Utilities > Change Java Heap Size is discussed under Memory Management. It allows the user to 

match the maximum Java Heap size to the memory available on the computer in use. 

11.17  DATABASE MANAGER  

Utilities > DatabaseManager starts up a utility that comes with HSQLDB for working with the 

database. It allows running queries and writing the results out to a delimited text file. We have 

not developed any capabilities with the database yet. 

11.18  MEMORY USE DISPLAY  

Utilities > Memory Use Display opens a window that will show the memory use as a simulation 

is being made. This memory use has also been recently added to the message at the bottom of 

the SIMPPLLE screen that displays the status of the simulation. 

12. MAPPING SIMULATION OUTPUT  

SIMPPLLE version 2.5 is designed to work with ArcGIS 9. In addition to the SIMPPLLE toolbox for 

processing input, an Extension is provided to map the simulation results. The ArcView project 

file, which was customized for use with earlier versions, is still included with the installation. The 

instructions for both are included. 

12.1  ARCVIEW PROJECT 

Locating the ArcView Project file and legend files: 

1. Startup up SIMPPLLE. 
2. Choose a zone. 
3. Go to the Utilities > Copy GIS Files. 
4. Select Copy Arcview files. 
5. Next you will be presented with another file dialog.  

Simply change to the directory where you want the files to be saved and press Ok. 
(legend files have a .avl filename extension).  

Opening the SIMPPLLE Project File: 

1. Start ArcView GIS 3.2. 
2. Open the project file simpplle_arcview.apr. 
3. This will result in a small dialog being displayed which will ask for two directory 

pathnames. 

Project Pathname: The directory containing output from SIMPPLLE (i.e., the .txt files). 
Data Pathname:  The directory containing the project file you just opened as well as all of 

the necessary legend files. 
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Note that all pathnames should have a forward slash (/) at the end. Remember, the pathways 

names are different for a PC and a UNIX platform. 

The Three types of SIMPPLLE Displays: 

1. Display Current Processes, Species, Size Class, Canopy Coverage, and Treatments. 

 This display will show the processes (for example) on the theme map in different colors. 

 The color scheme is defined in the legend files you moved using SIMPPLLE for use with 
the ArcView project. 

The files <data prefix>-#.txt are used with this display 
Where <data prefix> is the name you provided when saved GIS files with SIMPPLLE (e.g. stevi- ) 

 Where # represents a time step number (i.e. 0,,1,,2, ...) 

 There will be one file for each time step in the simulation plus a zero time step file which 
has initial conditions. 

 This display allows for easily changing to different time steps. 

 There is also the option of producing a chart with this display type. 
2. Display probability (frequency of occurrence) for Processes, Species, Size Class, and Canopy 
Coverage. 

 This display shows probability information for a particular Process, Species, Size Class, or 
Canopy Coverage. 

 The information is shown via colors that correspond to pre-defined ranges of 
probabilities. 

 The color scheme and probability ranges are defined in the legend files you moved using 
SIMPPLLE for use with the ArcView project. 

The files named <data prefix>-process.txt, <data prefix>-size.txt, <data prefix>-canopy.txt, <data 
prefix>-species.txt are used with this display. 
Where <data prefix> is the name you provided when saved GIS files with SIMPPLLE (e.g. stevi- ) 

 This display type allows for easily changing the field for which probability information is 
currently displayed. 

3. Display Process Spreading for each time step. 

Recommendations Concerning Views and Themes 

The Avenue scripts written for this project have been designed to allow multiple themes in a 

given view. However, it is recommended that only themes of the same type be displayed in a 

given view. For example try not to place a theme showing spread in the same view as a theme 

showing probability. This will work, however, the title of the view typically carries information 

on the current time step. This information could be erased should a theme be added to show 

probability after a theme showing spread in the same view. 

Aside from the above, a view can have as many themes as desired. For example, one could add a 
theme for a few different spreading processes and make the color transparent. 
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Figure 156 SIMPPLLE ArcView Project displaying processes for the second time step. 

 

 
Figure 157 Choices under the Theme Menu that serve specific functions in the SIMPPLLE project file. 

 

 

Figure 157 displays options from the Theme drop down menu. The items function as follows: 

Toggle Outlines (F6) toggles the display of polygon outlines on and off. By default, all of the 
legends for use with SIMPPLLE have the polygon outlines turned off. 

Set Simpplle Attribute (F12) is used with the SIMPPLLE Display and the Probability Display. 

This option displays a list of attributes to view for a particular theme: Process, Species, Size 

Class, Canopy Coverage, or Treatment. Treatment is not available for use with the Probability 
Display. Set Simple Attribute must be set in order to run the Simpplle Display or Probability 
Display setups. 

Set Probability Field (F11) is used to choose which field to display probabilities for the 
currently selected theme. For example, if Process is chosen for the SIMPPLLE attribute, 
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then this would display a list of processes for the display of probabilities. Note: This is 
only used to change the field to a different one than chosen during probability setup. 
Set Spread Field (F9) is used to choose which Process to use in the spread display for the 
currently selected theme. This is only used to change the process field to a different one than 
chosen during spread setup. 
 
 

 
Figure 158 Choice of customized buttons in the SIMPPLLE ArcView project file. 

 

 

Figure 158 shows all of the view buttons within the ArcView GIS Version 3.0 screen that are 
currently used for SIMPPLLE.  

 

The  button will zoom all displays to the same extent as the currently selected view. For 
example, if you zoom in to a particular set of polygons in one view, pressing this button will 
zoom all of the other views to the same area. 

 

 

 
Figure 159 The set of buttons used to display attributes by time-steps. 

 

 

Figure 159 shows the set of buttons used in displaying current information on processes, 
species, size-class, canopy coverage, and treatments by time steps. 

From left to right: 
Button 1: 

This moves the display of the all themes with this type of display back to the first loaded 
time step. 

Button 2: 
This moves the display of all themes with this type of display back one time step. 

Button 3: 
This is the setup button for this display type. Pressing it will display the Display Setup 
dialog box in Figure 160: 
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Figure 160 Dialog box for information required to display time steps. 

 

 

The dialog shown in Figure 160 is used to get information needed to create the display for time-
steps. 

SIMPPLLE Run Name: 
The prefix used in saving GIS Files in SIMPPLLE. 

TXT files: 
The directory where the SIMPPLLE output files are located. 

Starting Time Period and Ending Time Period: 
Enter the first and last time steps you wish to load. 

Produce a graph: 
Enter 'y' if you would like to produce a chart to summarize the displayed info. 

Continuous Display: 
Enter 'y' to load all of the time steps without being asked if you would like to 
load the next time step. 

Button 4: 
Same as button 2, except it moves forward one time step. 
 
 

 
Figure 161 Buttons for the display of a process spread. 

 

 

The set of buttons shown in Figure 161 controls the display of Process Spread. 

From Left to Right: 

Button 1: 
This  moves the display of the selected theme back to the first loaded time step. 

Button 2: 
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This moves the display of the selected theme back one time step. 
Button 3: 

This is the setup button for this display type. Pressing it will display the dialog in Figure 
65. 
 
 

 
Figure 162 Dialog box for information needed for display of process spread and origin. 

 

 

The dialog in figure 162 is very similar to that used for the time step information. The 
data requirements are identical. 

Button 4: 
This is the same as button 2, except it moves forward one time step. 
 
 

 
Figure 163  This Button Display the setup dialog for Probability Displays. 

 

Use the button in Figure 163 to bring up the Display Setup dialog box (Figure 164) to provide 
information required to display probability maps. 

 

 
Figure 164 Dialog box for information required for probability map displays. 
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The following information is required for the probability displays. 
SIMPPLLE Run Name: 

This is the prefix used in saving GIS Files in SIMPPLLE. 
TXT files: 

This is the directory where the SIMPPLLE output files are located. 
 
 

 
Figure 165  Button for exporting the current theme to a new cover. 

 

 

The button in Figure 165 allows you to export the currently selected theme to a new coverage. 
Upon clicking this button, you will be presented with a file dialog asking for the output location 
and coverage name. 

 
Figure 166 Button to return a selected theme(s) to the starting state. 

 

 

The button in Figure 166 allows you to return a selected theme(s) to the state they were in 
when they were first added to a view. Specifically, it sets the themes ProjectTag to nil and 
executes an UnJoinAll on the theme table. This button will need to be used on a theme if the 
theme is currently showing one type of SIMPPLLE display and you wish to use this theme to 
display a different type of display. For example if a theme is currently showing spread and you 
wish to display probability information in this theme, it will be necessary to use this button first 
on the theme. 

Step by Step Walk-through of Displaying SIMPPLLE data in ArcView 

For this example, assume the following: 

1. A simulation has been made for 5 time steps. 
2. GIS output files with the prefix of test- have been created. 

SIMPPLLE has been used to copy the Arcview project file and necessary legend files to the 
following location: C:/work1/gisdev 
GIS output files are in the following location: C:/work1/gisdev. (Keep in mind this need not be the 
same directory as in #3).  
We wish to look at the processes occurring in our area for each of the time steps. 

Step 1:  Starting ArcView  
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Once ArcView is started, a window similar to Figure 167 will appear. 

 

 
Figure 167  Dialog box for opening a new project file. 

Step 2:  Opening the SIMPPLLE Project file 

Within the ArcView GIS menu, select File > Open Project. This will bring up the Open Project 

screen (Figure 168). Select the project file from the appropriate directory and click OK. 

 

 

 
Figure 168  Dialog box for locating project files. 
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Step 3:  Providing the Data and Project Pathnames  

The selection of a project file will bring up the Simpplle Pathnames dialog box (Figure 169). 

 

 

 
Figure 169  Dialog box for identifying pathnames for SIMPPLLE project. 

 

 

The Data and Project pathnames can then be entered. Project Pathname is where the output 
from SIMPPLLE is stored (i.e., the text (*.txt) files). Data Pathname is where the legend files and 
the project file you just opened are stored. 

Note: A forward slash (/)must be included at the end of a pathname. 
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Step 4:  Creating a New View  

After completing Step 3 you should see a window similar to Figure 170.  

 

 

 
Figure 170 Basic opening screen for the SIMPPLLE project. 

 

 

Click the icon with a picture of Earth labeled Views. 

Next, click New. This will result in a window similar to Figure 171: 
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Figure 171  Display for adding a new view. 

 

 

Step 5:  Adding a Theme to the View 

After successfully completing Step 4, make sure the new view is active by clicking on its window. 

The button with a plus sign (top row, second from left) is a shortcut to add a theme to a view 

(Figure 172). View > Add Theme... can also be used. 

 

 

 
Figure 172  Display for adding a theme. 
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Navigate to the directory containing the coverage associated with the landscape run in 
SIMPPLLE, select it, and press OK. You will now have a theme in the new view. Click on the small 
button next to the theme name. This will draw the theme in the window (Figure 173).  

 

 

 
Figure 173  Display of plant community coverage added to the view. 
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Step 6:  Setting the Simpplle Attribute 

To set the Simpplle Attribute, make sure the new theme is selected in the view by clicking it. 

Press the F12 key, or select Theme > Set Simpplle Attribute (Figure 174). 

 

 

 
Figure 174  Display for selecting the attribute to show. 

 

 

This will bring up The List of Simpplle Attributes screen (Figure 175). 
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Figure 175  Choice of attributes to display. 

 

 

Select process (as indicated in Figure 175) and click OK. Your view window will be similar to 
Figure 176. 

 

 

 
Figure 176  View with the process attribute selected. 
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Step 7:  Running the Simpplle Setup 

To run the Simpplle setup, press the Running Man button shown in Figure 177. 

 

 

 
Figure 177  Customized button for displaying attributes by time step. 

 

 

Upon pressing the button you are presented with the following dialog: 

 

 

 
Figure 178  Dialog box for providing information needed to display attribute by time step. 

 

 

In Figure 179, the information shown in the dialog is correct; however, when you run the setup 

the information will undoubtedly be different. Assuming the information entered is correct, the 

Avenue Script will now start joining the “*.txt” files for each time step with the theme's table 

using the Slink field to join them. Upon completion, this will load the legend appropriate for the 

Simpplle Attribute chosen to display, in this case Processes (Figure 179). 
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Figure 179  View with processes displayed for the third time step. 

 

 

Step 8:  Moving to a different time step 

Moving to a different time step Can be achieved by pressing either the back (<<) or forward (>>) 

buttons shown in Figure 180. 

 

 

 
Figure 180  Customized button to move from one time step to another. 

 

 

The Back (<<) Button moves back a step. 
The Forward (>>) Button moves forward a step. 
Alternatively, the first button (left to right) in the above picture will take you to the first loaded 
time step, which in this example is Time Step 0. 

Additional features of the customized ArcView project are given in Exercise 2 and 3. 
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12.2  ARCGIS EXTENSION 

In addition to the SIMPPLLE toolbox that has to be added to the ArcGis environment (see section 
on Spatial Attributes) the user has to enable two other features in ArcMap. When SIMPPLLE is 
installed, the SIMPPLLE extension and SIMPPLLE toolbar are automatically added, but they must 
be enabled. To first enable the extension from the main menu in ArcMap select Tools > 
Extensions. This brings opens up the Extensions window (Figure 181) in which ArcGIS SIMPPLLE 
Extension must be checked. 
 
 
 

 
Figure 181  Selection that must be made to enable the SIMPPLLE extension. 
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To enable the SIMPPLLE toolbar for this extension, from the Untitled - ArcMap - ArcInfo screen, 
select View > Toolbars and click in the box SIMPPLLE Toolbar to enable it (Figure 182). 

 

 

 
Figure 182  Choices that must be made to enable the SIMPPLLE toolbar. 

 

 

When using the GIS extension you have to remember that different types of GIS files are created 

for single and multiple simulations. A single simulation will create (if you specify it in the 

simulations parameters) files that show an update of all the vegetation attributes and 

disturbance process occurrence for each time step and a spread file that shows the origin and 

spread of certain disturbance processes for each time step. 

For multiple simulations, the only GIS files automatically created are probability files. There are 

probability files for each attribute and the processes for each time step and for the entire 
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simulation. If you specify in the simulation parameters that you want the update and spread 

files they will be generated and put in a separate directory for each simulation in the set. 

Usually, one does not specify the update and spread files at the time multiple simulations are 

made. The result would usually be far more files that one wants or needs. Instead, if after 

analysis using the probability files one wants to have a representation of an individual 

simulation, any number of the saved simulations (*.simdata) files can be reloaded and the GIS 

update and spread files created. All of this has a bearing on the extension in that you end up 

with two types of files in different directories. You can create an extension to display the 

probability files and/or an extension to display the update and spread files for an individual 

simulation. If you want an extension with both, it is best to make it by moving the update and 

spread files into the directory with the probability files and then using the SIMPPLLE GIS 

PreProcess tool.  

Before running the GIS PreProcess tool, the default layer (*.lyr) files that the extension will use 

must be in a directory that you want. Initially, the default files can be downloaded from 

SIMPPLLE by going to Utilities > Copy GIS Files. Uncheck Copy Arcview Files, and leave the Copy 

ArcGIS Files checked (Figure 183). Next, provide a Destination Directory.  

 

 

 
Figure 183  Choice to download the *.lyr files for the ArcGIS extension. 

 

 

All of the layer files begin with the prefix “sim_.” The system looks for the probability layer filed 

named “probability_legend.lyr.” Until the next release of SIMPPLLE the probability file must be 

manually edited to drop the “sim_” prefix.  If this is not completed, later in the process you will 

get an error message that the probability layer file cannot be found. 
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Once the layer files are in the desired location and the simulations have been made, the next 

step is to select the SIMPPLLE GIS PreProcess from the SIMPPLLE toolbox (Figure 184).   

 
Figure 184  The SIMPPLLE GIS PreProcess tool. 

 

 

This creates a geodatabase that combines the polygon layer feature class with the text files that 

are the SIMPPLLE output. The initial screen that comes up just mentions update and spread files, 

but it will load the probability files if that is what is in the “SIMPPLLE Files Directory” (Figure 

185). It will load all the files with the prefix name used in the simulation. 
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Figure 185 Specifying the location of the GIS *.txt files that were the output from a single or set of 
multiple simulations. 
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It is essential that you use the correct vegetative feature class as specified in the help screen 

(Figure 186). This must be the vegetation polygons in the feature class that was the result of 

running SIMPPLLE Spatial Relations. 

 

 

 
Figure 186 Specifying the vegetation feature class. 

 

 

If you do not want to bring in all of the time steps, you can limit these by using the optional 

fields for beginning and ending time step. If left blank, all time steps will be used. Figure 187 will 

be displayed, showing the status of the process. 
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Figure 187  Status display for the PreProcess tool.  

 

 

This tool creates a new geodatabase that has the original vegetative polygons plus all the 

imported tables. If the extension has been enabled and the SIMPPLLE toolbar added, the 

ArcMap screen will display it as shown in Figure 188. 
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Figure 188 The SIMPPLLE toolbar. “SIMPPLLE Properties” only shows up when the cursor is placed on 

the “text” symbol. 

 

Placing the cursor on the small symbol for SIMPPLLE Properties will open the initial window of 

the extension (Figure 189). 

 

 

 
Figure 189 Information required in the SIMPPLLE properties dialog box. 
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The spatial data in this case is the new geodatabase that was created with the PreProcess tool. 

Upon completing all the fields it may take a few minutes to execute depending on the number 

of GIS files being loaded. 

The ArcMap screen will then load the geodatabase and display the landscape. The display works 

best by change the feature class symbol so boundaries are not marked with a separate color for 

the polygons. 

Make extension choices on the pulldown arrow within the boxes at the top of the screen (Figure 

190). The first pulldown (highlighted in Figure 191) gives a choice of Update, Spread, or 

Probability. The choices available depend on what files were in the directory that was specified 

in the PreProcess tool. The second provides the choice of sim_Species (simulated species), 

sizeclass, density, process, treatment, or probability. The third pull-down choices are 

dependent upon the first two. With Update chosen, the attribute of sim_Species at Time Step 0 

(the initial pre-simulation conditions) is displayed. 

 

 

 
Figure 190  SIMPPLLE extension display of species for Time Step 0. 

The arrows on either side of time step display can be used to move through the simulation 

(Figure 191). If you have loaded in probability files from multiple simulations the choices for any 
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given attribute or disturbance process will be for an individual time step or across all time steps, 

the entire simulation, which is the “n” choice in the time step pulldown. 

 

 

 
Figure 191 Pulldown showing choice of time steps for probability, or “n” for the entire simulation. 

 

 

If only single simulations are made, then the only files to load are the update and spread files, 

and the extension does not have the probability choice. If a set of multiple simulations is made 

and either you did not check to create GIS update and spread files or you did but only loaded 

the probability files in using the PreProcess tool to make your extension, the only choice is for 

probability. If you now want to look at some update and spread files you have two choices. It is 

possible within an extension to open up the “SIMPPLLE properties” dialog box and identify a 

directory that contains the update and spread files. You can identify the spatial data as the new 

geodatabase created for this extension. However, the method that ArcGIS uses to load the new 

files into the geodatabase will take a very long time (hours). It will eventually work, but the 

recommended approach is to go back to the PreProcess tool. We recommend moving the 

update and spread files (along with the *.sinfo file) into the same directory that the probability 
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files are in. Then when the PreProcess is run again using the feature class in the geodatabase 

made with the previous extension, all of the choices: update, spread and probability will show 

up.  

It is possible to leave the files in separate directories by the second execution of the PreProcess 

identifying the directory location of the update/spread files and the geodatabase with the 

probability file already loaded. This will get them all in the same geodatabase, but one would 

have to run the SIMPPLLE properties each time you wanted to switch between probabilities and 

updates/spread. 

13. SYSTEM REQUIREMENTS 

System Requirements: 

 Java Runtime Environment version 1.5 (included in downloads) 
 Windows (Uses Java 1.5 included in download) 

2GB Memory (areas with large numbers of vegetation units, or includes land and aquatic 
units will require more memory) 

 Will probably run on any processor but faster is always better. 
 Known to work on:  Win XP, Vista, and Mac OS X 
 
 ArcGIS 9 Software (recommend 9.3 or higher) 

14. SYSTEM DOCUMENTATION 

This user’s manual can be accessed by selecting Start > All Programs > SIMPPLLE > Application 

Folder > doc or downloaded from the SIMPPLLE web site: 

http://www.fs.fed.us/rm/ecology/publications/simpplle/SIMPPLLE-MANUAL-2-5.pdf.  

There is additional documentation located at the directory structure identified: 

“C:\fsapps\fsother\SIMPPLLE\version2_5\doc”.    

This is a “Release Notes.pdf.” This file contains developer’s notes on the changes made in 

developing this version. 
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16. APPENDICES 

The following appendices provide a limited amount of information on each geographic zone. For 

all zones we provide a listing of the valid values for the attributes for SIMPPLLE. Some zones 

have a limited discussion on the system knowledge components.  
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16.1 APPENDIX A—FOREST SERVICE REGION ONE—WESTSIDE AND 

EASTSIDE  

The initial development of SIMPPLLE was done for the two Region One geographic zones: west 

and east of the Continental Divide. Thus, there is more documentation of the system knowledge 

than with some of the other geographic areas. Both of these original geographic zones were 

developed for single life form description of the vegetation. 

Ecological Stratification 

The habitat type classification system in use by the Region provided the basis for an ecological 

stratification of system knowledge. 

 

ht-grp Description Habitat type ADP code R1_PVT 

A1 hot & very dry pifl/agsp 91 pifl 

  pifl/feid 92 pifl 

  pifl/feid-feid 93 pifl 

  pifl/feid-fesc 94 pifl 

  pifl/juoc 95 pifl 

  pipo/and 110 pipo 

A1 hot & very dry psme/syor 380 psme2 

A2 warm & very dry pipo/agsp 130 pipo 

  pipo/feid 140 pipo 

  pipo/feid-feid 141 pipo 

  pipo/feid-fesc 142 pipo 

  pipo/putr 160 pipo 

  pipo/putr-agsp 161 pipo 

  pipo/putr-feid 162 pipo 

  psme/agsp 210 psme1 

  psme/feid 220 psme1 

  psme/fesc 230 psme1 

  psme/syal-agsp 311 psme2 
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ht-grp Description Habitat type ADP code R1_PVT 

  psme/caru-agsp 321 psme1 

A2 Warm & very dry psme/juoc 360 psme1 

B1 warm & dry pipo/syal 170 pipo 

  pipo/syal-syal 171 pipo 

  pipo/syal-bere 172 pipo 

  psme/caru 320 psme1 

  psme/caru-aruv 322 psme1 

  psme/caru-caru 323 psme1 

  psme/caru-pipo 324 psme1 

  psme/cage 330 psme1 

  psme/aruv 350 psme1 

B1 warm & dry psme/arco 370 psme1 

B2 modwarm & dry pipo/pruvi 180 pipo 

  pipo/pruvi-prvi 181 pipo 

  pipo/pruvi-shca 182 pipo 

  pipo/phma 190 pipo 

  psme/phma 260 psme2 

  psme/phma-phma 261 psme2 

  psme/phma-caru 262 psme2 

  psme/phma-smat 263 psme2 

  psme/vagl-aruv 282 psme2 

  psme/syal  310 psme2 

  psme/syal-caru 312 psme2 

  psme/syal-syal 313 psme2 

  psme/spbe 340 psme1 

  picea/phma 430 picea 
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ht-grp Description Habitat type ADP code R1_PVT 

  abgr/spbe 505 abgr1 

  abgr/phma  506 abgr1 

  abgr/phma-cooc 507 abgr1 

B2 modwarm & dry abgr/phma-phma 508 abgr1 

Table A-1 Habitat type groups A1 thru B2. 

 

 

ht-grp Description Habitat type ADP code R1_PVT 

B3 warm & modmoist psme/vaca 250 psme1 

  psme/vagl 580 abgr2 

  psme/vagl-vagl 281 psme2 

  psme/vagl-xete 283 psme2 

B3 warm & modmoist psme/libo-caru 292 psme2 

C1 modwarm & modmoist psme/libo  290 psme2 

  psme/libo-syal 291 psme2 

  psme/libo-vagl 293 psme2 

  abgr/xete 510 abgr2 

  abgr/xete-cooc 511 abgr2 

  abgr/xete-vagl 512 abgr2 

  abgr/vagl 515 abgr2 

  abgr/clun-xete 523 abgr2 

  abgr/libo 590 abgr2 

  abgr/libo-libo 591 abgr2 

C1 modwarm & modmoist abgr/libo-xete 592 abgr2 

C2 modwarm & moist abgr/asca 516 abgr2 

  abgr/asca-asca 517 abgr2 
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ht-grp Description Habitat type ADP code R1_PVT 

  abgr/asca-mefe 518 abgr2 

  abgr/asca-tabr 519 abgr2 

  abgr/clun  520 abgr2 

  abgr/clun-clun 521 abgr2 

  abgr/clun-arnu 522 abgr2 

  abgr/clun-phma 524 abgr2 

  abgr/clun-mefe 525 abgr2 

  abgr/clun-tabr 526 abgr2 

C2 modwarm & moist abgr/setr 529 abgr2 

D1 modcool & moist thpl/clun 530 abgr2 

  thpl/clun-clun 531 thpl 

  thpl/clun-aarnu 532 thpl 

  thpl/clun-mefe 533 thpl 

  thpl/clun-xete 534 thpl 

  thpl/clun-tabr 535 thpl 

  thpl/asca 545 thpl 

  thpl/asca-asca 546 thpl 

  thpl/asca-mefe 547 thpl 

  thpl/asca-tabr 548 thpl 

  thpl/gydr 555 thpl 

  tshe/gydr 565 tshe 

  tshe/clun 570 tshe 

  tshe/clun-clun 571 tshe 

  tshe/clun-arnu 572 tshe 

  tshe/clun-mefe 573 tshe 

  tshe/clun-xete 574 tshe 
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ht-grp Description Habitat type ADP code R1_PVT 

  tshe/asca 575 tshe 

  tshe/asca-arnu 578 tshe 

  tshe/asca-mefe 577 tshe 

D1 modcool & moist tshe/asca-asca 578 tshe 

Table A-2 Habitat type groups B2 through D1. 

 

 

 

ht-grp Description Habitat type ADP code R1_pvt 

D2 modcool & modmoist picea/sest 460 picea 

  picea/sest-psme 461 picea 

D2 modcool & modmoist picea/sest-picea 462 picea 

D3 cool & moist picea/clun 420 picea 

  picea/clun-vaca 421 picea 

  picea/clun-clun 422 picea 

  picea/libo 470 picea 

  picea/smst 480 picea 

  tshe/mefe 579 tsme 

  abla/clun 620 abla1 

  abla/clun-clun 621 abla1 

  abla/clun-arnu 622 abla1 

  abla/clun-vaca 623 abla1 

  abla/clun-xete 624 abla1 

  abla/clun-mefe 625 abla1 

  abla/caca-vaca 654 abla1 
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  abla/libo 660 abla1 

  abla/libo-libo 661 abla1 

  abla/libo-xete 662 abla1 

  abla/mefe 670 abla1 

  abla/mefe-cooc 671 abla1 

  abla/mefe-luhi 672 abla1 

  abla/mefe-xete 673 abla1 

  abla/mefe-vasc 674 abla1 

  tsme/mefe 680 tsme 

  tsme/mefe-luhi 681 tsme 

  tsme-mefe-xete 682 tsme 

  tsme/clun 685 tsme 

  tsme/clun-mefe 686 tsme 

  tsme/clun-xete 687 tsme 

  abla/vasc-thoc 733 abla2 

D3 cool & moist abla/alsi 740 abla1 

E1 modcool & wet thpl/atfl 540 thpl 

  thpl/atfl-adpe 541 thpl 

  thpl/atfl-atfl 542 thpl 

  thpl/opho 550 thpl 

E1 modcool & wet thpl/adpe 560 thpl 

Table A-3  Habitat type groups D2 through E1. 
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ht-grp Description Habitat type ADP code R1_pvt 

E2 cool & wet picea/eqar 410 picea 

  picea/gatr 440 picea 

  abla/opho 610 abla1 

  abla/gatr 630 abla1 

  abla/stam 635 abla1 

  abla/stam-mefe 636 abla1 

  abla/stam-lica 637 abla1 

  abla/caca 650 abla1 

  abla/caca-caca 651 abla1 

  abla/caca-lica 652 abla1 

  abla/caca-gatr 653 abla1 

  abla/caca-legl 655 abla1 

  tsme/stam  675 tmse 

  tsme/stam-luhi 676 tmse 

E2 cool & wet tsme/stam-mefe 677 tmse 

F1 cool & mod dry picea/vaca 450 picea 

  abla/vaca 640 abla1 

  abla/libo-vasc 663 abla1 

  abla/xete 690 abla1 

  abla/xete-vagl 691 abla1 

  abla/xete-vasc 692 abla1 

  abla/xete-cooc 693 abla1 

  abla/xete-luhi 694 abla1 

  tsme/xete 710 tmse 

  tsme/xete-luhi 711 tmse 

  tsme/xete-vagl 712 tmse 
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  tsme/xete-vasc 713 tmse 

  abla/vagl 720 abla1 

  abla/vasc 730 abla2 

  abla/vasc-caru 731 abla2 

  abla/vasc-vasc 732 abla2 

  pico/putr 910 pico 

  pico/vaca 920 pico 

F1 cool & mod dry pico/libo 930 pico 

F2 modcool & mod dry abla/caru 750 abla1 

  abla/caru 770 abla1 

  abla/clps 780 abla1 

  abla/arco 790 abla1 

  abla/cage 791 abla1 

  abla/cage-cage 792 abla1 

F2 modcool & mod dry pico/caru 950 pico 

G1 cold & moist abla/rimo 810 abla2 

  abla/pial-vasc 820 abla2 

  abla/luhi 830 abla2 

  abla/luhi-vasc 831 abla2 

  abla/luhi-mefe 832 abla2 

  tsme/luhi 840 tmse 

  tsme/luhi-vasc 841 tmse 

G1 cold & moist tsme-luhi-mefe 842 tmse 

Table A-4  Habitat type groups E2 through G1. 
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ht-grp Description Habitat type ADP code R1_pvt 

G2 cold & dry pial-abla 850 pial 

  laly-abla 860 laly 

  pial  870 pial 

  pico/xete 925 pico 

G2 cold & dry pico/vasc 940 pico 

NF1 grasslands upland grassland 15 NA 

  sticom 16 drygrass 

  agrspi 17 drygrass 

  fesida 18 fesida 

  fessca 19 fessca 

  androp 20 androx 

NF1 grasslands descae 21 ripgrass 

NF2 shrublands upland shrubland 30 NA 

  artarb 31 bigsage 

  arttri 32 bigsage 

  arttrip 33 bigsage 

  pottru 34 potfru 

  purtri 35 dryshrub 

  cerled 36 dryshrub 

  rhulri 37 rhusx 

  sarver 38 saltshrub 

NF2 shrublands eriogo 39 unknown 

NF3 woodlands upland woodland 50 NA 

NF4 riparian riparian 60 NA 

  carex 61 ripgrass 

  grass 65 ripgrass 
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  tall forb 70 ripforb 

  cartaeg 71 crataeg 

  celtis 72 celtis 

  alnus 73 alnus 

  salix 74 salix 

  poptre 78 poptre 

NF4 riparian poptri 79 poptri 

NF5 alpine alpine 80 alpine 

  alp sedge/grass 81 alpgrass 

  alp forb 84 alpforb 

NF5 alpine alp shrub 87 alpshrub 

XX1 agriculture crop, hay, pasture 4  

XX2 exotics exotics grass/fo 2  

XX3 urban/rural towns, subdiv 3  

XX4 barren rock, scree, ice 10 rock,scree 

XX5 water lakes, reservior 1 water 

Table A-5  Habitat type groups G2 through non-forest. 

 

Vegetation Attributes 

The vegetation attributes were linked to Region One’s vegetation mapping and inventory 

design. 

 

 

Species  Abbreviation Species Names 

AF alpine fir 

AF-ES-MH alpine fir - Englemann spruce - mountain hemlock 

AF-MH alpine fir - mountain hemlock 

AGR agriculture 
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Species  Abbreviation Species Names 

AL alpine larch 

AL-AF alpine larch - alpine fir 

AL-WB-AF alpine larch - white bark pine - alpine fir 

ALPINE-GRASSES alpine grasses 

ALTERED-GRASSES altered grasses 

C cedar 

CW cottonwood   

CW-MC cottonwood - mixed conifers 

DF Douglas-fir 

DF-AF Douglas-fir - alpine fir 

DF-ES Douglas-fir - Englemann spruce 

DF-GF Douglas-fir - grand fir 

DF-LP Douglas-fir - lodgepole pine 

DF-LP-AF Douglas-fir - lodgepole pine - alpine fir 

DF-LP-ES Douglas-fir - lodgepole pine - Englemann spruce 

DF-LP-GF Douglas-fir - lodgepole pine - grand fir 

DF-PP-GF Douglas-fir - ponderosa pine - grand fir 

DF-PP-LP Douglas-fir - ponderosa pine - lodgepole pine 

DF-RRWP Douglas-fir - rust resistance white pine 

DF-RRWP-GF Douglas fir - rust resistance white pine - grand fir 

DF-WP Douglas-fir - white pine   

DF-WP-GF Douglas-fir - white pine -grand fir 

EARLY-SERAL early seral 

ES Englemann spruce   

ES-AF Englemann spruce - alpine fir 

GF grand fir 
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Species  Abbreviation Species Names 

L larch 

L-DF larch - Douglas-fir  

L-DF-AF larch - Douglas-fir - alpine fir 

L-DF-ES larch - Douglas-fir - Englemann spruce 

L-DF-GF larch - Douglas-fir - grand fir 

L-DF-LP larch - Douglas-fir - lodgepole pine 

L-DF-PP larch - Douglas-fir - ponderosa pine 

L-DF-RRWP ;arch - Douglas-fir - rust resistance white pine 

L-DF-WP larch - Douglas-fir - white pine 

L-ES larch - Englemann spruce  

L-ES-AF larch - Englemann spruce - alpine fir 

L-GF larch - grand fir 

L-LP larch - lodgepole pine 

L-LP-GF larch -lodgepole pine - grand fir 

L-PP larch - ponderosa pine  

L-PP-LP larch - ponderosa pine - lodgepole pine 

L-RRWP larch - rust resistance white pine  

L-RRWP-GF larch - rust resistance white pine - grand fir 

L-WP larch - white pine -grand fir 

L-WP-GF larch - white pine -grand fir 

LATE-SERAL late seral 

LP lodgepole pine 

LP-AF lodgepole pine alpine fir 

LP-GF lodgepole pine - grand fir 

MESIC-SHRUBS mesic shrubs 

MH mountain hemlock 
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Species  Abbreviation Species Names 

NATIVE-FORBS native forbs 

ND no data 

NS non stocked 

PF limber pine 

PP ponderosa pine 

PP-DF ponderosa pine - Douglas fir 

QA quaking aspen  

QA-MC quaking aspen - mixed conifers 

RRWP rust resistance white pine 

UPLAND-GRASSES upland grasses 

WB white bark pine - Englemann spruce - alpine fir 

WB-ES-AF white bark pine - Englemann spruce - alpine fir 

WH western hemlock 

WH-C western hemlock - cedar    

WH-C-GF western hemlock - cedar - grand fir 

WP white pine 

XERIC-SHRUBS xeric shrubs 

Table  A-6 Valid species values for forest habitat type groups for the Westside zone, Region One. 
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Species Abbreviation Species Name 

AF alpine fir 

AF-ES-LP alpine fir - Englemann spruce - lodgepole pine 

AGR agriculture 

ALPINE-GRASSES alpine grasses 

ALTERED-GRASSES altered grasses 

CW cottonwood 

CW-MC cottonwood - mixed conifers 

DF Douglas-fir 

DF-AF Douglas-fir - alpine fir 

DF-AF-ES Douglas-fir - alpine fir - Englemann spruce 

DF-ES Douglas-fir - Englemann spruce 

DF-LP Douglas-fir - lodgepole pine 

DF-LP-AF Douglas-fir - lodgepole pine - alpine fir 

DF-LP-ES Douglas-fir - lodgepole pine - Englemann spruce 

DF-PP-LP Douglas-fir - ponderosa pine - lodgepole pine 

DF-PP-PF Douglas-fir - ponderosa pine - limber pine 

ES Englemann spruce 

ES-AF Englemann spruce - alpine fir 

ES-LP Englemann spruce - lodgepole pine 

LP lodgepole pine 

LP-AF lodgepole pine - alpine fir 

MESIC-SHRUBS mesic shrubs 

NATIVE-FORBS native forbs 

ND no data 

NS non stocked 

PF limber pine 
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Species Abbreviation Species Name 

PF-LP limber pine - lodgepole pine 

PP ponderosa pine 

PP-DF ponderosa pine - Douglas-fir 

QA quaking aspen 

QA-MC quaking aspen - mixed conifers 

UPLAND-GRASSES upland grasses 

WB white bark pine 

WB-AF white bark pine - alpine fir 

WB-ES white bark pine - Englemann spruce 

WB-ES-AF white bark pine -Englemann spruce - alpine fir 

WB-ES-LP white bark pine - Englemann spruce - lodgepole pine 

XERIC-SHRUBS xeric shrubs 

Table  A-7 Valid species values for forest habitat type groups for the Eastside zone, Region One. 

 

 

 

 

 

Species Abbreviation Species Name 

AGR agriculture 

AGSP bluebunch wheatgrass 

ALPINE-GRASSES alpine grasses 

ALPINE-HERBS alpine herbs 

ALPINE-SHRUBS alpine shrubs 

ALTERED-GRASSES altered grasses 
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Species Abbreviation Species Name 

ALTERED-NOXIOUS altered noxious 

DF Douglas-fir 

FESCUE fescue 

FS-S-G fire sprouting shrubs and grasses 

EARLY-SERAL early seral 

GA green ash 

HERBS herbs 

JUSC juniper 

JUSC-AGSP juniper - bluebunch wheatgrass 

JUSC-ORMI juniper - rice grass 

LATE-SERAL late seral 

MAHOGANY mahogany 

MESIC-SHRUBS mesic shrubs 

MID-SERAL mid seral 

MTN-FS-SHRUBS mountain fire sprouting shrubs 

MTN-MAHOGANY mountain mahogany 

MTN-SHRUBS mountain shrubs 

NATIVE-FORBS native forbs 

NF non forest 

NOXIOUS noxious 

PF limber pine 

PP ponderosa pine 

QA quaking aspen 

QA-MC quaking aspen - mixed conifers 

RIP-DECID riparian deciduous 

RIP-DECID-MC riparian deciduous - mixed conifers 
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Species Abbreviation Species Name 

RIP-GRAMS riparian graminoids 

RIPARIAN-GRASSES riparian grasses 

UPLAND-GRASSES upland grasses 

WATER water 

WOODLAND woodland 

XERIC-FS-SHRUBS xeric fire sprouting shrubs 

XERIC-SHRUBS xeric shrubs 

Table A-8 Valid species values for the non forest habitat type groups for the Westside and Eastside 
zones, Region One. 

 

 
Size Class 

Size Class - Structure Name 

NS non-stocked 

UNIFORM uniform 

SCATTERED scattered 

CLUMPED clumped 

OPEN-HERB open herbaceous 

CLOSED-HERB closed herbaceous 

OPEN-LOW-SHRUB open low shrub 

OPEN-MID-SHRUB open mid shrub 

OPEN-TALL-SHRUB open tall shrub 

CLOSED-LOW-SHRUB closed low shrub 

CLOSED-MID-SHRUB closed mid shrub 

 CLOSED-TALL-SHRUB closed tall shrub 

WOODLAND woodland 

SS seedling and saplings, less than 5 inches dbh 
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Size Class - Structure Name 

POLE 5 to 8.9 inches dbh 

PTS pole two stories 

PMU pole multiple stories 

MEDIUM 9 to 14.9 inches dbh 

MTS medium two stories 

MMU medium multiple stories 

LARGE 15 to 20.9 inches dbh 

LTS large two stories 

LMU large multiple stories 

VERY-LARGE  

VLTS very large two stories 

VLMU very large multiple stories 

AGR agriculture 

NF non forest 

WATER  

Table  A-9 Valid size-class / structure values by habitat type for the Westside zone and Eastside zone, 
Region One. 

 

 

Density 

Density 
class 

Canopy coverage percent 

1 0 – 14  

2 15 – 39 

3 40 – 69 

4 70 – 100 

Table A-10  Density classes for both Eastside and Westside. 

Optional Attributes: 

Owner:  To utilize the Fire suppression logic, ownership needs to be one of the three:  National 
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Forest Wilderness (NF-WILDERNESS), National Forest Other (NF-OTHER), or OTHER. OTHER can 
be State, private, or other federal ownership. 

Roads:  The road status is also used in the Fire suppression logic. It needs to be one of the three: 
Open Roaded (O), Closed Roaded (C), or None (N). 

Fire-ignition-probability:  This field is no longer being used. It can be left blank. 

FMZ:  This field is for designating the fire management zone. These are delineations that have 
some meaning for fire management planning on a National Forest. There can be considerable 
variation within the Region. There is usually variation in terms of numbers of past fires, 
suppression costs, and suppression policy. If no zone value is used, All is interpreted for the 
field. 

Special Area:  This field can be used to facilitate a spatial break down of the outcome from 
SIMPPLLE in the reports. In past analyses we have seen drainage designations, wildlife 
management units, Forest Plan Management Areas, and a broad designation of Forest versus 
non forest habitat type groups used. 

Landtype:  This value must be blank; it is not currently used in this version. 

Initial Process:  The values must be one of the acceptable disturbance processes used in the 
system. This allows the user to identify plant communities that have had a process in the 
previous time step such as root disease, light mpb in lodgepole, etc. To identify a current, 
ongoing process the “lock-in” process feature is used. Without specifying any disturbance 
process, each plant community starts out as if succession was occurring. 

 

 

Disturbance processes: 

Disturbance process Description 

LSF Light severity fire 

MSF Mixed severity fire 

SRF Stand replacing fire 

FIRE EVENT Fire event 

RD Root disease 

LIGHT-WSBW Light western spruce budworm 

SEVERE-WSBW Severe western spruce budworm 

PP-MPB Ponderosa pine mountain pine beetle 

LIGHT-LP-MPB Light lodgepole pine mountain pine beetle 

SEVERE-LP-MPB Severe lodgepole pine mountain pine beetle 
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WP-MPB White pine mountain pine beetle 

WBP-MPB White bark pine mountain pine beetle 

DF-BEETLE Douglas-fir beetle 

SPRUCE BEETLE Spruce beetle 

Table A-11   Processes for the Westside and Eastside Region One. 

 

AQUATIC UNITS 

These fields for this class were initially created for a prototype that displayed the capabilities to 

include the dynamics of stream reaches and the interaction with changes in adjacent vegetation 

and vegetation in each reach’s drainage area. The required fields that were developed were:  

Required fields 

SLINK 

LENGTH 

LTA_GRP 

AQ_CLASS 

AQ_ATTRIB 

SEG_NUM 

INT_PROCESS 

STATUS 

As a parallel to the ecological stratification with the vegetation units, the LTA_GRP has values 

that represent Landtype Association, valley bottom groupings. 

The following values were used in the prototype drainage: 

12-FMA 

12-FWC 

12-FWB 

45-41-FMA 

45-41-FNA 
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51-FMA 

51-UWB 

51-FWB 

62-72-FNA 

A combination of the AQ_Class and AQ_ATTRIB were used to represent current condition of an 

aquatic unit. The AQ_CLASS has values that represent the Rosgen type assigned the stream unit.  

The following values were used for the prototype drainage: 

A1, A2, A3, A4 

B2, B3, B4 

C4 

D4 

E4 

G3, G4 

The AQ_ATTRIB is intended to represent the status of temperature, stream bank stability, large 

woody debris, and stream bed conditions. Different combinations of these variables being in or 

out of reference conditions were developed. With the absence of an initial inventory, all of 

these attributes were considered within the Reference range of conditions, identified as: 

REF 

The INT_PROCESS has values that are intended to be representative of the dynamics of an 

individual stream reach. 

In the Westside Region One zone, the sample landscape of Sweathouse Creek can be loaded. 

The individual aquatic units can be seen and the pathway files are available. However, no 

pathway diagram is displayed and no change occurs in the simulation. 
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Figure A-1 Selection of the Sweathouse Creek area to load that contains aquatic units. 

 

 

The functionality for the aquatics has not been maintained in newer versions of SIMPPLLE. 

Discussion on System Knowledge 

Mountain Pine Beetle in Lodgepole Pine 

The logic for mountain pine beetle probability in lodgepole is built upon the hazard rating 

system in General Technical Report INT-36, “Guidelines for reducing losses of lodgepole pine to 

the mountain pine beetle in unmanaged stands in the Rocky Mountains” (Amman et al. 1977). 

The interpretation of a combination of a hazard ratings and past processes are based on 

analyses by silviculturists using the system on sample landscapes. The stand level data used in 

these hazard rating systems must be replaced by other information that is consistent with the 

level of available vegetation information. For example, basal area of lodgepole pine is replaced 

by whether the plant community is only lodgepole pine, or it contains one other species, or two 

other species. Elevation of the plant community is replaced by the habitat type group assigned. 

Probabilities are assigned to combinations of hazard ratings and past processes in both the 

vegetation unit being evaluated and its neighbors. These probabilities are based on analyses by 

silviculturists using the system on sample landscapes. The user-interface provides the means to 

change the probabilities, but not the combination of attributes of hazard, past insect and fire 

activity. 
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Figure A-2 Hazard Rating for Westside Region One zone, mountain pine beetle in lodgepole pine when 
lp is the dominant species or occurs with one other species. 
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Figure A-3 Hazard Rating for Westside Region One zone, mountain pine beetle in lodgepole pine when 
lodgepole pine is a minor component occurring with two other species. 
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Figure A-4 Logic Westside Region One zone for determining if mountain pine beetle will spread to 
adjacent plant communities. 
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Figure A-5 Hazard Rating for Eastside Region One, mountain pine beetle in lodgepole pine when 
lodgepole pine is a single species or is one of two species. 
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Figure A-6 Hazard Rating for Eastside Region One zone, mountain pine beetle in lodgepole pine when 
lodgepole pine is a minor component occurring with two other species. 
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Figure A-7 Logic Eastside Region One zone for determining if mountain pine beetle will spread to 
adjacent plant communities. 

 

 

Mountain Pine Beetle in Ponderosa Pine 

The basis for the probability of mountain pine beetle in ponderosa pine starts with the 
determination of a hazard. This hazard is based on the research work documented in “Risk 
Rating Guide for Mountain Pine beetle in Black Hills Ponderosa Pine” (Stevens et al. 1980). This 
work uses the number of stories, basal area of ponderosa pine and the ponderosa pine 
quadratic mean diameter (qmd) to develop a risk of low, moderate, or high. Within SIMPPLLE, 
the single story, two story, and multi-story designation easily provides the information of one 
story, two stories, or more than two. The diameter definitions for the size classes used in 
SIMPPLLE provide the information that we use for the quadratic mean diameter (qmd). The 
levels of ponderosa pine basal area used in the Risk Rating Guide could not be used directly with 
SIMPPLLE since we do not carry basal area information. In its place we used a combination of 
the size-class and canopy-coverage class. The following figures display the logic used within 
SIMPPLLE. 
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Figure A-8 Determination of mountain pine beetle hazard for ponderosa pine within SIMPPLLE. 

 

In the user interface, we do not display the logic that results in the hazard, only the combination 
of the hazard and other attributes that are used to assign a probability. Included in the logic is 
an interaction with mpb in lodgepole pine. These figures are not currently available through the 
user interface. 

Mountain pine beetle is a process that has a spread component to it. That is, it can occur in a 
plant community without having to have originated in it if one of its neighbors has the 
disturbance process. Included in the probability logic is an interaction between mountain pine 
beetle in lodgepole pine and ponderosa pine. 

Mountain Pine Beetle in White Pine 

The relationships and probabilities in the default logic are the result of workshops with 

silviculturists, ecologists, and pathologists. The logic for mountain pine beetle in white pine is 

based on the degree of white pine in the community, the size-class/structure, density, and past 

fire processes. 

Mountain Pine Beetle in Whitebark Pine 
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The default relationships and probabilities are the result of workshops with silviculturists, 

ecologists, and pathologists. The logic for mountain pine beetle in whitebark pine is based on 

the degree of whitebark pine in the community, the size-class/structure, density, and past fire 

processes. 

Blister Rust in White Pine 

Blister rust is not identified as a separate process within SIMPPLLE. During the course of our 

workshops in the Region, the decision was made that it was so common that it should be 

included within the succession pathways.  

From whatever pathway state an existing stand may currently be in, the progression is to lose 
density until we eventually have a nonstocked condition. 

Separate pathways have been developed for rust-resistant white pine (rrwp) to allow for it to be 
planted in treatments. The presence of blister rust in the pathways for both white pine and 
whitebark pine presents a problem when the user wants to make long-term simulations to 
recreate historical conditions. Before these simulations can be made we must recreate the 
white pine pathways by taking out blister rust. To a certain extent this is already done. Simply 
change the rust resistance white pine (rrwp) back to white pine (wp) and save these as historic 
pathways.  

Douglas-fir Beetle 

The logic for Douglas-fir beetle was derived through a series of workshops with silviculturists, 

ecologist, and entomologists in the Region. The logic uses a combination of the abundance of 

Douglas-fir, size-class/structure, density and the occurrence of a past light or mixed severity fire.  

No spread logic has been incorporated with this disturbance process.  

Spruce Beetle 

The relationships and probabilities are the result of workshops with silviculturists, ecologists, 
and pathologists. The logic is based on habitat type groups, degree of presence of susceptible 
species, size-class and if a past light- or mixed-severity fire has occurred. 
 
Western Spruce Budworm 

The hazard rating system developed by Carlson and Wulf (1989) contains attributes of individual 
plant communities that were generalized to the landscape scale for use in the SIMPPLLE modeling 
system. One factor within the hazard rating is a measure of the surrounding suitable host forest. 
Within SIMPPLLE, this factor is expanded to include not just the adjacent communities, but also the 
percent of the landscape that is in contiguous, suitable host forest conditions. This is an example 
where some detail is given up in stand level attributes, but other components are gained in relation 
to landscape level attributes. 

We compute a susceptibility-index as is done in the research work. This index consists of: 

 Percent-host-index 

 Percent-climax-host-index 

 Density-index 
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 Structure-index 

 Stand-vigor-index 

 Maturity-index 

 Site-climate-index 

 Character-of-adjacent-index 

Additional information will be added to the documentation in future versions. 

 

Root Disease 

Most of the existing research for root disease requires a level of inventory information that is not 

consistent with what is available at landscape scales. Monitoring on long-term measurement for areas in 

the Region can provide rates of change due to root disease and other disturbance process. These values 

have been used in transition matrices in other models but we do not want to lock these values within 

SIMPPLLE. They should serve as comparisons to what SIMPPLLE produces on similar landscapes through 

multiple stochastic simulations. Future analysis should be done to compare these values to the ranges 

that result from multiple simulations. 

The relationships and probabilities are the result of workshops with silviculturists, ecologists, and 

pathologists. The logic is based on habitat type groups, degree of presence of susceptible species and if 

past partial harvest has been done. 

Invasive Species—Eastside Only 

Research from Lisa J. Rew, Bruce Maxwell, and Richard Aspinall, Land Resources and Environmental 

Science Department, Montana State University (Rew et al. 2005) has been incorporated into version 2.5. 

Their research on “Predicting the Occurrence of Non-indigenous Species Using Environmental and 

Remotely Sensed Data” uses a log-odds equation with the following variables: 

 

 

Variable Definition 

ELEV (meters) Elevation in meters 

SLOPE (degrees) Slope in degrees 

COSASP Cosine of Aspect 

SINASP Sine of Aspect 

ANNRAD Annual Radiation load 

DISTROAD (meters) 
The distance the EVU is from the nearest road instance that is 

labeled “road.” 
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DISTTRAIL (meters) 
The distance the EVU is from the nearest trail instance that is 

labeled “trail.” 

GRAZING, CLEARCUT, THINNING, PREBURN, WILDFIRE history 

SHRUB, GRASS, TREE cover type 

Table A-12 The variables used in the equations from Rew et al. (2005). 

 

 

The SIMPPLLE data set will have: 

Vegetation 

Land units 

Manmade units = roads (includes trails) 

  

The cover for the vegetation will have to have a treatment history in it. The user will need to identify the 

treatments as: 

 Grazing 

 Clearcut 

 Thinning 

 Prescribe Burning 

The land units will have to have slope, elevation, and aspect assigned to them. There is a model 

coefficient for ANNRAD.  

The manmade units will be roads. 

Under the system knowledge choice of Invasive species Logic, selecting the Montana State University  

logic will bring up the input screen. 

A difference in the logic screen is that the probabilities are computed, thus, there are no values to put in 

the screen. There are three screens for the MSU logic: the Probability tab (identifies the invasive species 

and what coefficients values go with the parameters), the Change_rate tab,  and a new Starting Value 

tab (includes for each invasive species a probability range of occurrence, and for this range what the 

starting value of density would be). 
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 To test SIMPPLLE’s calculation of probabilities, a separate output file can be created by adding the 

following to the end of the SIMPPLLE.lax file in the SIMPPLLE installation directory: 

simpplle.comcode.InvasiveSpeciesLogicDataMSU.probFile=true. Note: this output file will have the 

prefix of the output specified in the simulation parameters dialog.  

 

Using the Close-roads treatment. 

The treatment will change the status of a road unit to closed from open. And there is a corresponding 

treatment that can change the status from closed back to open. This change in road status will affect the 

probability of occurrence of invasive species that have a coefficient for the distance to an open road. 

The difficulty in developing this treatment in the current version of SIMPPLLE (2.5) is that there is no 

user interface access to road units. Road units exist in SIMPPLLE and a distance from each existing 

vegetation unit (EVU) to the nearest open road is computed for each time step. There is a road status of 

an EVU that is determined by whether a closed or open road goes through the unit. This relationship of 

what EVUs have roads in them is determined at the time the SIMPPLLE toolbox spatial relations is run. 

This relationship is constant for a dataset. At this time we do not allow for “new” roads to be built or 

existing roads to be completely removed. But this new treatment will allow the user to change the 

status of a road at a specified time step. This in turn will affect the distance each EVU is from an open 

road in each time step for the coefficient in the probability calculations. This has to be accomplished 

without identifying a given road unit(s) in SIMPPLLE. 

Our short-term solution for version 2.5 is to apply the treatment to close or open a road unit by 

identifying the EVUs that are associated with a given road unit. 

The steps to apply this treatment are: 

1. From the geodatabase, the road feature class, select the road units that you want to close. See 

the example in following figure. 
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Figure A-9 Selected road units to close. 

 

 

With the above road units selected go to the ArcGIS toolbox and chose Analysis Tools, Overlay, and 

Identity. 

It is necessary to use this combination because it is the same approach utilized in the SIMPPLLE spatial 

relations tool that determines the relationship between EVUs and road units. Any other approach will 

result in identifying EVUS that SIMPPLLE does not have with a road through them. 
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Figure A-10   Selection of identify tool. 

 

 

This brings up the input screen for this process. The input features is the road feature class from the 

geodatabase with the roads to close selected. The identify features is the vegetation feature class from 

the same geodatabase. The output feature class will be the vegetation polygons that are associated with 

the selected road units. Within the join attributes if you specify ONLY_FID it will minimize what is in the 

table of the feature class of the selected EVUs. 
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Figure A-11 Input screen for the identify tool. 

 

 

2. Within the table of the output, export it as a text file. 
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Figure A-12 The exported text file that contains the combination of selected road units and the EVUs that they 
are within. 

 

 

3. The exported *.txt file can be imported into an Excel spread sheet as a comma delimited format. 

With Excel, all of the fields except the SLINK field identifying the EVUs can be deleted and a first 

line added to contain the time step number and the treatment name. Example: 1, close-roads. 

The file can be saved as a text file. This is the format for a “unit-id” file that can be loaded into 

SIMPPLLE. 
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Figure A-13 Final file saved as a text file from Excel. 
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Figure A-14 Loading unit-id file for a treatment. 

 

 

Within SIMPPLLE, under Treatment Schedule, schedule a new treatment for the desired time step (must 

match the number you put in the id text file). Select the Close-road treatment. Then select File > Load 

Unit Id File. After it is loaded, select Save As to make this a treatment schedule file for future 

simulations. 

No changes are required to the close-roads treatment logic. If you look at the treatment logic you can 

see there are no restrictions for feasibility of application. There are no rules associated with change, 

only the use of a function call to close the road unit that is associated with the EVU identified. 
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This same sequence of steps can be used with other treatments of Open-roads, Close-trails, and Open-

trails. A combination of these treatments can be used, closing and opening roads a number of times 

over a simulation. 

Conifer Encroachment—Eastside Only 

This system knowledge component was developed before many of the current regeneration features 

were in the system. The purpose is to account for ecological stratifications, certain habitat types in 

Region One, that are classified as non-forest, but with the absence of fire certain adjacent conifer 

species will encroach. The logic screen accounts for the concept that the larger the plant community of 

non forest habitat type, the longer it must be free of fire before the encroachment can occur. The code 

that identifies considered habitat type groups is not accessible. However, it can be seen by looking at 

the pathways for the non-forest habitat type groups. Those pathways have Douglas-fir, Ponderosa Pine, 

and Limber Pine present. Thus, if a seed source is present in an adjacent plant community it is possible 

in the absence of fire to get regeneration of the species. 

16.2  APPENDIX B—CALIFORNIA: SOUTHERN CALIFORNIA AND SIERRA NEVADA  

A California version of SIMPPLLE was created with two initial zones that correspond with Bailey’s  

Ecological Sections in California: the Sierra Nevada zone containing M261E and M261F and the 

Southern California zone containing M262B (Bailey 1998). These geographic zones were developed with 

funding from a Joint Fire Sciences Project, 98-1-8-06, A risk-based comparison of potential fuel 

treatment tradeoff models (Weise et al. 2000, 2003) 

Information for pathways and process logic came from the following sources: 

 Stephenson, John R., and Gena M. Calcarone. 1999. Southern California Mountains and 
Foothills Assessment: Habitat and Species Conservation Issues. Gen. Tech. 

Rep. GTR-PSW-175. Albany, CA: Pacific Southwest Research Station, Forest 
Service, U.S. Department of Agriculture; 402 p. 

 Sierra Nevada Ecosystem Project: Final Report to Congress.  Volume II: Assessments and 

Scientific Basis for Management Options, Wildland Resources Center Report No. 37 ISBN 1-8-

87673-01-6. July 1996 

 Meeting with Jo Keeley, University of California, Los Angeles in June 1999 

 A variety of publications provided by Richard Minnich, University of California, Los Angeles  
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Ecological Stratification 

Ecological Stratification Description 

Fth-x Foothills xeric 

Fth-m Foothills mesic 

Lm-x Lower montane xeric 

Lm-m Lower montane mesic 

Um-x Upper montane xeric 

Um-m Upper montane mesic 

Sa subalpine 

Table B-1 Ecological stratification used for the Southern California and Sierra Nevada geographic zones. 

Vegetation Attributes 

Dominant Species Used in SIMPPLLE 

abbreviation description 

AGR AGRICULTURE 

GRASS GRASS 

EXOTIC-GRASSES EXOTIC-GRASSES 

NF NON-FOREST 

NS NON-STOCKED 

CSS COASTAL SAGE SCRUB 

MDS MIXED DESERT SHRUB 

MTN-CHP MONTANE CHAPARRAL 

NM-CHP NORTHERN MIXED CHAPARRAL 

C-CHP CEANOTHUS CHAPPARRAL 

CA-CHP CHAMISE CHAPARRAL 

SD-CHP SEMI-DESERT CHAPARRAL 
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BSB BIG BASIN SAGEBRUSH 

SB SAGEBRUSH 

TBRSB TIMBERLINE SAGEBRUSH 

ILO INTERIOR LIVE OAK 

CLO CANYON LIVE OAK 

BO BLACK OAK 

BO-PP BLACK OAK-PONDEROSA PINE 

PC COULTER PINE 

PJ PINON PINE 

JP JEFFERY PINE 

PP PONDEROSA PINE 

LP LODGEPOLE PINE 

WB WHITEBARK PINE 

WJ WESTERN JUNIPER 

WH WESTERN HEMLOCK 

CW COTTONWOOD 

QA ASPEN 

MH MOUNTAIN HEMLOCK 

MC-DF MIXED CONIFER - DOUGLAS FIR 

MC-IC MIXED CONIFER - INCENSE CEDAR 

MC-WF MIXED CONIFER - WHITE FIR 

MC-PP MIXED CONIFER - PONDEROSA PINE 

MC-SEQ MIXED CONIFER - SEQUOIA 
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WP WESTERN WHITE PINE 

MC-RF MIXED CONIFER - RED FIR 

LP-RF LODGEPOLE PINE - RED FIR 

DF DOUGLAS-FIR 

RF RED-FIR 

XERIC-SHRUBS XERIC-SHRUBS 

MESIC-SHRUBS MESIC-SHRUBS 

RIP-SHRUBS   RIPARIAN-SHRUBS 

ALPINE-SHRUBS ALPINE-SHRUBS 

WATER WATER 

Table B-2 Species in the California zones. 

 

Size-Class, Structure Description 

SS seedling & sapling < 5-inch DBH 

POLE pole size 5–8.9-inch DBH 

PTS two stories with largest being pole size 

PMU 
more than two stories, multi-storied, largest being 

pole size 

MEDIUM medium size 9–14.9-inch DBH 

MTS two stories with largest being medium size 

MMU 
more than two stories, multi-storied, largest being 

medium size 

LARGE large size, 15–20.9-inch DBH 

LTS two stories with largest being large size 
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LMU 
more than two stories, multi-storied, largest being 

large size 

VERY-LARGE very large ≥21-inch 

VLTS two stories with largest being very-large 

VLMU 
more than two stories, multi-storied, largest being 

very-large 

Table B-3 Size Class, Structure in the California zones. 

 

 

 

Density 

Class 
Percent 

1 0 - 10 

2 11 - 39 

3 40 - 69 

4 70 - 100 

Table B-4 Density in the California zones. 

 

 

 

 

 

Disturbance Process Description 

srf stand replacing fire 
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msf mixed severity fire 

lsf light severity fire 

dm drought mortality 

sbb severe bark beetles 

lbb light bark beetles 

succ succession 

Rd root disease 

bb-rd-mist root disease, bark beetles, mistletoe complex 

wpbr  white pine blister rust 

Table B-5 Disturbance Processes in the California zones. 
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16.3  APPENDIX C—GILA NATIONAL FOREST  

This geographic area was developed with funding from a Joint Fire Sciences Project, 98-1-8-06, A risk-

based comparison of potential fuel treatment tradeoff models (Weise et al. 2000,. 2003) 

Values used came from a meeting with the Forest and Reserve District in May 2001 in Silver City, New 

Mexico. 

 

 

Ecological Stratification 

Ecological 

Stratification 
Description 

NF Non-forest 

W Woodland 

R Riparian 

FW Forested wet 

FD Forested dry 

Table C-1 Ecological stratification used for the Gila Forest. 

 

 

Vegetation Descriptions 

SIMPPLLE Species Definition 

NRK rockland/talus/scree 

NFL non forested 

NPT strip mine/quarries/gravel pits 

PVT private (no data) 

WET wetlands 

WAT water 
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SIMPPLLE Species Definition 

GRA grass 

GRA-SMS grass/shrub mountain mahogany 

GRA-TAA grass/tree quaking aspen 

GRA-TAD grass/tree quaking aspen/Douglas-fir 

GRA-TDF grass/tree Douglas-fir (wet) 

GRA-TDO grass/tree Douglas-fir/oak 

GRA-TMC grass/tree mixed conifer (wet) 

GRA-TMC grass/tree mixed conifer (wet) 

GRA-TJW grass/tree juniper woodland 

GRA-TPI grass/tree pinyon pine 

GRA-TPJ grass/tree pinyon pine/juniper 

GRA-FW grass/forested wet 

GRA-FD grass/forested dry 

GRA-TDF grass/tree Douglas-fir wet 

GRA-TOC grass/tree oak/conifer 

GRA-TODF grass/tree oak/Douglas-fir 

GRA-TOPP grass/tree oak/ponderosa pine 

GRA-TMS grass/tree mountain mahogany 

GRA-TOW grass/tree oak woodland 

GMU grass mountain muhly 

GWE wetland grass 

GWE-TCF wetland grass/tree cottonwood forest 

GWE-TCW wetland grass/tree cottonwood 

GWE-TRF wetland grass/tree riparian forest 

SHR shrub 
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SIMPPLLE Species Definition 

SHR-TCF shrub/tree cottonwood forest 

SHR-TRF shrub/tree riparian forest 

SHR-TODF shrub/tree oak/Douglas-fir 

SHR-TOPP shrub/tree oak/ponderosa pine 

SHR-TOW shrub/tree oak woodland 

SMS shrub mountain mahogany 

SGO shrub Gambel oak 

SMZ shrub manzanita/turbinella oak/chaparral 

TAA tree quaking aspen 

TADF tree quaking aspen/Douglas-fir 

TDFA tree Douglas-fir/quaking aspen 

TCF tree cottonwood forest 

TCW tree cottonwood 

TDF-OAK tree Douglas-fir (SS)/oak 

TPP-GRA tree ponderosa pine (SS)/grass 

TPP-GRA tree ponderosa pine (SS)/grass 

TDF tree Douglas-fir (dry) 

TDF tree Douglas-fir (wet) 

TPP-TDF tree ponderosa pine/Douglas-fir 

TDF-TPP tree Douglas-fir/ponderosa pine 

TES tree Engelmann spruce 

TJW tree juniper woodland 

TMC tree mixed conifer (dry) 

TMC tree mixed conifer (wet) 

TMS tree mountain mahogany 
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SIMPPLLE Species Definition 

TGO tree Gambel oak 

TOC tree oak/conifer 

TODF tree oak/Douglas-fir 

TDFO tree Douglas-fir/oak 

TOPP tree oak/ponderosa pine 

TPPO tree ponderosa pine/oak 

TOW tree oak woodland 

TPI tree pinyon pine woodland 

TPJ tree pinyon/juniper woodland 

TPP tree ponderosa pine (dry) 

TPP tree ponderosa pine (wet) 

TRE tree (no species data) 

TRF tree riparian forest 

TRJ tree Rocky Mountain juniper 

TSF tree subalpine fir/Engelmann spruce 

TWF tree white fir 

TWP tree white pine 

Table C-2 Species used for the Gila Forest. 

 

 

 

Size Class Definition 

NF Non-forest 

GRA Grass 
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SHR Shrub 

SS Seedling sapling 

POLE Pole 

MEDIUM Medium 

LARGE Large 

VERY-LARGE Very large 

Table C-3 Size class used for the Gila Forest. 

 

 

 

Density Class Definition 

1 Non-forest <10% 

2 Low 11-49% 

3 Medium 50-69% 

4 High 70-100% 

Table C-4 Density classes used for the Gila Forest. 

 

Disturbance Process Definition 

SUCCESSION Succession 

LSF Light severity fire 

MSF Mixed severity fire 

SRF Stand replacing fire 

ROOT-DISEASE Root disease 

DF-BEETLE Douglas-fir beetle 

PP-MPB Ponderosa pine mountain pine beetle 
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Disturbance Process Definition 

LIGHT-WSBW Light western spruce budworm 

SEVERE-WSBW Severe western spruce budworm 

ELK-HERBIVORY Elk browsing 

WP-MPB White pine mountain pine beetle 

Table C-5 Disturbances used for the Gila Forest. 
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16.4  APPENDIX D—SOUTH CENTRAL ALASKA  

This geographic zone was developed with funding from a Joint Fire Sciences Project, 98-1-8-06, A risk-

based comparison of potential fuel treatment tradeoff models (Weise et al. 2000, 2003) 

Vegetation attributes were based on inventories developed by the Kenai Peninsula Borough through the 

Spruce Beetle project. Process behavior knowledge was derived from meeting with Marvin Rude from 

the Borough and individuals from the Forest Service, State and Private Office. 

Ecological Stratification 

No stratification was used for the Kenai. 

 

 

Vegetation Attributes 

 

Species Definition 

Tree  

A aspen 

AB aspen-birch 

AB-BS aspen-birch-black spruce 

AB-CW aspen birch-cottonwood 

AB-DLS aspen birch-dead Lutz spruce 

AB-DSS aspen birch-dead Sitka spruce 

AB-DWS aspen-birch-dead white spruce 

AB-HD aspen birch-hardwood 

AB-LS aspen birch-Lutz spruce 

AB-MH aspen birch-mtn. Hemlock 

A-BS aspen-black spruce 

AB-SS aspen birch-Sitka spruce 
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Species Definition 

AB-WH aspen birch-w. hemlock 

AB-WS aspen-birch-white spruce 

AC Alaska cedar 

A-CW aspen-cottonwood 

A-DLS aspen-dead Lutz spruce 

A-DSS aspen-dead Sitka spruce 

A-DWS aspen-dead white spruce 

A-HD aspen-hardwood 

A-LS aspen-Lutz spruce 

A-MH aspen-mtn. Hemlock 

A-SS aspen-Sitka spruce 

A-WH aspen-w. hemlock 

A-WS aspen-white spruce 

B birch 

BA birch-aspen 

BA-BS birch aspen-black spruce 

BA-CW birch aspen-cottonwood 

BA-DLS birch aspen-dead Lutz spruce 

BA-DSS birch aspen-dead Sitka spruce 

BA-DWS birch aspen-dead white spruce 

BA-HD birch aspen-hardwood 

BA-LS birch aspen-Lutz spruce 

BA-MH birch aspen-mtn. Hemlock 

BA-SS birch aspen-Sitka spruce 
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Species Definition 

BA-WH birch aspen-w. hemlock 

BA-WS birch aspen-white spruce 

B-BS birch-black spruce 

B-CW birch-cottonwood 

B-DLS birch-dead Lutz spruce 

B-DSS birch-dead Sitka spruce 

B-DWS birch-dead white spruce 

B-HD birch-hardwood 

B-LS birch-Lutz spruce 

B-MH birch-mtn. Hemlock 

BS black spruce 

BS-A black spruce-aspen 

BS-AB black spruce-aspen-birch 

BS-B black spruce-birch 

BS-BA black spruce-birch aspen 

BS-CW black spruce-cottonwood 

BS-DLS black spruce-dead Lutz spruce 

BS-DSS black spruce-dead Sitka spruce 

BS-DWS black spruce-dead white spruce 

BS-HD black spruce-hardwood 

BS-LS black spruce-Lutz spruce 

BS-MH black spruce-mtn. Hemlock 

B-SS birch-Sitka spruce 

BS-SS black spruce-Sitka spruce 
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Species Definition 

BS-WH black spruce-w.hemlock 

BS-WS black spruce-white spruce 

B-WH birch-w. hemlock 

B-WS birch-white spruce 

CW cottonwood 

CW-A cottonwood-aspen 

CW-AB cottonwood-aspen birch 

CW-B cottonwood-birch 

CW-BA cottonwood-aspen birch 

CW-BS cottonwood-black spruce 

CW-DLS cottonwood-dead Lutz spruce 

CW-DSS cottonwood-dead Sitka spruce 

CW-DWS cottonwood-dead white spruce 

CW-HD cottonwood-hardwood 

CW-LS cottonwood-Lutz spruce 

CW-MH cottonwood-mtn. Hemlock 

CW-SS cottonwood-Sitka spruce 

CW-WH cottonwood-w. hemlock 

CW-WS cottonwood-white spruce 

DLS dead Lutz spruce 

DLS-A dead Lutz spruce-aspen 

DLS-AB dead Lutz spruce-aspen birch 

DLS-B dead Lutz spruce-birch 

DLS-BA dead Lutz spruce-birch aspen 
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Species Definition 

DLS-BS dead Lutz spruce-black spruce 

DLS-CW dead Lutz spruce-cottonwood 

DLS-HD dead Lutz spruce-hardwood 

DLS-LS Dead Lutz spruce-Lutz spruce 

DLS-MH dead Lutz spruce-mountain hemlock 

DLS-SS dead Lutz spruce-Sitka spruce 

DLS-WH dead Lutz spruce-western hemlock 

DLS-WS dead Lutz spruce-white spruce 

DSS dead Sitka spruce 

DSS-A dead Sitka spruce-aspen 

DSS-AB dead Sitka spruce-aspen birch 

DSS-B dead Sitka spruce-birch  

DSS-BA dead Sitka spruce-birch aspen 

DSS-BS dead Sitka spruce-black spruce 

DSS-CW dead Sitka spruce-cottonwood 

DSS-HD dead Sitka spruce-hardwood 

DSS-MH dead Sitka spruce-mountain hemlock 

DSS-SS Dead Sitka spruce-Sitka spruce 

DSS-WH dead Sitka spruce-western hemlock 

DWS dead white spruce 

DWS-A dead white spruce-aspen 

DWS-AB dead white spruce-aspen-birch 

DWS-B dead white spruce-birch 

DWS-BA dead white spruce-birch aspen 
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Species Definition 

DWS-BS dead white spruce-black spruce 

DWS-CW dead white spruce-cottonwood 

DWS-HD dead white spruce-hardwood 

DWS-MH dead white spruce-mountain hemlock 

DWS-SS dead white spruce-Sitka spruce 

DWS-WH dead white spruce-western hemlock 

DWS-WS dead white spruce-white spruce 

HD hardwood 

HD-A hardwood-aspen 

HD-AB hardwood-aspen birch 

HD-B hardwood-birch 

HD-BA hardwood-birch aspen 

HD-BS hardwood-black spruce 

HD-CW hardwood-cottonwood 

HD-DLS hardwood-dead Lutz spruce 

HD-DSS hardwood-dead Sitka spruce 

HD-DWS hardwood-dead white spruce 

HD-LS hardwood-Lutz spruce 

HD-MH hardwood-mtn. Hemlock 

HD-SS hardwood-Sitka spruce 

HD-WH hardwood-w. hemlock 

HD-WS hardwood-white spruce 

LS Lutz spruce 

LS-A Lutz spruce-aspen 
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Species Definition 

LS-A Lutz spruce-aspen 

LS-AB Lutz spruce-aspen birch 

LS-B Lutz spruce-birch 

LS-B Lutz spruce-birch 

LS-BA Lutz spruce-birch aspen 

LS-BS Lutz spruce-black spruce 

LS-CW Lutz spruce-cottonwood 

LS-CW Lutz spruce-cottonwood 

LS-DLS Lutz spruce-Dead Lutz spruce 

LS-HD Lutz spruce-hardwood 

LS-MH Lutz spruce-mountain hemlock 

LS-SS Lutz spruce-Sitka spruce 

LS-WH Lutz spruce-western hemlock 

MH mountain hemlock 

MH-A mtn. Hemlock-aspen 

MH-AB mtn. Hemlock-aspen birch 

MH-AC mountain hemlock-Alaska cedar 

MH-B mountain hemlock-birch 

MH-B mtn. Hemlock-birch 

MH-BA mtn. Hemlock-birch aspen 

MH-BS mtn hemlock-black spruce 

MH-CW mtn. Hemlock-cottonwood 

MH-DLS mountain hemlock-dead Lutz spruce 

MH-DSS mountain hemlock-dead Sitka spruce 
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Species Definition 

MH-HD mtn. Hemlock-hardwood 

MH-LS mountain hemlock-Lutz spruce 

MH-SS mountain hemlock-Sitka spruce 

MH-WH mountain hemlock-western hemlock 

MH-WS mtn. Hemlock-white spruce 

SS Sitka spruce 

SS-A Sitka spruce-aspen 

SS-AB Sitka spruce-aspen birch 

SS-B Sitka spruce-birch 

SS-BA Sitka spruce-birch aspen 

SS-BS Sitka spruce-black spruce 

SS-CW Sitka spruce-cottonwood 

SS-DLS Sitka spruce-dead Lutz spruce 

SS-DSS Sitka spruce-Dead Sitka spruce 

SS-DWS Sitka spruce-dead white spruce 

SS-HD Sitka spruce-hardwood 

SS-MH Sitka spruce-mountain hemlock 

SS-WH Sitka spruce-western hemlock 

SS-WS Sitka spruce-white spruce 

WH western hemlock 

WH-A w. hemlock-aspen 

WH-AB w. hemlock-aspen birch 

WH-B w. hemlock-birch 

WH-BA w. hemlock-birch aspen 
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Species Definition 

WH-BS w. hemlock-black spruce 

WH-CW w. hemlock-cottonwood 

WH-DLS western hemlock-dead Lutz spruce 

WH-DSS western hemlock-dead Sitka spruce 

WH-DWS western hemlock-dead white spruce 

WH-HD w. hemlock-hardwood 

WH-LS w. hemlock-Lutz spruce 

WH-SS western hemlock-Sitka spruce 

WH-WS w. Hemlock-white spruce 

WS white spruce 

WS-A white spruce-aspen 

WS-AB white spruce-aspen-birch 

WS-B white spruce-birch 

WS-BA white spruce-birch aspen 

WS-BS white spruce-black spruce 

WS-CW white spruce-cottonwood 

WS-DWS white spruce-dead white spruce 

WS-HD white spruce-hardwood 

WS-MH white spruce-mountain hemlock 

WS-SS white spruce-Sitka spruce 

WS-WH white spruce-western hemlock 

Shrub  

Wil willow 

Ald alder 
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Species Definition 

mixed tall shrub mixed tall shrub 

mixed low shrub mixed low shrub 

mixed dwarf shrub mixed dwarf shrub 

Grass  

Herb herbaceous 

GH grasses/herbs 

Aqu aquatic 

Non-forest 

OCEAN ocean 

NF NF 

ALP alp 

AGR agriculture 

Table D-1 Species used in the South Central Alaska zone. 

 

Size Class Definition Size Limit 

Tree 

SS Seedling-sapling 1–5-inch DBH 

SS-SS Seedling-sapling - seedling-sapling  

SS-POLE Seedling-sapling - pole  

SS-LARGE Seedling-sapling-large  

POLE Pole 

5.1–9-inch DBH – conifer 

5.1–11-inch DBH - hardwood 

POLE-SS Pole-seedling - sapling  

POLE-POLE Pole - pole  
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POLE-LARGE Pole - large  

LARGE Large 

>9-inch DBH – conifer 

>11-inch DBH - hardwood 

LARGE-SS Large – seedling-sapling  

LARGE-POLE Large – pole  

LARGE-LARGE Large – large  

SHRUB   

TALL-SHRUB Tall shrub  

LOW-SHRUB Low shrub  

DWARF-SHRUB Dwarf shrub  

GRASS   

HERB Herbaceous  

GH Grass or herbaceous  

AQUATIC Aquatic herbaceous  

NON-FOREST   

NF Non-forest  

Table D-2 Size Classes used in the South Central Alaska zone. 

 

 

Density Definition Percent of Canopy Closure 

Tree 

W Woodland 10-24% 

O Open 25-59% 

C Closed 60-100% 

Shrub 
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W Woodland 10-24% 

O Open 25-59% 

C Closed 60-100% 

Herbaceous 

C Closed 60-100% 

Table D-3 Density used in the South Central Alaska zone. 

 

 

Disturbance Processes 

Abbreviation Definition 

LSF Light severity fire 

MSF Mixed severity fire 

SRF Stand replacing fire 

LOW-WINDTHROW Low windthrow 

MEDIUM-WINDTHROW Medium windthrow 

HIGH-WINDTHROW High windthrow 

WILDLIFE-BROWSING Wildlife browsing in aspen and birch 

ROOT-DISEASE Root disease 

LIGHT-SB Light spruce beetle  

MEDIUM-SB Medium spruce beetle 

HIGH-SB High spruce beetle 

Table D-4 Disturbance Processes used in the South Central Alaska zone. 

 

 

Discussion of System Knowledge 

Root Disease is the only process probability logic that is accessible in the user interface. Windthrow and 

Wildlife Browsing must be locked-in to be used. The spruce beetle probability comes from the 
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incorporation of components of the spruce beetle expert system, Reynolds and Holsten (1997). The 

system knowledge on the spruce beetle probability is not accessible in SIMPPLLE version 2.5. 
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16.5  APPENDIX E—SOUTHWEST UTAH  

This geographic zone was developed with funding from a Joint Fire Sciences Project, 98-1-8-06, A risk-

based comparison of potential fuel treatment tradeoff models (Weise et al. 2000, 2003) 

Values and system behavior were derived from a workshop in Cedar City, Utah and follow up 
correspondence with local Forest Service and BLM individuals. 
 

Ecological Stratification 

 

Ecological 

Stratification 
Definition 

0 Miscellaneous special habitats: scree, forested rock, wet meadow, mountain grassland, deciduous 

riparian communities 

1 Pinyon pine–Juniper communities 

2 Montane maple-oak communities 

3 Ponderosa pine communities 

4 Dry Douglas-fir communities 

5 Cool or moist Douglas-fir communities 

6 White fir and blue spruce communities (mixed conifer types) 

7 Aspen-dominated communities 

Table E-1 Ecological Stratification used for Southwest Utah. 

 

 

Vegetation Attributes 

 

Species Definition 

AGR/URB Agriculture/urban 

AG Annual grass 

A Aspen 
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Species Definition 

A-MF Aspen-montane fir 

A-MS Aspen-mountain sagebrush 

A-PG Aspen-perennial grass 

A-SF Aspen-spruce/fir 

GW-PG Greasewood-perennial grass 

MF Montane fir 

MF-A Montane fir-aspen 

MM-OK Mountain mahogany-oak 

MM-OK-PJU Mountain mahogany-oak-pinyon/juniper 

MS-PG Mountain sagebrush-perennial grass 

MS-PJU-PG Mountain sagebrush-pinyon/juniper-perennial grass 

OK Oak 

OK-PJU Oak-pinyon/juniper 

PG Perennial grass 

PJU Pinyon/juniper 

PJU-MM-OK Pinyon/juniper-mountain mahogany-oak 

PJU-MS Pinyon/juniper-mountain sagebrush 

PJU-OK Pinyon/juniper-oak 

PJU-WS Pinyon/juniper-Wyoming sagebrush 

PP Ponderosa pine 

PP-MF Ponderosa pine-montane fir 

RIPARIAN Riparian 

ROCK/BARE Rock or bare ground 

SD-PG Shadscale-perennial grass 

SF Spruce/fir 
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Species Definition 

SF-A Spruce/fir-aspen 

WATER Water 

WS-PG Wyoming sagebrush-perennial grass 

WS-PJU-PG Wyoming sagebrush-pinyon/juniper-perennial grass 

Table E-2 Species used for Southwest Utah. 

 

 

Size Class Definition 

BARREN Barren 

GF Grass/forbs 

SS Seedling-sapling 

POLE Pole 

MEDIUM Medium 

LARGE Large 

WATER Water 

AGR Agriculture 

URBAN Urban 

RIPARIAN Riparian 

ALPINE Alpine 

Table E-3 Size Classes used for Southwest Utah. 
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Density Definition 

RANGE DENSITY 

1 Open 

2 Closed 

3  

FOREST DENSITY 

1 < 40 percent cover 

2 41 to 70 percent cover 

3 > 70 percent cover 

Table E-4 Density used for Southwest Utah. 

 

 

Disturbance Processes 

Process Definition 

LSF Light severity fire 

MSF Mixed severity fire 

SRF Stand replacing fire 

PP-MPB Ponderosa pine mountain pine beetle 

Table E-5 Disturbance Processes used for Southwest Utah. 
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16.6  APPENDIX F—MICHIGAN  

This geographic zone is incomplete. The initial work was funded from a Joint Fire Sciences Project, 98-1-

8-06, A risk-based comparison of potential fuel treatment tradeoff models (Weise et al. 2000,2003) 

No testing of this zone has been made. No sample landscape has been developed. 
 

Ecological Stratification 

SIMPPLLE Attribute Definition 

FR1 

Landscape ecosystems experiencing frequent, large catastrophic stand 

replacing fires; dry outwash plains underlain by coarse textured sandy soils; 

dominant forest types were jack pine and mixed pine forests 

FR2 

Landscape ecosystems experiencing large catastrophic fires at lower 

frequencies; dry outwash plains underlain by sandy and sandy loam soils. 

Dominant vegetation is mixed red, white, and jack pine forests. 

FR3W 
Wetland ecosystems interspersed or adjoining FR1 and FR2 fire prone 

landscapes. 

FR3 

Dry-mesic to mesic areas with sandy or silt loam soils; experienced much less 

frequent stand replacement fires and dominated by mixed hemlock and 

white pine forests. 

FR4 

Moist mesic areas with deep loamy soils. Infrequent fires with long fire 

rotations; dominated by northern hardwoods (beech, sugar maple) and 

hardwood-hemlock forests. 

FR4W 
Wetland ecosystems interspersed or adjoining fire resistant landscapes. 

These areas are less influenced by fire than FR3W. 

Table F-1 Ecological Stratification used for Michigan. 

 

Vegetation Descriptions 

SIMPPLLE Attribute Species Definition 

Tree 

QA-PB Quaking aspen-paper birch 

QA-WS-BF Quaking aspen-white spruce-balsam fir 

BF-QA-PB Balsam fir-quaking aspen-paper birch 
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SIMPPLLE Attribute Species Definition 

BP Balsam poplar 

BE Beech 

BA Bigtooth aspen 

BO-SO-HL Black oak-scarlet oak-hemlock 

BLA-AE-RM Black ash-American elm-red maple 

BC-WA-YP Black cherry-white ash-yellow poplar 

BS Black spruce 

WC-QA-PB White cedar-quaking aspen-paper birch 

CONIFERS Conifers 

HL Hemlock 

JP Jack pine 

JP-OAK Jack pine-oak 

DEAD-JP Dead Jack pine 

MIXED-HDS Mixed hardwoods 

LOW-HDS Mixed lowland hardwoods 

OAK Mixed oak 

MIXED-SC Mixed swamp conifer 

RO Red oak 

PB Paper birch 

QA Quaking aspen 

RM-DRY Red maple, dry site 

RM-WET Red maple, wet site 

RM-RO Red maple-red oak 

RP Red pine 

RP-OAK Red pine-oak 

USDA Forest Service Gen. Tech. Rep. RMRS-GTR-268WWW. 2012 298



  

SIMPPLLE Attribute Species Definition 

SO Scarlet oak 

SM Sugar maple 

SM-BW Sugar maple-basswood (linden) 

SM-BE-YB Sugar maple-beech-yellow birch 

TR Tamarack 

WO White oak 

WC White cedar 

WP White pine 

WP-HL White pine-hemlock 

WP-RO-WA White pine-red oak-white ash 

WS-BF-NS White spruce-balsam fir-Norway spruce 

YP-WO-RO Yellow poplar-white oak-red oak 

GRASS/SHRUB  

LOW-BRUSH Lowland brush 

OPEN Grass or shrub mixture 

UP-BRUSH Upland brush 

NON-FOREST  

AGR-URBAN Agriculture or urban 

WATER Water 

NF Non-forest 

NS Non-stocked 

Table F-2 Species used for Michigan. 
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SIMPPLLE  Attribute Size-class Definition 

Tree 

SS Seedling-sapling 

POLE Pole 

PMU Pole-multistory 

LARGE Large 

LMU Large-multistory 

GRASS/SHRUB  

GRA-SHR Open 

SHR Shrub 

NON-FOREST  

NF Non-forest 

NS Non-stocked 

Table F-3 Size Classes used for Michigan. 

 

SIMPPLLE Attribute Density  

1 0 to 16 percent 

2 16 to 39 percent 

3 40 to 69 percent 

4 >70 percent 

Table F-4 Density used for Michigan. 

 

Disturbance Processes 

SIMPPLLE Attribute Process Definition 

LSF Light severity fire 

MSF Mixed severity fire 

SRF Stand replacing fire 

EM-ASH-BORER Emerald ash borer 

LIGHT-GYPSY Light gypsy moth 

SEVERE-GYPSY Severe gypsy moth 

JPBW Jack pine budworm 

FT-CATERPILLAR Forest tent caterpillar 

BB-DISEASE Beech bark disease 
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RH-SAWFLY Red-headed sawfly 

Table F-5 Disturbance Processes used for Michigan. 

 

Discussion of System Knowledge 

There has been no development of probability logic for disturbance processes. 
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16.7  APPENDIX G—COLORADO FRONT RANGE  

This geographic zone was developed with funding from a Joint Fire Sciences Project–01-1-3-22: 

Optimizing landscape treatments for reducing wildfire risk and improving ecological sustainability of 

ponderosa pine forests with mixed severity fire regimes, Kaufmann et al. 2001. 

 

 

Ecological Stratification 

Stratification Description 

PLAINS Below 5,500 feet elevation, short grass prairie 

FOOTHILLS 5,500 to 6,500 feet elevation 

LOWER-MONTANE 6,500 to 7,500 feet elevation 

UPPER-MONTANE 7,500 to 8,500 feet 

SUBALPINE 8,500 to 11,000 feet 

ALPINE Above 11,000 feet elevation 

Table G-1 Ecological Stratification used for the Colorado Front Range. 

 

Vegetation Descriptions 

Species Description 

NS nonstocked 

WATER water 

NF non forest 

ND no data 

AGR agriculture 

RIPARIAN riparian 

BA barren 

ACHY Indian rice grass 
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Species Description 

BOGR2 blue grama 

BRTE cheatgrass 

CACA4 blue joint 

CAEL3-CARUD blackroot sedge-Drummond's sedge 

CAFO3 dryspike sedge 

CAGE2 Geyer's sedge 

CAPU purple reedgrass 

CAREX sedge species 

CAREX-JUNCU sedge species-rush species 

CAREXU upland sedge species 

CAREXU-CARU upland sedge-pinegrass 

CARO5 Ross' sedge 

CARUD-FEBRC Drummond's sedge-Colorado fescue 

FEAR2 Arizona fescue 

FEAR2-BOGR2 Arizona fescue-blue grama 

FEAR2-DAPA2 Arizona fescue-Parry's oatgrass 

FEAR2-MUMO Arizona fescue-mountain muhly 

FEID Idaho fescue 

FETH Thurber's fescue 

HECO26 needle and thread 

JUBAL-CAGE Baltic rush-Geyer's sedge 

LEKI2 spike fescue 

MUMO mountain muhly 

PASM western wheatgrass 

PHCO9-POAL2 alpine timothy-alpine bluegrass 
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Species Description 

POAL2-CAEL3 alpine bluegrass-blackroot sedge 

POAL2-KOMY alpine bluegrass-Bellardi bog sedge 

POFE mutton grass 

POPR Kentucky bluegrass 

PSSP6 bluebunch wheatgrass 

ACGL Rocky Mountain maple 

ALINT thinleaf alder 

AMAL2 Saskatoon serviceberry 

ARTR2 big sagebrush 

ARTR2-CEMO2 big sagebrush-alderleaf mountain mahogany 

ARTR2-JUCO6 big sagebrush-common juniper 

ARTRV mountain big sage 

ARTRV-PUTR mountain big sage-antelope bitterbrush 

ARTRW8 Wyoming big sage 

ARTRW8-CHVI8 Wyoming big sage-yellow rabbitbrush 

ARTRW8-PUTR Wyoming big sage-antelope bitterbrush 

ARUV kinnikinnick 

BEOC2 water birch 

CEMO2 alderleaf mountain mahogany 

CEMO2-ARTR2 alderleaf mountain mahogany-big sagebrush 

CEMO2-ARUV alderleaf mountain mahogany-kinnikinnick 

CEMO2-DAFL3 alderleaf mountain mahogany-shrubby cinquefoil 

CEMO2-JUCO6 alderleaf mountain mahogany-common juniper 

CEMO2-PHMO4 alderleaf mountain mahogany-mountain ninebark 

CEMO2-PUTR2 alderleaf mountain mahogany-antelope bitterbrush 
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Species Description 

CEMO2-QUGA alderleaf mountain mahogany-Gambel oak 

CEMO2-RIBES alderleaf mountain mahogany-current species 

CEMO2-RICE alderleaf mountain mahogany-wax currant 

CEMO2-SALIXU alderleaf mountain mahogany-upland willow 

CEMO2-SYOR2 alderleaf mountain mahogany-mountain snowberry 

CHIV yellow rabbitbrush 

DAFL3 shrubby cinquefoil 

ERPA Parry's rabbitbrush 

JAAM fivepetal cliffbrush 

JUCO6 common juniper 

JUCO6-ARUV common juniper-kinnikinnick 

JUCO6-SALIXU common juniper-upland willow species 

PHMO mountain ninebark 

PUTR antelope bitterbrush 

PUTR-ARTR antelope bitterbrush-big sagebrush 

PUTR-CEMO2 antelope bitterbrush-alderleaf mountain mahogany 

PUTR-RIBES antelope bitterbrush-currant species 

QUGA Gambel oak 

QUGA-ACGL Gambel oak-Rocky Mountain maple 

QUGA-AMAL Gambel oak-Saskatoon serviceberry 

QUGA-ARUV Gambel oak-kinnikinnick 

QUGA-CEMO2 Gambel oak-alderleaf mountain mahogany 

QUGA-JUCO6 Gambel oak-common juniper 

QUGA-PRVI Gambel oak-chokecherry 

QUGA-SALIX Gambel oak-upland willow species 
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Species Description 

QUGA-VASC Gambel oak-grouse whortleberry 

RIBES currant species 

RIBES-PUTR currant species- antelope bitterbrush 

RICE wax currant 

SAGL grayleaf willow 

SALIX riparian willow species 

SALIX-ALIN riparian willow spp.-thinleaf alder 

SALIX-BEOC2 riparian willow spp.-water birch 

SALIXU upland willow species 

SALIXU-RIBES upland willow spp.-currant spp. 

SHCA russet buffaloberry 

VASC grouse whortleberry 

ABCO white fir 

ABCO-PIEN white fir-Engelmann spruce 

ABCO-PIFL2 white fir-limber pine 

ABCO-PIPO white fir-ponderosa pine 

ABCO-POTR5 white fir-quaking aspen 

ABCO-PSME white fir-Douglas-fir 

ABLA subalpine fir 

ABLA-PIAR subalpine fir-bristlecone pine 

ABLA-PICO subalpine fir-lodgepole pine 

ABLA-PIEN subalpine fir-Engelmann spruce 

ABLA-PIFL2 subalpine fir-limber pine 

ACNE2 boxelder 

ACNE2-PSME boxelder-Douglas-fir 
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Species Description 

JUMO oneseed juniper 

JUMO-PIED oneseed juniper-two-needle pinyon 

JUSC2 Rocky Mountain juniper 

JUSC2-PIED Rocky Mountain juniper-two-needle pinyon 

JUSC2-PIPO Rocky Mountain juniper-ponderosa pine 

JUSC2-POTR5 Rocky Mountain juniper-quaking aspen 

JUSC2-PSME Rocky Mountain juniper-Douglas-fir 

PIAR bristlecone pine 

PIAR-PICO bristlecone pine-lodgepole pine 

PIAR-PIEN bristlecone pine-Engelmann spruce 

PIAR-PIFL2 bristlecone pine-limber pine 

PIAR-PIPO bristlecone pine-ponderosa pine 

PIAR-POTR5 bristlecone pine-quaking aspen 

PIAR-PSME bristlecone pine-Douglas-fir 

PICO lodgepole pine 

PICO-ABLA lodgepole pine-subalpine fir 

PICO-PIEN lodgepole pine-Engelmann spruce 

PICO-PIFL2 lodgepole pine-limber pine 

PICO-POTR5 lodgepole pine-quaking aspen 

PICO-PSME lodgepole pine-Douglas-fir 

PIED two-needle pinyon 

PIED-ABCO two-needle pinyon-white fir 

PIED-JUMO two-needle pinyon-oneseed juniper 

PIED-JUSC2 two-needle pinyon-Rocky Mountain juniper 

PIED-PIAR two-needle pinyon-bristlecone pine 
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Species Description 

PIED-PIPO two-needle pinyon-ponderosa pine 

PIED-POTR5 two-needle pinyon-quaking aspen 

PIED-PSME two-needle pinyon-Douglas-fir 

PIEN Engelmann spruce 

PIEN-ABCO Engelmann spruce-white fir 

PIEN-ABLA Engelmann spruce-subalpine fir 

PIEN-PIAR Engelmann spruce-bristlecone pine 

PIEN-PICO Engelmann spruce-lodgepole pine 

PIEN-PIFL2 Engelmann spruce-limber pine 

PIEN-PIPU Engelmann spruce-blue spruce 

PIEN-POTR5 Engelmann spruce-quaking aspen 

PIEN-PSME Engelmann spruce-Douglas-fir 

PIFL2 limber pine 

PIFL2-ABCO limber pine-white fir 

PIFL2-PIAR limber pine-bristlecone pine 

PIFL2-PICO limber pine-lodgepole pine 

PIFL2-PIEN limber pine-Engelmann spruce 

PIFL2-PIPO limber pine-ponderosa pine 

PIFL2-POTR5 limber pine-quaking aspen 

PIFL2-PSME limber pine-Douglas-fir 

PIPO ponderosa pine 

PIPO-ABCO ponderosa pine-white fir 

PIPO-JUSC2 ponderosa pine-Rocky Mountain juniper 

PIPO-PIAR ponderosa pine-bristlecone pine 

PIPO-PICO ponderosa pine-lodgepole pine 
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Species Description 

PIPO-PIED ponderosa pine-two-needle pinyon 

PIPO-PIFL2 ponderosa pine-limber pine 

PIPO-PIPU ponderosa pine-blue spruce 

PIPO-POAN3 ponderosa pine-narrowleaf cottonwood 

PIPO-POTR5 ponderosa pine-quaking aspen 

PIPO-PSME ponderosa pine-Douglas-fir 

PIPU blue spruce 

PIPU-PIPO blue spruce-ponderosa pine 

PIPU-POAN3 blue spruce-narrowleaf cottonwood 

PIPU-POTR5 blue spruce-quaking aspen 

PIPU-PSME blue spruce-Douglas-fir 

POAN3 narrowleaf cottonwood 

POAN3-PIPO narrowleaf cottonwood-ponderosa pine 

POAN3-PIPU narrowleaf cottonwood-blue spruce 

POAN3-POTR5 narrowleaf cottonwood-quaking aspen 

POAN3-PSME narrowleaf cottonwood-Douglas-fir 

POTR5 quaking aspen 

POTR5-ABCO quaking aspen-white fir 

POTR5-ABLA quaking aspen-subalpine fir 

POTR5-PIAR quaking aspen-bristlecone pine 

POTR5-PICO quaking aspen-lodgepole pine 

POTR5-PIEN quaking aspen-Engelmann spruce 

POTR5-PIFL2 quaking aspen-limber pine 

POTR5-PIPO quaking aspen-ponderosa pine 

POTR5-PIPU quaking aspen-blue spruce 
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Species Description 

POTR5-POAN3 quaking aspen-narrowleaf cottonwood 

POTR5-PSME quaking aspen-Douglas-fir 

PSME Douglas-fir 

PSME-ABCO Douglas-fir-white fir 

PSME-JUSC2 Douglas-fir-Rocky Mountain juniper 

PSME-PIAR Douglas-fir-bristlecone pine 

PSME-PICO Douglas-fir-lodgepole pine 

PSME-PIED Douglas-fir-two-needle pinyon 

PSME-PIEN Douglas-fir-Engelmann spruce 

PSME-PIFL2 Douglas-fir-limber pine 

PSME-PIPO Douglas-fir-ponderosa pine 

PSME-PIPU Douglas-fir-blue spruce 

PSME-POTR5 Douglas-fir-quaking aspen 

Table G-2 Species used for the Colorado Front Range. 

 

Size SIMPPLLE Abbreviation Notes 

Trees 

Established Seedlings E 0.0–0.9-inches DBH 

Sapling SS 1–4.9-inches DBH 

Medium  MEDIUM 5–8.9-inches DBH 

Large LARGE 9–15.9-inches DBH 

Very Large VERY-LARGE >16-inches DBH 

Non-stocked NS  

Medium-Multistory MMU  
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Large-Multistory LMU  

Very Large-Multistory VLMU  

Shrubs  

Small SMALL-SH < 2.5 feet 

Medium MEDIUM-SH 2.5–6.4 feet 

Large LARGE-SH > 6.5 feet 

Unknown UNKNOWN  

Grasses 

Clumped CLUMPED  

Uniform UNIFORM  

Non forest 

Non forest NF  

Table G-3 Size Classes used for the Colorado Front Range. 

 

SIMPPLLE Abbreviation Density 

1 0 to 10 percent 

2 11 to 40 percent 

3 41 to 70 percent 

4 71 to 100 percent 

Table G-4 Density used for the Colorado Front Range. 
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Disturbance Processes 

SIMPPLLE Abbreviation Process 

LSF LIGHT SEVERITY FIRE 

MSF MIXED SEVERITY FIRE 

SRF STAND REPLACING FIRE 

PP-MPB PONDEROSA PINE MOUNTAIN PINE BEETLE 

LIGHT-LP-MPB LODGEPOLE MOUNTAIN PINE BEETLE 

SEVERE-LP-MPB LODGEPOLE MOUNTAIN PINE BEETLE 

SPRUCE-BEETLE SPRUCE BEETLE 

DF-BEETLE DOUGLAS FIR BEETLE 

LIGHT-WSBW LIGHT WESTERN SPRUCE BUDWORM 

SEVERE-WSBW SEVERE WESTERN SPRUCE BUDWORM 

WILDLIFE-BROWSING WILDLIFE BROWSING 

PIED-BB PINYON BARK BEETLE 

PRAIRIE-DOG PRAIRIE DOG 

WINDTHROW WINDTHROW 

WET-SUCCESSION WET SUCCESSION 

DRY-SUCCESSION DRY SUCCESSION 

SUCCESSION SUCCESSION 

ROOT-DISEASE ROOT DISEASE 

Table G-5 Disturbance Processes used for the Colorado Front Range. 
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Discussion of System Knowledge 

The system knowledge in pathways is based on the work done by Thad Jones as a Master’s degree 

thesis, Development and Evaluation of Successional Pathways for SIMPPLLE: Simulating Vegetation 

Along the Colorado Front Range, University of Montana, 2005. 

16.8  APPENDIX H—GRASSLANDS  

Western Great Plains Steppe, Mixed Grass Prairie, and Great Plains Steppe were developed together and 

have many common features. The development was done with funding and expertise provided by the 

Ecosystem Research Management Institute (EMRI) of Seeley Lake, Montana. The initial use of the 

system in these geographic zones was to assist in developing a representation of historical conditions. 

Thus, an emphasis was placed on including the process of bison grazing. No treatment logic has been 

developed yet. 

16.8.1 Western Great Plains Steppe 

 

Ecological Stratification 

Ecosites 

Clayey, Dense Clay 

Shallow Clayey 

Clayey Overflow, 

Overflow 

Loamy 

Shallow Loamy 

Sands, Sandy 

Shallow Sandy 

Very Shallow 

Saline Upland 

Saline Lowland 

Table H-1 Ecology Stratifications for the Western Great Plains Steppe. 
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Vegetation Descriptions 

CLAYEY 

PASM-BOGR2-NAVI4/NA/NA 

BOGR2-OPPO/NA/NA 

NAVI4-PASM/NA/NA 

PASM-NAVI4-BOGR2-ARTR2/NA/NA 

BOGR2-ARTR2-OPPO/NA/NA 

NAVI4-PASM-ARTR2/NA/NA 

SHALLOW_CLAYEY 

PASM-BOGR2-NAVI4/NA/NA 

BOGR2-OPPO/NA/NA 

PASM-NAVI4/NA/NA 

PASM-NAVI4-BOGR2-ARTR2/NA/NA 

BOGR2-PASM-ARTR2/NA/NA 

NAVI4-PASM-ARTR2/NA/NA 

CLAYEY_OVERFLOW 

PASM-NAVI4-LECI4/NA/NA 

BOGR2-PASM/NA/NA 

LECI4-PASM-NAVI4/NA/NA 

PASM-BOGR2-ARTR2/NA/NA 

BOGR2-PASM-ARTR2/NA/NA 

WATER/NA/NA 

LECI4-PASM-ARTR2/NA/NA 

OVERFLOW 

PASM-NAVI4-LECI4/NA/NA 

BOGR2-PASM/NA/NA 
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LECI4-PASM-NAVI4/NA/NA 

PASM-BOGR2-ARTR2/NA/NA 

BOGR2-PASM-ARTR2/NA/NA 

LECI4-PASM-ARTR2/NA/NA 

LOAMY 

PASM-BOGR2-PLME/NA/NA 

PASM-VUOC-BOGR2/NA/NA 

PASM-BOGR2-HECO26/NA/NA 

BOGR2-CAFI/NA/NA 

HECO26-PASM/NA/NA 

PASM-BOGR2-ARTR2/NA/NA 

BOGR2-CAFI-ARTR2/NA/NA 

HECO26-PASM-ARTR2/NA/NA 

SHALLOW_LOAMY 

PASM-BOGR2-PSSP6/NA/NA 

BOGR2-CAFI/NA/NA 

PSSP6-HECO26-PASM/NA/NA 

PASM-BOGR2-ARTR2/NA/NA 

BOGR2-CAFI-ARTR2/NA/NA 

PSSP6-HECO26-ARTR2/NA/NA 

SANDS_SANDY 

HECO26-BOGR2-YUGL/NA/NA 

BOGR2-CAFI/NA/NA 

CALO-HECO26-POSE/NA/NA 

HECO26-BOGR2-ARTR2/NA/NA 

BOGR2-CAFI-ARTR2/NA/NA 
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CALO-HECO26-ARTR2/NA/NA 

SHALLOW_SANDY 

HECO26-BOGR2-YUGL/NA/NA 

BOGR2-CAFI/NA/NA 

CALO-HECO26-POSE/NA/NA 

HECO26-BOGR2-ARTR2/NA/NA 

BOGR2-CAFI-ARTR2/NA/NA 

CALO-HECO26-ARTR2/NA/NA 

VERY_SHALLOW 

PASM-BOGR2-CALO/NA/NA 

BOGR2-CAFI/NA/NA 

CALO-PSSP6-PASM/NA/NA 

PASM-BOGR2-JUSC2/NA/NA 

BOGR2-CAFI-JUSC2/NA/NA 

CALO-PSSP6-JUSC2/NA/NA 

SALINE_UPLAND 

SPAI-DISP-ATGA/NA/NA 

SAVE4-DISP/NA/NA 

ATGA-SPAI/NA/NA 

SALINE_LOWLAND 

SAVE4-PASM-SPAI/NA/NA 

SAVE4-DISP/NA/NA 

PASM-SPAI/NA/NA 

Table H-2 Vegetation Descriptions used for the Western Great Plains Steppe. 
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Size class and density are not utilized.  The value “NA” is used for the above species. The single state 

pathway format was developed for these ecosystems. 

Disturbance Processes 

Processes 

SUCCESSION 

LIGHT-BISON-GRAZING 

MODERATE-BISON-GRAZING 

HEAVY-BISON-GRAZING 

STAND-REPLACING-FIRE 

WET-SUCCESSION 

DRY-SUCCESSION 

PRAIRIE-DOG-ACTIVE 

PRAIRIE-DOG-INACTIVE 

Table H-3 Disturbance Processes for the Western Great Plains Steppe. 

 

 

16.8.2 Great Plains Steppe 

 

Ecological Stratification 

Ecosites 

Porous Clay 

Dense Clay 

Clayey 

Claypan 

Loamy 
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Shallow 

Badlands 

Sandy 

Thin Sands 

Saline Upland 

Overflow 

Table H-4 Ecological Stratification for the Great Plains Steppe. 

 

Vegetation Descriptions 

POROUS CLAY  

SCSC-CALO-PASM little bluestem - prairie sandreed - Western wheatgrass 

CALO-SCSC-PASM-CAINH2 prairie sandreed - little bluestem - Western wheatgrass - sun sedge 

CAINH2-KOMA-BOGR2 sun sedge - prairie junegrass - blue grama 

SCSC-CALO-JUCO6-AMCA6 little bluestem - prairie sandreed - juniper - leadplant 

SCSC-PASM-AMCA6-JUCO6 little bluestem - Western wheatgrass - leadplant - juniper 

CAINH2-BOGR2-AMCA6-JUCO6 sun sedge - blue grama - leadplant - juniper 

DENSE CLAY  

ACMIO-VUOC Western yarrow - six weeks fescue 

PASM-NAVI4 Western wheatgrass - green needlegrass 

PASM-NAVI4-BOCU-BOGR2 Western wheatgrass - green needlegrass- sideoats grama - blue grama 

PASM-BOGR2 Western wheatgrass -blue grama 

NAVI4-PASM-ARTR2-KOMA green needlegrass - Western wheatgrass - Wyoming big sagebrush - prairie junegrass 

PASM-NAVI4-BOGR2-ARTR2 Western wheatgrass - green needlegrass - blue grama - Wyoming big sagebrush 

PASM-BOGR2-ARPE6-ARTR2 Western wheatgrass - blue grama - birdfoot sagebrush - Wyoming big sagebrush 

CLAYEY  
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HECO26-ARPUL-GRSQ needle and thread - Fendler threeawn - Curly cup gumweed 

NAVI4-PASM-HECO26-HESP11 Green needlegrass - Western wheatgrass - needle and thread - porcupine grass 

PASM-NAVI4-BOCU-BOGR2 Western wheatgrass - green needlegrass - sideoats grama - blue grama 

BOGR2-BUDA-CAFI-PASM blue grama - buffalograss - threadleaf sedge - Western wheatgrass 

NAVI4-PASM-HECO26-SYOC green needlegrass - Western wheatgrass - needle and thread - Western snowberry 

PASM-NAVI4-BOGR2-SYOC Western wheatgrass - green needlegrass - blue grama - Western snowberry 

BOGR2-PASM-POSE-SYOC blue grama - Western wheatgrass - Sandberg bluegrass - Western snowberry 

CLAYPAN  

HECO26-KOMA-GRSQ needle and thread - prairie junegrass - curly cup gumweed 

ARPUF-VUOC-GRSQ threeawn - six weeks fescue - curly cup gumweed 

PASM-NAVI4-HECO26-CALO Western wheatgrass - green needlegrass - needle and thread - prairie sandreed 

PASM-BOGR2-HECO26 Western wheatgrass - blue grama - needle and thread 

BOGR2-BUDA-OPPO-CAFI blue grama - buffalograss - plains prickley pear - threadleaf sedge 

PASM-NAVI4-HECO26-ARTR2 Western wheatgrass - green needlegrass - needle and thread - Wyoming big sagebrush 

PASM-BOGR2-NAVI4-ARTR2 Western wheatgrass - blue grama - green needlegrass -Wyoming big sagebrush 

BOGR2-BUDA-OPPO-ARTR2 blue grama - buffalograss - plains prickley pear - Wyoming big sagebrush 

LOAMY  

HECO26-ARPUF-GRSQ needle and thread - threeawn - curly cup gumweed 

ARPUF-BOGR2-DYPA threeawn -blue grama - fetid marigold 

NAVI4-PASM-HECO26-ANGE green needlegrass - Western wheatgrass - needle and thread - big bluestem 

PASM-HECO26-BOCU-BOGR2 Western wheatgrass - needle and thread - sideoats grama -blue grama 

BOGR2-BUDA-CAFI blue grama - buffalograss - threadleaf sedge 

NAVI4-PASM-HECO26-ARTR2 Western wheatgrass - needle and thread - needle and thread - Wyoming big sagebrush 

PASM-HECO26-BOCU-ARTR2 Western wheatgrass - needle and thread - sideoats grama -Wyoming big sagebrush 

BOGR2-BUDA-CAFI-ARTR2 blue grama - buffalograss - threadleaf sedge - Wyoming big sagebrush 

SHALLOW  
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ARPUF-HECO26-SCSC threeawn - needle and thread - little bluestem 

HECO26-SCSC-NAVI4-BOCU needle and thread - little bluestem - green needlegrass - sideoats grama 

SCSC-HECO26-BOCU-BOGR2 little bluestem - needle and thread - sideoats grama - blue grama 

BOGR2-BOHI2-CAFI blue grama - hairy grama - threadleaf sedge 

SCSC-HECO26-KOMA-ARTR2 little bluestem - needle and thread - prairie junegrass - Wyoming big sagebrush 

HECO26-SCSC-BOCU-ARTR2 needle and thread - little bluestem - sideoats grama - Wyoming big sagebrush 

BOGR2-BOHI2-CAFI-ARTR2 blue grama - hairy grama - threadleaf sedge - Wyoming big sagebrush 

SANDY  

ARPUF-HECO26-SPCR threeawn - needle and thread - sand dropseed 

ANHA-CALO-HECO26-SCSC sand bluestem - prairie sandreed - needle and thread - little bluestem 

PASM-HECO26-SPCR-BOGR2 Western wheatgrass - needle and thread - sand dropseed - blue grama 

BOGR2-BOHI2-CAFI blue grama - hairy grama - threadleaf sedge 

ANHA-CALO-YUGL-ARCA13 sand bluestem - prairie sandreed - yucca - silver sagebrush 

PASM-HECO26-YUGL-ARCA13 western wheat grass - needle and thread - yucca - silver sagebrush 

BOGR2-BOHI2-ARCA13-YUGL blue grama - hairy grama - silver sagebrush - yucca 

THIN SANDS  

CALO-ANHA-SCSC-ANGE prairie sandreed - sand bluestem - little bluestem - big bluestem 

BOGR2-CAFI-SCSC-HECO26 blue grama - threadleaf sedge - little bluestem - needle and thread 

HECO26-PASM-DIOLS-SPCR needle and thread - Western wheatgrass - Scribner panicum - sand dropseed 

CALO-SCSC-OPPO-YUGL Prairie sandreed - little bluestem - plains prickley pear - yucca 

HECO26-BOGR2-OPPO-JUHO2 needle and thread - blue grama - plains prickley pear - creeping juniper 

HECO26-PASM-JUHO2-ROAR3 needle and thread - Western wheatgrass - Creeping/Rocky Mtn. juniper - prairie rose 

SALINE UPLAND  

PASM-DISP-SPAI-ACHY Western wheatgrass - inland saltgrass - alkali sacaton - indian ricegrass 

PASM-DISP-SPAI-CAFI Western wheatgrass - inland saltgrass - alkali sacaton - threadleaf sedge 

DISP-CAFI-KOMA-BOGR2 inland saltgrass - threadleaf sedge - prairie junegrass -blue grama 
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PASM-DISP-SPAI-ATGA Western wheatgrass - inland saltgrass - alkali sacaton - Gardner's saltbush 

PASM-DISP-ATGA-SAVE4 Western wheatgrass - inland saltgrass - Gardner's saltbush - greasewood 

DISP-CAFI-KOMA-SAVE4 inland saltgrass - threadleaf sedge - prairie junegrass - greasewood 

BADLANDS  

ARPUF-HECO26-SPCR Fendler threeawn - Needle and thread - sand dropseed 

CALO-SCSC-PASM-ANGE prairie sandreed - little bluestem - Western wheatgrass - big bluestem 

PASM-SCSC-CALO-DISP Western wheatgrass - little bluestem - prairie sandreed - inland saltgrass 

DISP-PASM inland saltgrass - Western wheatgrass 

CALO-SCSC-PASM-ARTR2 prairie sandreed - little bluestem - Western wheatgrass - silver/big sagebrush 

PASM-SCSC-DISP-ARTR2 western wheatgrass - little bluestem -  inland saltgrass - silver/big sagebrush 

DISP-PASM-ARTR2 inland saltgrass - Western wheatgrass - silver/big sagebrush 

OVERFLOW  

ANGE-NAVI4-PAVI2-PASM big bluestem - green needlegrass - switchgrass - Western wheatgrass 

BOGR2-PASM blue grama - Western wheatgrass 

ANGE-NAVI4-PAVI2 big bluestem - green needlegrass - switchgrass 

PASM-ARCA13-ARTR2 Western wheatgrass - silver sagebrush - big sagebrush 

BOGR2-PASM-ARTR2 blue grama - Western wheatgrass - big sagebrush 

SYOC-ARTR2-PASM Western snowberry - big sagebrush - Western wheatgrass 

WATER water 

Table H-5 Vegetation Descriptions by Ecological Stratification used in the Great Plains Steppe. 
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Disturbance Processes 

 

Processes 

SUCCESSION 

LIGHT-BISON-GRAZING 

HEAVY-BISON-GRAZING 

STAND-REPLACING-FIRE 

WET-SUCCESSION 

DRY-SUCCESSION 

PRAIRIE-DOG-ACTIVE 

PRAIRIE-DOG-INACTIVE 

Table H-6 Disturbance Processes used in the Great Plains Steppe. 
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16.8.3 Mixed Grass Prairie 

 

Ecological Stratification 

Ecosites 

Dense Clay 

Clayey 

Shallow Clayey 

Claypan 

Loamy 

Sandy 

Shallow 

Very Shallow 

Water 

Gullied Land 

Table H-7 Ecological Stratification used in the Mixed Grass Prairie. 

 

 

Vegetation Descriptions  

MIXED GRASS PRAIRIE 

DENSE CLAY  

NAVI4-PASM green needlegrass - Western wheatgrass 

PASM-NAVI4-CAREX Western wheatgrass - green needlegrass - sedges 

CAREX-PASM sedges - Western wheatgrass 

NAVI4-PASM-SYOC green needlegrass - Western wheatgrass - Western snowberry 
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MIXED GRASS PRAIRIE 

PASM-NAVI4-CAREX-SYOC Western wheatgrass - green needlegrass - sedges - Western snowberry 

CAREX-PASM-SYOC sedges - Western wheatgrass - Western snowberry 

CLAYEY  

ARPU9-VUOC-KOMA purple threeawn - six weeks fescue - prairie junegrass 

NAVI4-PASM-HESP11 green needlegrass - Western wheatgrass - porcupine grass  

PASM-HECO26-BOGR2 Western wheatgrass - needle and thread - blue grama 

BOGR2-CAREX-PASM blue grama - sedges - Western wheatgrass 

NAVI4-PASM-HESP11-SYOC green needlegrass - Western wheatgrass - porcupine grass - Western snowberry 

PASM-HECO26-BOGR2-SYOC Western wheatgrass - needle and thread - blue grama - Western snowberry 

BOGR2-CAREX-SYOC blue grama - sedges - Western snowberry 

SHALLOW CLAYEY  

ARPU9-VUOC-KOMA purple threeawn - six weeks fescue - prairie junegrass 

NAVI4-PASM-ANGE-SCSC green needlegrass - Western wheatgrass - big bluestem - little bluestem 

PASM-BOCU-ANGE Western wheatgrass - sideoats grama - big bluestem  

BOGR2-POA-CAREX blue grama - bluegrasses - sedges 

NAVI4-PASM-ANGE-QUMA2 green needlegrass - Western wheatgrass - big bluestem - bur oak 

PASM-BOCU-ANGE-QUMA2 Western wheatgrass - sideoats grama - big bluestem - bur oak 

BOGR2-CAREX-QUMA2 blue grama - sedges - bur oak 

CLAYPAN  

VUOC-HECO26-GRSQ six weeks fescue - needle and thread - curly cup gumweed 

NAVI4-PASM-HECO26 green needlegrass - Western wheatgrass - needle and thread 

PASM-BOGR2-HECO26 Western wheatgrass - blue grama -needle and thread 

BOGR2-POSE-BUDA blue grama - Sandberg bluegrass - buffalograss 

HECO26-PASM-NAVI4-GUSA2 needle and thread - Western wheatgrass - green needlegrass - broom snakeweed 
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MIXED GRASS PRAIRIE 

PASM-BOGR2-HECO26-GUSA2 Western wheatgrass - blue grama - needle and thread - broom snakeweed 

BOGR2-POSE-BUDA-GUSA2 blue grama - Sandberg bluegrass - buffalograss - broom snakeweed 

LOAMY  

ARPU9-VUOC-HECO26 purple threeawn - six weeks fescue - needle and thread 

NAVI4-PASM-HESP11 green needlegrass - Western wheatgrass - porcupine grass 

PASM-HECO26-BOCU Western wheatgrass - needle and thread - sideoats grama  

BOGR2-CAFI blue grama - threadleaf sedge 

NAVI4-PASM-HESP11-SYOC green needlegrass - Western wheatgrass - porcupine grass - Western snowberry 

PASM-HECO26-BOCU-SYOC western wheatgrass - needle and thread - sideoats grama -Western snowberry 

BOGR2-CAREX-SYOC blue grama - sedges - Western snowberry 

SANDY  

ARPU9-SPCR-GRSQ purple threeawn - sand dropseed - curlycup gumweed 

ANHA-CALO-ANGE sand bluestem - prairie sandreed - big bluestem 

HECO26-PASM-BOGR2 needle and thread - Western wheatgrass - blue grama 

CAFI-BOGR2-HECO26 threadleaf sedge - blue grama - needle and thread 

ANHA-CALO-ANGE-SYOC sand bluestem - prairie sandreed - big bluestem - Western snowberry 

HECO26-PASM-BOGR2-SYOC needle and thread - Western wheatgrass - blue grama - Western snowberry 

CAFI-BOGR2-HECO26-SYOC threadleaf sedge - blue grama - needle and thread - Western snowberry 

SHALLOW  

ARPU9-VUOC purple threeawn - six weeks fescue  

NAVI4-SCSC-MUCU3 green needlegrass - little bluestem - plains muhly  

PASM-NAVI4-BOCU Western wheatgrass - green needlegrass - sideoats grama 

BOGR2-CAREX blue grama - sedges 

NAVI4-SCSC-MUCU3-SYOC green needlegrass - little bluestem - plains muhly - Western snowberry 
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MIXED GRASS PRAIRIE 

PASM-NAVI4-SYOC Western wheatgrass - green needlegrass - Western snowberry 

BOGR2-CAREX-SYOC blue grama - sedges - Western snowberry 

VERY SHALLOW  

ARPU9-VUOC-GRSQ purple threeawn - six weeks fescue - curlycup gumweed 

HECO26-SCSC-MUCU3 needle and thread - little bluestem - plains muhley 

HECO26-PASM-BOGR2 needle and thread - Western wheatgrass - blue grama 

BOGR2-CAFI blue grama - threadleaf sedge  

HECO26-SCSC-MUCU3-SYOC needle and thread - little bluestem - plains muhley - Western snowberry 

HECO26-PASM-BOGR2-SYOC needle and thread - Western wheatgrass - blue grama- Western snowberry 

BOGR2-CAFI-SYOC blue grama - threadleaf sedge - Western snowberry 

note: Not including Bare Ground in 

species code. 

POA is used for Bluegrasses 

CAREX is used for sedges 

species starting point on coverage is 1.2 

Table H-8 Vegetation Descriptions by Ecological Stratification used for the Mixed Grass Prairie. 
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Disturbance Processes 

Processes 

SUCCESSION 

LIGHT-BISON-GRAZING 

HEAVY-BISON-GRAZING 

STAND-REPLACING-FIRE 

WET-SUCCESSION 

DRY-SUCCESSION 

PRAIRIE-DOG-ACTIVE 

PRAIRIE-DOG-INACTIVE 

Table H-9 Disturbance Processes used in the Mixed Grass Prairie. 

 

Discussion of System Knowledge 

Ecological Stratification 

The use of NRCS soil ecosystems as ecological stratification is common in all three geographic zones. 

Vegetative Descriptions by Ecological Stratification 

For non forest communities, a sizeclass-structure or density is not used. These two attributes are coded 

as “NA.” Thus, the pathway diagrams contain only one state. Upon editing the state, there are two new 

choices:  Inclusion Rule and Species to Track. Both of these can be edited through the screens, not only 

changing the percents, but species can be added or deleted. The values in rate of change for species 

may be less than whole percents. 

If the species value in the attributes file that came from the cover is greater than zero but there is no 

species change information for it within the pathway files, it will be brought in, but the species value will 

not change in simulations. In this case, the user can edit the pathway file, adding in change values for 

this new species. 

These values can also be entered in by reading from an Excel spreadsheet by selecting File > Import 

Species Change File. 
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Figure H-10 File options of Importing Species Change File and Inclusion File. 

 

 

Aquatic Unit Representation 

Aquatic units were utilized to provide a water source for the bison grazing logic. The class uses the 

stream layer plus the polygons of water that are converted to a line to go with the streams. Each has to 

be identified as either perennial or intermittent. The logic for what is considered a water source in 

normal, dry, or wet time steps is not accessible for user change in this version. 

There is no report that gives the total water source at any time step. But the existing vegetation unit 

history will show, for each vegetation unit, the distance to the nearest water source (distance used in 

bison grazing logic) and the aquatic unit that is the source and its status. 

The intermittent aquatic units will only be considered a water source in wet time steps. In normal or dry 

time steps, they are not a water source.  Future versions may have additional logic for changes in the 

size of water sources that are polygons. 

Current logic for determining water source:  

Time step with “normal succession” water sources are: 

Water/water/1 polygons 

Plant communities on clayey-overflow  

Existing aquatic units that are “perennial” 
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Time step with “wet succession” water sources are: 

Water/water/1 polygons 

Plant communities on clayey-overflow 

Existing aquatic units that are “perennial” or “intermittent” 

Time step with “dry succession” water sources are: 

Water/water/1 polygons  

Existing aquatic units that are “perennial” 

Time Steps 

By default, these three zones use yearly time steps. Within the year, all four seasons are accounted for. 

This makes it possible for the grass communities to be more responsive to seasonal moisture changes. 

This makes a significant change in the display for EVU history. 

 
Figure H-11 Unit display showing differences with seasons for disturbance processes. 
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It also has an impact on the reports. For processes we report all of them, so for a time step the sum of 

the acres of processes can be greater than the total landscape. For other attributes we take the only the 

last vegetation state at the end of the time step. 

Processes 

Bison Grazing 

The Bison Grazing Logic screen makes the distinction between temporary and permanent water 

sources. The first step in editing bison grazing is to decide if the basic probability for all acres will be 100 

percent or not. Specific exceptions can be listed. If you do not want any bison grazing you must change 

the default probability to zero. Changing the probabilities of the weights for each component, but still 

keeping the default with some value, is not the correct method. This will still result in Light Bison 

Grazing. The three components can have their weight spread in given distribution. One can even shift all 

the weight to one component. 
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Figure H-12  System knowledge screen for the probability of bison grazing. 

 

 

A cell cannot have less than the percent assigned as the weight. 

Fire—Season of Fire 

Although there is a screen for assigning the probability of the season that a fire may occur, it is not 

operational yet. All fires occur in the Fall in version 2.5. 
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Figure H-13 Screen for setting the probability of the season of the fire process. 

 

 

Prairie Dog  

This process must be locked in. There is no logic for predicting its occurrence. 

Regeneration logic  

If there is any Species to Track Information available we will not call the Regeneration logic as a result of 

SRF.  

For the case of Heavy-bison-grazing and Prairie-dog-active processes the “fire-event” logic is expanded 

so it is not just dependent on the probability of an event occurring. If the past time step process has 

been one of these processes, the plant community cannot get a fire event. In the long run we will have a 

screen to edit the logic that goes along with the fire-event. 

The valid values are given for the three zones. All values are for non forested species. Future landscapes 

within theses geographic zones can include tree species. Version 2.5 can represent landscapes with both 

forms of pathways. Non forest species with single states, not using size class and density, and forest 

species with multiple states using Sizeclass and density. 

  

USDA Forest Service Gen. Tech. Rep. RMRS-GTR-268WWW. 2012 332



  

16.9  APPENDIX I—COLORADO PLATEAU  

The development of this geographic zone was accomplished in connection with USGS’s FRAMES project 
for Mesa Verde National Park. This effort involved a number of scientists and managers from USGS, 
Mesa Verde National Park, Colorado State University, Northern Arizona University, and Prescott College. 
 

Ecological Stratification 

Soils information from a range of surveys was used to provide a stratification that used a combination of 

soil depth, slope steepness, and moist or xeric aspect. 

 

SIMPPLLE Descriptor Substrate Slope Aspect 

MSM Mancos Steep Mesic 

MSX Mancos Steep Xeric 

MMM Mancos Moderate Mesic 

MMX Mancos Moderate Xeric 

MGM Mancos Gentle Mesic 

MGX Mancos Gentle Xeric 

DSM Deep-soils Steep Mesic 

DSX Deep-soils Steep Xeric 

DMM Deep-soils Moderate Mesic 

DMX Deep-soils Moderate Xeric 

DGM Deep-soils Gentle Mesic 

DGX Deep-soils Gentle Xeric 

SSM Shallow-soils Steep Mesic 

SSX Shallow-soils Steep Xeric 

SMM Shallow-soils Moderate Mesic 

SMX Shallow-soils Moderate Xeric 

SGM Shallow-soils Gentle Mesic 
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SGX Shallow-soils Gentle Xeric 

Table I-1 Ecological Stratification used for the Colorado Plateau. 

 

Vegetation Descriptions 

A combination of inventories from State gap program and Mesa Verde National Park were used. 
Narrative descriptions from documentation that was developed for RMLands modeling efforts were 
used to identify common combinations of trees, shrubs, and grasses. 

Numerous workshops with scientists, resource specialists, and managers were used to get agreement on 
final assignment within SIMPPLLE. The following three tables display the combinations used for each life 
form. 

 

 

Inventory Assignment 

SIMPPLLE Trees 

Species Size Density 

Aspen POTR5 LARGE 3 

Aspen- Douglas-fir- spruce-fir PSME-PIEN-ABLA-POTR5 VERY-LARGE 3 

Cool-moist mixed conifer PSME-PIEN-ABLA VERY-LARGE 3 

Greasewood    

High elevation sagebrush    

Low elevation sagebrush PIED-JUOS LARGE-MULTISTORY 1 

Meadow (high elevation)    

NS (Spruce-fir forest)    

NS (Aspen- Douglas-fir)    

Oak-service berry shrubland    

PJ oak-serviceberry woodland PIED-JUOS LARGE-MULTISTORY 2 

PJ Woodland PIED-JUOS LARGE-MULTISTORY 3 

Ponderosa pine-oak PIPO LARGE 3 

Riparian    
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Inventory Assignment 

SIMPPLLE Trees 

Species Size Density 

 (high elevation 

 above 9,000) 

Riparian 

(mid-elevation 

6,500 to 9,000) 

   

Riparian 

(low elevation 

below 6,500) 

   

Semi-desert grassland    

Semi-desert savannah PIED-JUOS LARGE-MULTISTORY 2 

Sparse PJ woodland PIED-JUOS LARGE-MULTISTORY 1 

Spruce-fir forest PIEN-ABLA VERY-LARGE 3 

Agriculture  AGR AGR 1 

Urban URBAN URBAN 1 

Non-forest NF NF 1 

Barren BA BA 1 

Water WATER WATER 1 

Table I-2 Trees used for the Colorado Plateau. 

 

Inventory Assignment 

SIMPPLLE Shrubs 

Species Size Density 

Aspen SYORO MEDIUM-SH 1 

Aspen- Douglas-fir- spruce-fir LOIN5 LARGE-SH 1 
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Inventory Assignment 

SIMPPLLE Shrubs 

Species Size Density 

Cool-moist mixed conifer LOIN5 LARGE-SH 1 

Greasewood SAVE4 MEDIUM-SH 2 

High elevation sagebrush ARTR2-PUTR2 MEDIUM-SH 3 

Low elevation sagebrush ARBI3 MEDIUM-SH 2 

Meadow (high elevation)    

NS (Spruce-fir forest)    

NS (Aspen- Douglas-fir)    

Oak-service berry shrubland QUGA LARGE-SH 3 

PJ oak-serviceberry woodland QUGA MEDIUM-SH 2 

PJ Woodland ARNO4-PUTR2 MEDIUM-SH 2 

Ponderosa pine-oak QUGA-AMUT MEDIUM-SH 2 

Riparian 

 (high elevation 

 above 9,000) 

SAGE2 MEDIUM-SH 3 

Riparian 

(mid-elevation 

6,500 to 9,000) 

ALINT LARGE-SH 3 

Riparian 

(low elevation 

below 6,500) 

SAEX LARGE-SH 3 

Semi-desert grassland ATCO-ARBI3 MEDIUM-SH 2 

Semi-desert savannah ATCO-ARBI3 MEDIUM-SH 2 

Sparse PJ woodland ARBI3 MEDIUM-SH 2 

Spruce-fir forest VAMY2-RIMO2 MEDIUM-SH 1 
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Inventory Assignment 

SIMPPLLE Shrubs 

Species Size Density 

Agriculture     

Urban    

Non-forest    

Barren    

Water    

Table I-3 Shrubs used for the Colorado Plateau. 

 

 

 

 

 

Inventory Assignment 

SIMPPLLE Herbaceous 

Species Size Density 

Aspen THFE UNIFORM 2 

Aspen- Douglas-fir- spruce-fir ORSE CLUMPED 1 

Cool-moist mixed conifer ORSE CLUMPED 1 

Greasewood SPAI CLUMPED 1 

High elevation sagebrush POPR-VIAM UNIFORM 2 

Low elevation sagebrush    

Meadow (high elevation) THFE UNIFORM 3 

NS (Spruce-fir forest) GERI CLUMPED 3 

NS (Aspen- Douglas-fir) ORSE UNIFORM 3 

Oak-service berry shrubland POFE CLUMPED 2 
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Inventory Assignment 

SIMPPLLE Herbaceous 

Species Size Density 

PJ oak-serviceberry woodland POFE CLUMPED 2 

PJ Woodland POSE-PASM UNIFORM 1 

Ponderosa pine-oak FEAR2 CLUMPED 1 

Riparian 

 (high elevation 

 above 9,000) 

   

Riparian 

(mid-elevation 

6,500 to 9,000) 

   

Riparian 

(low elevation 

below 6,500) 

   

Semi-desert grassland ACHY CLUMPED 2 

Semi-desert savannah HECO26-PLJA UNIFORM 2 

Sparse PJ woodland    

Spruce-fir forest GERI CLUMPED 1 

Agriculture     

Urban    

Non-forest    

Barren    

Water    

Table I-4 Herbaceous used for the Colorado Plateau. 
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Size SIMPPLLE Abbreviation XXXX 

Trees 

Established Seedlings E 0.0–0.9-inches DBH 

Sapling SS 1–4.9-inches DBH 

Medium  MEDIUM 5–8.9-inches DBH 

Large LARGE 9–15.9-inches DBH 

Very Large VERY-LARGE >16-inches DBH 

Non-stocked NS  

Medium-Multistory MMU  

Large-Multistory LMU  

Very Large-Multistory VLMU  

Shrubs  

Small SMALL-SH < 2.5 feet in height 

Medium MEDIUM-SH 2.5–6.4 feet in height 

Large LARGE-SH > 6.5 feet in height 

Grasses 

Clumped CLUMPED  

Uniform UNIFORM  

Non forest  

Non forest NF  

barren ba  

urban urban  

agriculture agr  

Table I-5 Size Classes used for the Colorado Plateau. 
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SIMMPPLLE 

Abbreviation 
Density 

1 0–10 percent 

2 11–40 percent 

3 41–70 percent 

4 71–100 percent 

Table I-6 Density used for the Colorado Plateau. 
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PROCESS 

LIGHT SEVERITY FIRE 

MIXED SEVERITY FIRE 

STAND REPLACING FIRE 

PONDEROSA PINE MOUNTAIN PINE BEETLE 

SPRUCE BEETLE 

DOUGLAS FIR BEETLE 

LIGHT WESTERN SPRUCE BUDWORM 

SEVERE WESTERN SPRUCE BUDWORM 

WILDLIFE BROWSING 

PINYON BARK BEETLE 

HIGH MORTALITY PRAIRIE DOG 

LOW MORTALITY PRAIRIE DOG 

WINDTHROW 

WET SUCCESSION 

DRY SUCCESSION 

SUCCESSION 

BLACK-STAIN ROOT DISEASE 

DROUGHT 

Table I-7 Disturbance Processes used for the Colorado Plateau. 

 

Invasive Species 

The logic in SIMPPLLE was based on research funded by Joint Fire Science Program, project number 

1469-BLM2-454, Non-Native Invasions Following Fire in Southwestern Colorado: Long-Term 

Effectiveness of Mitigation Treatments and Future Predictions, Hanna et al. 2004. 
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16.10 APPENDIX J—BASIC PROCESSING EXCEL SPREADSHEET AND MACRO  

INSTRUCTIONS: 

This macro is designed to work with the results from multiple simulations on the same landscape. The 

purpose is to enable comparisons between differences in simulations due to changes in the system logic 

or changes due to different management scenarios. It is not intended to compare different landscapes. 

It does not work with a single simulation. It utilizes the file that contains the results from a set(s) of 

multiple simulations.  

This macro processes each data type (processes, species, sizeclass / structure, and density) separately. 

There is no correlation between these values. If you want to process specific combinations of 

species/sizeclass/density then use the “all-states-report,” the “SIMPPLLE MACRO - ALL-STATES-REPORT-

26Augl2006.xls”. 

USING THE MACRO 

Open spreadsheet (SIMPPLLE  V2-2_90205.xls) 

Enable macros in the opening 

Select NEW DATA 

Browse to find the desired “ -ls.txt” file(s)  

Select OK  

(In future versions we may add the option to put together ls.txt files from different sets of simulations 

when it takes too much memory to do all the desired number in one set)  

Then select individual data types or all of them 

After the macro is complete, save results as a spreadsheet  *.xls, don’t save over the  

*-ls.txt file 

This will put the results from each set of multiple simulations in a separate spreadsheet  

with each data type being in a workbook. It calculates the following values for each time step using all f 

simulations: 

 Maximum 

 Minimum 
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 Average 

 Standard Deviation 

 Medium 

 Mode 

A line plot of the values for each time step for each simulation is automatically created. 

Two additional graphic displays can be selected. 

The Maximum, Minimum, and Average values for each attribute (each individual process, species, size 

class, or density) can be created. The values are for the entire set of time steps for the entire number of 

simulations. This graphic is generated using the “stock chart type,” using the High (Maximum), Low 

(Minimum) and Close (Average, or Medium, or Mode) values. The user needs to specify what attributes 

from each type should be plotted as one will probably not want to see the graphic for all processes, 

species, or sizeclass. 

Column graphs for the percent (based on Mean, Medium, or Mode) that each species, sizeclass, or 

density is of the total landscape acres by time step can be generated. This uses the average or medium 

or modal value as specified by the user. The user needs to specify what attributes from each type should 

be plotted as one will probably not want to see graphics for all processes, species, or sizeclass. 

If you want to save the results as a spreadsheet (don’t save by overriding the original *-ls.txt file), you 

have to specify that when you close the file. The saved results can be used later in the “COMPARISON” 

option.  

If you want to compare two or more sets of multiple simulations with the results from above: 

 Open spreadsheet Simpplle_Output_Macros.xls 

 Enable macros in opening 

 Select Create Comparison 

 Browse to find saved Excel (*.xls) files (results from New Data)  

 Select as many as you would like (two minimum) 

 Save (name must be in quotes) 

 Select OK  
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The graphics automatically created in the OVERVIEW will only be line plot comparisons for each process, 

species, sizeclass and density. The user needs to select where the comparison is done with the Average, 

Medium, or Modal values. 

An optional stacked column chart comparing the percent distribution of the fire process into its three 

components (stand replacing fire, mixed severity fire, and light severity fire) can be chosen. User can 

select if the Average across all time steps, all simulations in used, or if the Average for only the last time 

step of all simulations is used. 

CHART OPTIONS—Summary 

Options vary by whether you are doing “basic processing” or the “overview” comparison. 

Basic—Processing: 

Standard --- A line plot of each value of each data type, all time steps for each                        

simulation. 

Optional --- A Max, Min, Average (or Median or Modal) plot for selected values of selected data 

types. Values are taken from all time steps, all simulations. 

A column chart showing percent of total landscape acres by time step for selected 

species, sizeclass, or density values. 

Overview: 

Standard --- A line plot that compares the average value over the time steps between each set 

of multiple simulations. Plot is made for each value for each data type (process, 

species, sizeclass and density) 

 

Optional --- Change the above line plot to use Median or Modal value. 

 

A stacked column chart using percent distribution of the fire processes between 

the stand replacing fire, mixed severity fire, and light severity fire. Within this 

choice, an option to display for all time steps, or just the last time step. The 

percents are averages across all time steps, all simulations, or just the last time 

step, across all simulations.  
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16.11 APPENDIX K—ALL STATES EXCEL SPREADSHEET AND PIVOT TABLES  

CREATING THE REPORT 

The All States Report was designed to provide the capability to track all individual states, each 

combination of species/size class—structure/density. The report is designed to identify the maximum, 

minimum, average, and standard deviation for each state; the results from multiple simulations. This 

report requires an output file generated by SIMPPLLE and the use of an Excel template. You must have 

Excel 2002 to run the macros in the Report Template. 

If the report is run on all individual states, it may take considerable time to complete. Most likely the 

report will be done on “groupings” of the states (i.e., the grouping used for the standard Regional 

Diversity Matrix). 

The current version of SIMPPLLE does not have a complete user interface to query the user for the 

desired grouping. Instead, the system asks for the name of a text (*.txt) file that contains the 

information to create groups. Many text files for different groupings may be made. 

Steps: 

1. Create a text (*.txt) file that contains grouping information. 

2a. Make multiple simulations. From the main menu select Reports > All States Report (Figure K1) if 

you are not discarding any simulation data.  If you have made the choice to Discard Unnecessary 

Simulation Data, then you have to check the All States Report and identify the input text file 

prior to making the simulations. 

OR 

2b. Reload the saved simulation that is the last one made in the sequence of multiple simulations 

and run the report—only if the simulations were made without discarding information. 
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Figure K-1 The choice of the All States Report from the SIMPPLLE Reports pulldown menu. 

 

 

3. In running the report, provide the name of the text (*.txt) file that has the grouping information, 

and provide a name for the resulting output file that will have a text (*.txt) extension. 

4. Execute the Report Template spreadsheet. Make sure macros are enabled. 
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Figure K-2 The main screen for the All States Report Macro. 

 

5.  Select choices available for the All States Report. 

6. Save the results as an Excel (*.xls) file. 

THE “GROUPING TXT FILE” 

If values were missed when the groups were created, the missed individuals will show up in the reports 

in the Template. 

A title can be used by entering information beyond the “BEGIN” key word. 

All states report customization file format (*.txt): 

Valid Keywords: 

SPECIES 

SIZE-CLASS 

DENSITY 

HABITAT-TYPE-GROUP 
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SPECIAL-AREA 

OWNERSHIP 

{ and } server to illustrate format and are not part of it. 

{< or >}{ITEM} means either < or > followed by ITEM (e.g. <9) 

{comma} means insert a Comma. 

There can be as many keywords as you like and each can be listed multiple times. 

----------------File format -------------------------------------------------- 

{BEGIN}{comma}{OPTIONAL DESCRIPTION} 

{KEYWORD}{space}{OPTIONAL-DESCRIPTION} 

{ITEM1}{comma}{ITEM2}{comma}{ITEM3}… 

{KEYWORD}{space}{OPTIONAL-DESCRIPTION} 

{ITEM1}{comma}{ITEM2}{comma}{ITEM3}… 

{AGE}{space}{OPTIONAL-DESCRIPTION} 

{ITEM1}{comma}{ITEM2}{comma}{ITEM3}… 

END 

Example : 

BEGIN 

HABITAT-TYPE-GROUP For 

A1,A2,B1,B2,B3,C1,C2,D1,D2,D3,E1,E2,F1,F2,G1,G2 

HABITAT-TYPE-GROUP NonFor 

NF1A,NF1B,NF1C,NF2A,NF2B,NF2C,NF2D,NF3A,NF3B,NF3C,NF3D,NF4A,NF4B,NF4C,NF4D,NF4E,NF5A,NF

5B 

SPECIES TASH 

AF,ES,WB,MH,AF-ES-MH,ES-AF 

SPECIES TGCH 
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GF,C,WH,WH-C,WH-C-GF 

SPECIES IMXS 

L-DF,L-DF-AF,L-DF-ES,L-DF-GF,L-DF-PP,L-DF-WP,L-DF-LP,L-DF-RRWP,L-ES,L-ES-AF,L-GF,L-LP,L-LP-GF,L-

PP,L-PP-LP,L-RRWP-GF,L-WP,L-WP-GF,WB-ES-AF,AL,AL-AF,AL-WB-AF 

SPECIES DF-PP-MIX 

PP-DF,PF 

SPECIES LP 

LP,LP-AF,LP-GF 

SPECIES DF 

DF,DF-ES,DF-AF,DF-LP,DF-GF,DF-LP-AF,DF-LP-ES,DF-LP-GF,DF-PP-GF,DF-WP,DF-WP-GF,DF-RRWP,DF-

RRWP-GF,DF-PP-GF,DF-PP-LP 

SPECIES PP 

PP 

SPECIES WL 

L 

SPECIES UMD 

QA,QA-MC 

SPECIES RIPHD 

CW,CW-MC 

SPECIES GFS 

ALPINE-GRASSES,ALTERED-GRASSES,NATIVE-FORBS 

SPECIES MMS 

MESIC-SHRUBS 

SPECIES MXS 

XERIC-SHRUBS 
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SIZE-CLASS 1-5 

ss 

SIZE-CLASS 5-9 

pole,pts,pmu 

SIZE-CLASS 9+ 

medium,mts,mmu,large,lmu,lts,very-large,vlmu,vlts 

SIZE-CLASS  

closed-herb,closed-low-shrub,clumped,open-herb,open-low-shrub,open-mid-shrub,open-tall-

shrub,scattered,uniform 

END 

You can make multiple sets of keywords within one text file. SIMPPLLE will produce separate output files 

for each set. 

BEGIN 

SPECIAL-AREA s 

suitable 

HABITAT-TYPE-GROUP For 

A1,A2,B1,B2,B3,C1,C2,D1,D2,D3,E1,E2,F1,F2,G1,G2 

HABITAT-TYPE-GROUP NonFor 

NF1A,NF1B,NF1C,NF2A,NF2B,NF2C,NF2D,NF3A,NF3B,NF3C,NF3D,NF4A,NF4B,NF4C,NF4D,NF4E,NF5A,NF

5B 

SPECIES TASCH 

AF,ES,WB,MH,AF-ES-MH,ES-AF 

SPECIES TACH  

GF,C,WH,WH-C,WH-C-GF 

SPECIES IMXS 
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L-DF,L-DF-AF,L-DF-ES,L-DF-GF,L-DF-PP,L-DF-WP,L-DF-LP,L-DF-RRWP,L-ES,L-ES-AF,L-GF,L-LP,L-LP-GF,L-

PP,L-PP-LP,L-RRWP-GF,L-WP,L-WP-GF,WB-ES-AF,AL,AL-AF,AL-WB-AF 

SPECIES DF-PP-MIX 

PP-DF,PF 

SPECIES LP 

LP,LP-AF,LP-GF 

SPECIES DF 

DF,DF-ES,DF-AF,DF-LP,DF-GF,DF-LP-AF,DF-LP-ES,DF-LP-GF,DF-PP-GF,DF-WP,DF-WP-GF,DF-RRWP,DF-

RRWP-GF,DF-PP-GF,DF-PP-LP 

SPECIES PP 

PP 

SPECIES WL 

L 

SPECIES UMD 

QA,QA-MC 

SPECIES RIPHD 

CW,CW-MC 

SPECIES GFS 

ALPINE-GRASSES,ALTERED-GRASSES,NATIVE-FORBS 

SPECIES MMS 

MESIC-SHRUBS 

SPECIES MXS 

XERIC-SHRUBS 

SIZE-CLASS 1-5 

ss 
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SIZE-CLASS 5-9 

pole,pts,pmu 

SIZE-CLASS 9+ 

medium,mts,mmu,large,lmu,lts,very-large,vlmu,vlts 

SIZE-CLASS  

closed-herb,closed-low-shrub,clumped,open-herb,open-low-shrub,open-mid-shrub,open-tall-

shrub,scattered,uniform 

END 

BEGIN 

SPECIAL-AREA ns 

UNKNOWN 

HABITAT-TYPE-GROUP For 

A1,A2,B1,B2,B3,C1,C2,D1,D2,D3,E1,E2,F1,F2,G1,G2 

HABITAT-TYPE-GROUP NonFor 

NF1A,NF1B,NF1C,NF2A,NF2B,NF2C,NF2D,NF3A,NF3B,NF3C,NF3D,NF4A,NF4B,NF4C,NF4D,NF4E,NF5A,NF

5B 

SPECIES TASCH 

AF,ES,WB,MH,AF-ES-MH,ES-AF 

SPECIES TACH 

GF,C,WH,WH-C,WH-C-GF 

SPECIES IMXS 

L-DF,L-DF-AF,L-DF-ES,L-DF-GF,L-DF-PP,L-DF-WP,L-DF-LP,L-DF-RRWP,L-ES,L-ES-AF,L-GF,L-LP,L-LP-GF,L-

PP,L-PP-LP,L-RRWP-GF,L-WP,L-WP-GF,WB-ES-AF,AL,AL-AF,AL-WB-AF 

SPECIES DF-PP-MIX 

PP-DF,PF 

SPECIES LP 
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LP,LP-AF,LP-GF 

SPECIES DF 

DF,DF-ES,DF-AF,DF-LP,DF-GF,DF-LP-AF,DF-LP-ES,DF-LP-GF,DF-PP-GF,DF-WP,DF-WP-GF,DF-RRWP,DF-

RRWP-GF,DF-PP-GF,DF-PP-LP 

SPECIES PP 

PP 

SPECIES WL 

L 

SPECIES UMD 

QA,QA-MC 

SPECIES RIPHD 

CW,CW-MC 

SPECIES GFS 

ALPINE-GRASSES,ALTERED-GRASSES,NATIVE-FORBS 

SPECIES MMS 

MESIC-SHRUBS 

SPECIES MXS 

XERIC-SHRUBS 

SIZE-CLASS 1-5 

ss 

SIZE-CLASS 5-9 

pole,pts,pmu 

SIZE-CLASS 9+ 

medium,mts,mmu,large,lmu,lts,very-large,vlmu,vlts 

SIZE-CLASS  
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closed-herb,closed-low-shrub,clumped,open-herb,open-low-shrub,open-mid-shrub,open-tall-

shrub,scattered,uniform 

END 
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16.12 APPENDIX L—TRACKING SPECIES EXCEL SPREADSHEET AND MACRO  

The Excel spreadsheet and macro are designed to provide the acres of the species being tracked by 

percent categories that the user identifies. 

The Set Simulation Parameters screen (Figure L-1) has a check box for selecting an output file to be 

generated that provides input for this spreadsheet. 

 

 
Figure L-1 Set Simulation Parameters Screen. 

Selecting Adjust Categories brings up the Tracking Species Report Categories screen (Figure L-2), 

allowing the user to make changes in the percent categories by species. 

USDA Forest Service Gen. Tech. Rep. RMRS-GTR-268WWW. 2012 355



 

 

 

 
Figure L-2 Tracking Species Report Categories. 

 

 

The file resulting from the simulation must be identified as input in the spreadsheet. 
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Figure L-3 Main Screen for the SIMPPLLE macro for Tracking Species. 
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16.13 APPENDIX M—MULTI-RESPONSE PERMUTATION PROCEDURES  

A statistical test can be used to estimate the number of simulations necessary to provide a complete 

range of outcomes that capture the high and low extremes in the output (range of variability), as well as 

to provide a method of testing for real differences among sets of simulations that may represent 

different management alternatives. Standard parametric statistical methods to evaluate modeled 

output from multiple stochastic simulations are not reasonable since the modeled output is based on 

unknown multivariate distributions. Multi-response Permutation Procedures (MRPPs) provide 

techniques which allow the use of multi-response data that are ordinal, to compare a priori classified 

groups of objects. The applicability of MRPP is not dependent on the assumptions of normal population 

or homogeneous variances but on the internal variability of the existing data (Zimmerman et al. 1985). 

Using a permutation approach eliminates the need to adhere to the assumptions of normality and 

homogeneity (Mielke et al. 1976). Due to the size of landscapes, the number of polygons representing 

the landscapes, and the high variability of associated terrain of individual landscapes among the areas 

under analysis, there is uncertainty of the influence this would have on the range of variability over 

multiple simulations.  

The template is provided with the installation. Sample simulation results are included in the template. 

Additional instructions will be provided in a separate publication. 

 

16.14 APPENDIX N—GLOSSARY 

 

ANNRAD.  The annual radiation load for a specific vegetation unit computed for use in the invasive 

species logic developed by Montana State University. 

ArcGIS.   A group of geographic information system software products produced by Environmental 

Systems Research Institute. 

ArcGIS Extension.  [ESRI software] In ArcGIS, an optional software module that adds specialized tools 

and functionality to ArcGIS Desktop. ArcGIS Network Analyst, ArcGIS StreetMap, and ArcGIS Business 

Analyst are examples of ArcGIS extensions.  A SIMPPLLE Extension has been created. 

ArcView.   The entry level licensing of the geographic information system software product produced by 

Environmental Systems Research Institute. 

Build on Line (Node).  [ESRI software] An  ArcToolbox command in the Coverage toolbox that creates or 

updates feature attribute tables and polygon topology. Build is also used to synchronize polygon User-

IDs with label point User-IDs.  
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Cover.  [ESRI software] A data  model for storing geographic features. A coverage stores a set of 

thematically associated data considered to be a unit. It usually represents a single layer, such as soils, 

streams, roads, or land use. In a coverage, features are stored as both primary features (points, arcs, 

polygons) and secondary features (tics, links, annotation). 

Data structures.  The organization of data within a specific computer system that allows the data to be 

stored and manipulated effectively; a representation of a data model in computer form. 

Digital elevation model (DEM).  The representation of continuous elevation values over a topographic 

surface by a regular array of z-values, referenced to a common datum. DEMs are typically used to 

represent terrain relief. 

Double.  When you create feature classes and tables in ArcGIS a data type has to be selected for each 

field. The available types include a variety of number types and text.  Double represents the precision 

level chosen to store fractional numbers with decimal places.   

Empirical models.  Statistical or correlational models (e.g., regression models).  Lack biological 

mechanisms.  Empirical models are those that are based entirely on data. Empirical models are not 

derived from assumptions concerning the relationship between variables and they are not based on 

physical principles.  They are based on statistical analysis of observed data, and they are usually 

applicable only to the same conditions under which the observations were made. 

 

ESRI.  Environmental Systems Research Institute. 

Float.  When you create feature classes and tables in ArcGIS a data type has to be selected for each 

field. The available types include a variety of number types and text.  A float data type is for numeric 

values with fractional values. 

Feature class.  [ESRI software] In ArcGIS, a collection of geographic features with the same geometry 

type (such as point, line, or polygon), the same attributes, and the same spatial reference. Feature 

classes can be stored in geodatabases, shapefiles, coverages, or other data formats. 

File geodatabase.  [ESRI software] A database or file structure used primarily to store, query, and 

manipulate spatial data. Geodatabases store geometry, a spatial reference system, attributes, and 

behavioral rules for data. Various types of geographic datasets can be collected within a geodatabase, 

including feature classes, attribute tables, raster datasets, network datasets, topologies, and many 

others. 

FMZ – fire management zone.  A spatial delineation that has the same values for the probability of a fire 

ignition within SIMPPLLE.  Fire suppression logic in SIMPPLLE can be varied by these zones. 

Geographic zone / area.  A geographic extent defined for SIMPPLLE that utilizes the same set of system 

knowledge for defining vegetation, disturbance processes, and their probabilities. 
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GIS  environment.  The collection of methods, techniques, models, and approaches of a geographic 

information systems to store, select, manipulate, explore, analyze, and display georeferenced data. 

Hibernate.  Hibernate is a library for the Java language.  It provides a framework for mapping  the 

SIMPPLLE  java objects to a traditional  relational database. 

Hydrologic code unit (HUC).   A sequence of numbers or letters that identify a hydrological feature like a 

drainage basin.  

Inclusion rule.  A rule within SIMPPLLE that identifies what percentage of species has to exist to identify 

a species mixture label to individual vegetation units. 

Invalid units.   A landscape unit in SIMPPLLE is identified as “invalid” when it has attributes assigned that 

do not match the values created for a specific geographic area. 

Java Max Heap Size. The maximum memory reserved for data that is created when SIMPPLLE is 

executing.  The maximum memory that can be allocated to a Java Virtual Machine process. 

 

Landtype association.   An association of interpreted landtype map units based on the Forest Service, 

Region One Landtype Association Mapping. 

Life  form.  Within SIMPPLLE the distinction is made between trees, shrubs and herbaceous life forms as 

the dominate plant species. 

Light severity fire.  The intensity of a fire event in which only surface fuels are consumed.  No mortality 

in plant species occurs. 

Long.  When you create feature classes and tables in ArcGIS a data type has to be selected for each field. 

The available types include a variety of number types and text.  A long data type is selected for integer 

numbers that are large enough they require 4 bytes (outside the range of -32,768 to 32,767). 

Management scenario.  A unique combination of management treatments applied over time and space 

within SIMPPLLE that is designed to achieve specific objectives. 

Mechanistic models.  Often called “process-based” models. System of interest is broken-down into 

different levels representing a hierarchy of biological or ecological units. The state of the system is 

determined by submodels describing lower levels of organization (or units); interactions between 

levels may be described. Models often include some degree of, for example, (bio)physical or 

(bio)chemical detail. The interactions and mutual constraints among ecological processes are simulated 

with a mathematical model. 

 

Mixed severity fire.  A wildfire fire intensity in which some mortality occurs in the plant species. 
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Monte Carlo.  Monte Carlo simulation performs risk analysis by building models of possible results by 

substituting a range of values—a probability distribution—for any factor that has inherent uncertainty. It 

then calculates results over and over, each time using a different set of random values from the 

probability functions. 

Nonspatial attributes.  Attributes assigned to units within SIMPPLLE that do not depend upon spatial 

relationships to other units.  For vegetation units these are attributes such as species and size class. 

Null.   A value used in computer programming for an uninitialized, undefined, empty, or meaningless 

value.  Creating new data fields in an ArcGIS feature class often results in “null” being initially assigned.  

This value is not acceptable for some SIMPPLLE tools and must be changed. 

Object oriented design.  A software development paradigm to design systems by modeling them based 

on the real-world objects that they were trying to represent.  The paradigm uses objects data structures 

consisting of data fields and methods together with their interactions.  

Operating system – 32-bit vs. 64-bit.  The terms 32-bit and 64-bit refer to the way a computer's 

processor  handles information. The 64-bit version of Windows handles large amounts of random access 

memory (RAM) more effectively than a 32-bit system which relate to memory accessibility and memory 

management. 

Pathways.  One form of system knowledge within SIMPPLLE.  Pathways contain the sequence of state 

changes as a result of disturbance processes. 

Phnenomological model.  Like empirical models, these models focus on a single level related to the 

system of interest. In contrast to mechanistic models, lower levels of organization or function 

are not considered. But, these models can incorporate “ecological processes” that operate at the 

system level. The models can be dynamic and some aspects of the model may not be directly 

informed by data. 

Plant communities.   Vegetation units unique in both vegetation attributes and spatial location that are 

taken from a GIS feature and represented within SIMPPLLE. 

Projection.  A method by which the curved surface of the earth is portrayed on a flat surface.  All GIS 

features have to have a defined projection. 

Python scripts.  Python is a general-purpose high-level programming language often used as a scripting 

language.  Some of the tools in the SIMPPLLE ArcGIS toolbox utilizes python scripts.   

Raster.  A spatial data model that defines space as an array of equally sized cells arranged in rows and 

columns, and composed of single or multiple bands. Each cell contains an attribute value and location 

coordinates. Unlike a vector structure, which stores coordinates explicitly, raster coordinates are 

contained in the ordering of the matrix. 
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Rosgen type.  The Rosgen classification system, a widely-used method for classifying streams and rivers 

based on common patterns of channel morphology. 

Rule-based model.  A model in which the relationships between combinations of system variables and 

outcomes are expressed in the form of logic “If then rules”. 

Shapefile.  [ESRI software] A vector data storage format for storing the location, shape, and attributes of 

geographic features.  A shapefile is stored in a set of related files and contains one feature class.  

SIMPPLLE tool box.  In ArcGIS, a toolbox contains toolsets and geoprocessing tools. It takes the form of a 

.tbx file on disk, or a table in a geodatabase.  A SIMPPLLE toolbox has been created that contains the 

processing tools unique for SIMPPLLE. 

 

Simulation parameters.  The parameters within SIMPPLEL that can be set at the time simulations are 

made.  These include the number of simulations, the length of the simulation, whether fire suppression 

will be used, and choices of output files to generate and save. 

 

Spatial attributes.  Attributes in SIMPPLLE that depend upon a unit’s spatial relationship with other 

units.  The collection of neighboring vegetation units or land units, the distance to a water unit, and 

what units are downwind from a vegetation units are all spatial attributes. 

Spatially explicit.  Landscape elements have map coordinates and are placed within their geographic 

context. 

 

Spatially interactive.  A model transfers energy, matter, or information across the landscape. Examples 

of spatial interactions include the dispersal of seeds or a spreading fire. 

Stand replacing fire.  A wildfire intensity in which all of the above ground biomass is killed. 

State and Transition models.  Models used to describe possible ranges of vegetation states and the 

transitions between the states. 

Stochastic.   A stochastic model is a tool for estimating probability distributions of potential outcomes by 

allowing for random variation in one or more inputs over time. 

System knowledge.  The knowledge used by SIMPPLLE that is unique to each geographic area.  This 

knowledge is accessible to the user through interface screens.  Examples of this knowledge are the 

vegetation pathways, the probability logic for disturbance processes, the logic for fire suppression, and 

the logic for type of fire and fire spread. 

Text .  When you create feature classes and tables in ArcGIS a data type has to be selected for each field. 

The available types include a variety of number types and text.  A text field represents a series of 

alphanumeric symbols.  
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Transition matrix.   A matrix  format for  capturing the transition rates that are part of a state and 

transition model.  

Valley bottom groupings.  A portion of the Rosgen Stream Classification System.  The valley type 

classification influences the hydrologic processes that help determine stream channel form. 

Vector.  A coordinate-based data model that represents geographic features as points, lines, and 

polygons. Each point feature is represented as a single coordinate pair, while line and polygon features 

are represented as ordered lists of vertices. Attributes are associated with each vector feature, as 

opposed to a raster data model, which associates attributes with grid cells.  

Vegetation unit.   The individual vegetation unit that has unique spatial and nonspatial attributes 

simulated by SIMPPLLE.  These are often referred to as “existing vegetation units”. 

Working directory –  SIMPPLLE.  A directory that indicates the appropriate location on disk to place 

system knowledge and results from an analysis.  This is not the same location as the installation 

directory for SIMPPLLE. 
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The Rocky Mountain Research Station develops scientific information 
and technology to improve management, protection, and use of the 
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